Universal RAID Utility Ver 4.1
User's Guide

NEC Express Server
Express5800 Series

Overview
System requirements
Setup of Universal RAID Utility
Starting or Stopping Universal RAID Utility
Functions of RAID Viewer
Functions of Log Viewer
Functions of raidcmd
Referring to Information on RAID System
Configuration of RAID System
Maintenance of RAID System
Troubleshooting RAID System
Management of RAID System using NEC ESMPRO Manager
Changing of Settings of Universal RAID Utility
Notes on use Universal RAID Utility
Appendix A : Glossary
Appendix B : raidcmd Command Reference
Appendix C : Logs/Events
Trademarks

NEC EXPRESSBUILDER is trademarks of NEC Corporation.

Microsoft and its logo, Windows, Windows Server, and MS-DOS are registered trademarks of Microsoft Corporation in the United States and other countries.

"Linux" is a registered trademark or a trademark in United States or other countries of Linus Torvalds.

Red Hat, Red Hat Enterprise Linux, the Shadowman logo and JBoss are registered trademarks of Red Hat, Inc. in the U.S. and other countries.

The name and logo of "Asianux" is a trademark of Miracle Linux Corporation and Red Flag Software Co., Ltd.

Asianux is a registered trademark in Japan of MIRACLE LINUX Corporation.

Novell and SUSE are registered trademarks of Novell, Inc. in the United States and other countries.

VMware is a registered trademark of VMware, Inc. in the United States and/or other jurisdictions.

All other product, brand, or trade names used in this publication are the trademarks or registered trademarks of their respective trademark owners.

(TM), (R) mark is not specified in this text.

Notes

1. No part of this manual may be reproduced in any form without the prior written permission of NEC Corporation.
2. The contents of this manual may be revised without prior notice.
3. The contents of this manual shall not be copied or altered without the prior written permission of NEC Corporation.
4. All efforts have been made to ensure the accuracy of all information in this manual. If you notice any part unclear, incorrect, or omitted in this manual, contact the sales agent where you purchased this product.
5. NEC assumes no liability arising from the use of this product, nor any liability for incidental or consequential damages arising from the use of this manual regardless of Item 4.
External Libraries which this product uses

This product contains libraries ("External Libraries") provided by the third party suppliers ("Suppliers"). Please assume and agree these libraries' license documents and NOTICE files before using this product.

License documents and NOTICE files of "External Libraries" are stored in the following folders.

- **Windows**
  - <the folder where Universal RAID Utility installation image is stored>\eci\doc
- **Linux**
  - <the folder where Universal RAID Utility installation image is stored>\eci\doc

If the "External Libraries" require to include their Source Code with this product, see the folder below.

- **Windows**
  - <the folder where Universal RAID Utility installation image is stored>\eci\src
- **Linux**
  - <the folder where Universal RAID Utility installation image is stored>\eci\src

The external libraries this product uses are listed in “External Libraries and their Copyright”. Notwithstanding any of the terms in the Agreement or any other agreement You may have with NEC:

  a) "Suppliers" provide the libraries WITHOUT WARRANTIES OF ANY KIND and, such Suppliers DISCLAIM ANY AND ALL EXPRESS AND IMPLIED WARRANTIES AND CONDITIONS INCLUDING, BUT NOT LIMITED TO, THE WARRANTY OF TITLE, NON-INFRINGEMENT OR INTERFERENCE AND THE IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE EXTERNAL LIBRARIES;

  b) In no event are the Suppliers liable for any direct, indirect, incidental, special, exemplary, punitive or consequential damages, including but not limited to lost data, lost savings, and lost profits, with respect to the External Libraries; and,

  c) NEC and the Suppliers are not liable to You, and will not defend, indemnify, or hold You harmless for any claims arising from or related to the External Libraries.

**External Libraries and their Copyright**

- **Apache Axis2** Copyright © The Apache Software Foundation
- **Apache Rampart** Copyright © The Apache Software Foundation
- **libxml2** Copyright © Daniel Veillard, All Rights Reserved
- **libiconv** Copyright © Free Software Foundation, Inc.
- **OpenSLP** Copyright © Caldera Systems, Inc
- **OpenSSL** Copyright © The OpenSSL Project.
- **sysfsutil** Copyright © Ananth Mavinakayahanalli, Daniel Stekloff, Mohan Kumar, Nitin Vashisth
- **zlib** Copyright © Jean-loup Gailly and Maek Adler
Introduction

This User’s Guide describes RAID System management utility "Universal RAID Utility" the version 4.1. This User’s Guide consists of the following four files.

- User’s Guide : This file
- Appendix A : Glossary
- Appendix B : raidcmd Command Reference
- Appendix C : Logs/Events


Before using Universal RAID Utility, you should carefully read the User’s Guide of the RAID System managed by the Universal RAID Utility and that of the computer in which the RAID System is installed.

The User’s Guide is intended to be read by engineers who are fully familiar with the functions and operations of Windows and Linux. See the Windows and Linux online help and related documentation for the operations and concerns of Windows and Linux.

Symbols used in the text

The User’s Guide uses the following three symbols. Follow these symbols and their meanings to use the Universal RAID Utility appropriately.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td>Indicates a matter or caution you should particularly obey on operations of the Universal RAID Utility.</td>
</tr>
<tr>
<td>📜</td>
<td>Indicates a notice you should check to operate the Universal RAID Utility.</td>
</tr>
<tr>
<td>📁</td>
<td>Indicates effective or convenient information which help you if you know them.</td>
</tr>
</tbody>
</table>
# Contents

## Overview .................................................................................................................. 10
- What is Universal RAID Utility? ........................................................................... 10
- Structure of Universal RAID Utility ................................................................. 11
- Functional differences from previous version of Universal RAID Utility .......... 12
  - Ver4.02 and Ver4.1 ..................................................................................... 12

## System requirements ............................................................................................. 13
- Hardware ............................................................................................................ 13
  - Computers ................................................................................................. 13
  - RAID Systems to be managed by Universal RAID Utility ......................... 13
- Software (Windows) ....................................................................................... 13
  - Operating systems .................................................................................. 13
  - Microsoft .NET Framework .................................................................. 14
- Software (Linux) ............................................................................................. 14
  - Operating systems .................................................................................. 14
- Software (VMware ESX) ............................................................................. 14
  - VMware ESX ......................................................................................... 14
- Others .......................................................................................................... 15
  - Resources ............................................................................................... 15
  - TCP ports used by Universal RAID Utility ........................................... 15
  - Safe Mode and Single User Mode .......................................................... 16

## Setup of Universal RAID Utility .......................................................................... 17
- Installation image ........................................................................................... 17
- Installation and Uninstallation ......................................................................... 18
  - Preparing installation (Windows) ............................................................. 19
  - Installation (Windows) ........................................................................... 20
  - Uninstallation (Windows) ....................................................................... 22
  - Preparing installation (Linux) ................................................................. 23
  - Installation (Linux, VMware ESX) .......................................................... 24
  - Uninstallation (Linux, VMware ESX) ...................................................... 27
  - Installation of NEC ESMPRO Manager ................................................... 28
  - Change of Universal RAID Utility Configuration .................................... 29

## Starting or Stopping Universal RAID Utility ......................................................... 30
- raidsrv service ............................................................................................... 30
  - Starting Universal RAID Utility in Single User Mode ............................. 30
- raidsrv Agent Service .................................................................................. 31
- RAID Viewer ................................................................................................. 31
- Log Viewer ................................................................................................... 32
- raidcmd ........................................................................................................... 33
- Standard and Advanced Modes .................................................................... 35
  - RAID System Management Mode when startup RAID Viewer and raidcmd . 36
  - Changing RAID System Management Mode ........................................... 36

## Functions of RAID Viewer .................................................................................. 37
- Structure of RAID Viewer ............................................................................. 37
- Tree View ...................................................................................................... 37
- Server ........................................................................................................... 38
- RAID Controller ........................................................................................... 38
Troubleshooting RAID System ................................................................. 115

Maintenance of RAID System ................................................................................. 91

Operation Procedure of "Create Logical Drive - Simple Mode" ........................................78
Physical Devices Available for "Create Logical Drive - Simple Mode" .............................. 80
Creating Logical Drives by "Create Logical Drive - Simple Mode" ................................. 80
Creating Logical Drive Freely .................................................................................. 81
Operation Procedure of "Create Logical Drive - Custom Mode" .................................... 81
Disk Arrays and Physical Devices Available for "Create Logical Drive - Custom Mode".... 84
Creating Logical Drives by "Create Logical Drive - Custom Mode" ................................. 85
Deleting Logical Drive ............................................................................................ 86
Deleting Logical Drive ............................................................................................ 86
Using CacheCade ..................................................................................................... 87
Create SSD Cache Drive ........................................................................................ 87
Deleting SSD Cache Drive ........................................................................................ 90

Providing Patrol Read for Physical Devices............................................................... 91
Setting Whether Patrol Read Is Executed or Not ......................................................... 91
Checking Result of Executing Patrol Read ................................................................. 92
Setting Patrol Read Priority ..................................................................................... 92
Checking Logical Drive Consistency ......................................................................... 93
Executing Consistency Check Manually (Automatic Stop Enabled) ............................. 93
Executing Consistency Check Manually (Automatic Stop Disabled) ............................ 94
Executing Consistency Check for arbitrary Logical Drive .......................................... 95
Stopping Consistency Check .................................................................................... 96
Checking Result of Executing Consistency Check ..................................................... 96
Setting Consistency Check Priority ........................................................................ 97
Initializing Logical Drive........................................................................................... 98
Executing Initialize ................................................................................................... 98
Stopping Initializing .................................................................................................. 99
Checking Result of Executing Initialize ................................................................... 99
Setting Initialize Priority ......................................................................................... 100
Changing Cache Mode of Logical Drive ..................................................................... 101
Setting cache mode................................................................................................. 101
Rebuilding Physical Device ...................................................................................... 102
Executing Rebuild.................................................................................................... 102
Stopping Rebuild .................................................................................................... 103
Checking Result of Executing Rebuild ................................................................... 104
Setting Rebuild Priority ......................................................................................... 104
Reducing the power consumption of the Physical Device ...................................... 105
Setting Power Saving Devices ................................................................................ 105
Setting Device Standby Time .................................................................................. 106
Checking Location of Physical Device ..................................................................... 108
Procedure of Checking Location of Physical Device ................................................. 108
Changing Status of Physical Device Forcibly ............................................................ 109
To Online Forcibly ................................................................................................. 109
To Failed Forcibly ................................................................................................... 110
Refreshing the battery of the RAID Controller ............................................................ 112
Executing Refresh Battery Manually ........................................................................ 112
Scheduling Refresh Battery ..................................................................................... 113
Updating firmware of the RAID Controller ............................................................... 114
Executing Update Firmware Of The RAID Controller ................................................. 114

Failure Detection Measures .................................................................................. 116
Status Display by RAID Viewer ............................................................................... 116
Status Display by raidcmd ...................................................................................... 116
Logging Events to RAID Log ................................................................................ 116
Logging Events to OS Log ..................................................................................... 116
Buzzer in RAID Controller ...................................................................................... 118
Sending Alert to ESMPRO Manager ...................................................................... 119
Notes on Use of Universal RAID Utility ................................................................. 138
Operation in no failures of Physical Devices ....................................................... 121
Operation when redundancy of Logical Drive degraded or lost due to failure of Physical Device 122
Operation when failed Physical Device is replaced to recover RAID System ........ 123
Operation when the Logical Drive is offline due to failure of Physical Device ..... 124
Monitoring Battery Status .................................................................................. 125
Monitoring Flash Backup Unit Status ................................................................. 126
Monitoring Enclosure Status .............................................................................. 127
Monitoring Various Events of RAID System ................................................... 127
Replacing Physical Device for Prevention ......................................................... 127
Monitoring a Medium Error to see if they occur frequently .......................... 129
Monitoring a Medium Error to see if they occur intermittently ..................... 129
Monitoring unexpected change of RAID configuration ................................. 129
Monitoring the lifetime of SSD ......................................................................... 130
Management of RAID System using NEC ESMPRO Manager ..................... 133
System Requirement and Installation ................................................................. 132
Version of NEC ESMPRO Manager ................................................................. 132
Sending Alert to NEC ESMPRO Manager ....................................................... 132
Using RAID System Management Mode ......................................................... 132
Using "Standard Mode" .................................................................................. 132
Using "Advanced Mode" .................................................................................. 133
Function that can be used in NEC ESMPRO Manager ....................................... 133
Using ExpressUpdate ....................................................................................... 134
Functions supported by ExpressUpdate ............................................................ 134
Version management by ExpressUpdate ........................................................... 134
Changing of Settings of Universal RAID Utility ............................................. 135
Changing TCP port number ............................................................................. 135
Using Windows as Operating System ............................................................... 135
Using Linux or VMware ESX as Operating System ......................................... 136
Avoiding TCP port conflict ............................................................................. 136
Changing RAID System Management Mode at Start of RAID Viewer ............ 137
Notes on Use of Universal RAID Utility ........................................................... 138
Operation Environment ................................................................................... 138
Use of IPv6 ...................................................................................................... 138
Use of Windows PowerShell ............................................................................. 138
OS Fatal Error Event ....................................................................................... 139
Doubly Registered Event After Restoring Backup Data ................................. 139
Fails to Start Consistency Check ...................................................................... 139
Displaying of progress status when reboot a system during operation .......... 139
Installation / Uninstallation ............................................................................. 140
DistributedCOM event is registered during installing or uninstalling ............... 140
RAID Viewer, Log Viewer .............................................................................. 140
Verification of Authenticode signature at the startup of the RAID Viewer and Log Viewer 140
About the startup without Microsoft .NET Framework Ver2.0 or later ............... 140
About the startup from command prompt or Windows PowerShell ................. 141
The different behavior between RAID Viewer and raidcmd ......................... 141
About "An exception happened in the RAID Viewer" error ............................. 141
Logs output from Universal RAID Utility ......................................................... 141
Log Rotation .................................................................................................... 141
Location where log files are created ............................................................... 142
NEC ESMPRO Manager ................................................................................ 142
Simultaneous operation from two or more NEC ESMPRO Manager .......... 142
Notes on use of Web GUI .............................................................................. 142
Notes on use of function to Make/Remove Hot Spare by NEC ESMPRO Manager 142
NEC ESMPRO ServerAgentService
Notes on use report coordination with Windows Server 2008 R1 ServerCore
RAID Controller
Notes on updating firmware of the RAID Controller
Consistency Check
Notes on executing Consistency Check Manually (Automatic Stop Disabled)
This chapter describes the overview of the Universal RAID Utility.

What is Universal RAID Utility?

The Universal RAID Utility enables RAID Systems in a computer to be managed.

The Universal RAID Utility is characterized as follows.

1. Allowing a variety of RAID Systems to be managed

Conventionally, a specific management utility must be used for each RAID System. On the other hand, only the Universal RAID Utility can manage more than one RAID System. For the RAID Systems which the Universal RAID Utility can manage, see the documentation on computers and RAID Systems.

2. Operating in either Standard or Advanced Mode

The Universal RAID Utility can operate in two RAID System Management Modes, which are Standard Mode and Advanced Modes.

The Standard Mode provides the Universal RAID Utility with standard management functions of RAID Systems.

The Advanced Mode provides the Universal RAID Utility with advanced management and maintenance functions of RAID Systems.

Using the two RAID System Management Modes appropriately depending on users and jobs allows the usability of the Universal RAID Utility to be improved and malfunctions to be avoided.

3. Configuring RAID Systems easily

Using the Universal RAID Utility, you can configure a RAID System easily without expert knowledge of the RAID System.

The Universal RAID Utility provides the "simple Logical Drive create function" allowing a Logical Drive to be created by selecting only two selection items according to the guide of the Universal RAID Utility and the "Easy Configuration" allowing a RAID System to be configured only by defining uses of unused Physical Devices.

4. Supporting general functions required for configurations, operations and maintenances of RAID Systems

The Universal RAID Utility supports general functions for configuring a RAID System (including creating Logical Drive and making Hot Spare), general operation functions (including log recording, Patrol Read and Consistency Check), and general functions required for maintenance (including Rebuild and Locate functions).

5. Troubleshooting RAID Systems

The Universal RAID Utility can detect failures occurred in RAID Systems by using various functions.

The RAID Viewer, the GUI of the Universal RAID Utility, indicates the configurations and status of RAID Systems comprehensibly with trees and icons. The raidcmd, the CLI of the Universal RAID Utility, indicates the same information too. In addition, the Universal RAID Utility registers failures occurred in RAID Systems not only to the dedicated log but also the OS log. Further, the Universal RAID Utility can send alerts to the NEC ESMPRO Manager normally attached to NEC Express series systems.

6. RAID System Management by NEC ESMPRO Manager

Universal RAID Utility (Windows / Linux Edition) can manage the RAID System using Web GUI of NEC ESMPRO Manager Ver. 5.5 or later. The RAID System that exists in a remote environment can be managed by using NEC ESMPRO Manager like RAID Viewer and Log Viewer. You cannot manage the RAID System from Windows GUI of NEC ESMPRO Manager. Be sure to use Web GUI to manage the RAID Controller.

7. Management by ExpressUpdate

Universal RAID Utility Ver4.1 supports ExpressUpdate. This feature enables you to update Universal RAID Utility to the latest version when a new version of Universal RAID Utility is released. This feature is available with Universal RAID Utility Ver2.5 or the later versions.
Structure of Universal RAID Utility

The Universal RAID Utility consists of the following modules. The module that can be used is different depending on operating system.

- **raidsrv service**
  The raidsrv service always operates in the server to manage RAID Systems. Receiving a processing request from the RAID Viewer or raidcmd, the raidsrv service provides proper information on a RAID System or performs an appropriate operation for the RAID System. In addition, the raidsrv service manages events occurred in RAID Systems, notifies the RAID Viewer of the events and/or registers them to several logs.

- **RAID Viewer (Windows Edition only)**
  The RAID Viewer is the Windows application managing and monitoring the RAID System by GUI. The RAID Viewer displays the configuration and status of a RAID System graphically or provides configuration and operation for a RAID System.

- **Log Viewer (Windows Edition only)**
  The Log Viewer is the Windows application viewing the event of RAID System. The Log Viewer allows you to see the RAID Log in which events occurred in RAID Systems are registered.

- **raidcmd**
  The raidcmd is the application managing and monitoring the RAID System by CLI. The raidcmd is the command that indicates the configuration and status of a RAID System or operates on a console providing configurations and operations.

- **NEC ESMPRO Manager Communication Module / raidsrv Agent**
  When the RAID System is managed in NEC ESMPRO Manager, raidsrv Agent controls the communication between NEC ESMPRO Manager and Universal RAID Utility.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Windows</th>
<th>Linux</th>
<th>VMware ESX</th>
</tr>
</thead>
<tbody>
<tr>
<td>raidsrv service</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>RAID Viewer</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log Viewer</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>raidcmd</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>NEC ESMPRO Manager Communication Module (raidsrv Agent)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Functional differences from previous version of
Universal RAID Utility

Ver4.02 and Ver4.1

The following features have been enhanced and changed from Universal RAID Utility Ver4.02.

1. Universal RAID Utility Ver4.1 can newly manage the following RAID controllers.
   - N8103-188 RAID Controller (0GB, RAID 0/1)

2. Universal RAID Utility Ver4.1 can support Windows PowerShell.
   Universal RAID Utility Ver4.1 can execute raidcmd on Windows PowerShell.

3. Change of default value to update firmware of RAID controller.
   The default action is changed when not specifying an option in firmware updating function of a RAID
   controller by raidcmd.

4. Removing the restriction that the numbers of Physical Devices when you create RAID10.
   You can specify even-numbered Physical Devices equal to or greater than four (e.g.: 4, 6, 8, ...) when
   creating RAID 10.

5. Removing the restriction that you cannot specify the capacity freely when you create RAID 10, RAID 50
   and RAID 60.
   You can specify capacity of the Physical Devices freely when creating RAID 10, RAID 50 and RAID 60.

6. Change of feature about monitoring the lifetime of SSD.
   Universal RAID Utility registers the event about lifetime of SSD, it will be the reference to change the SSD.
   Moreover, added percentages about lifetime amounts of SSD. See the section "Monitoring the lifetime of
   SSD" for detail.

7. Universal RAID Utility Ver4.1 can support monitoring lifetime of SSD when you use not only optional RAID
   Controller but also Onboard RAID Controller (LSI Embedded MegaRAID).

8. Removing the restriction that cannot specify all capacity that includes less than Gigabyte when you create
   logical drive.
   You can specify all capacity that includes less than Gigabyte when creating logical drive.

9. Change of signage about SSD.
   SSD was being signed "HDD (SSD)" on RAID Viewer, raidcmd and NEC ESMPRO Manager, but it changed to
   "SSD".

10. Addition of supported OS
    - Windows Server 2016
    - Windows 10
    - Red Hat Enterprise Linux 6.8
    - Red Hat Enterprise Linux 6.9
    - Red Hat Enterprise Linux 7.2
    - Red Hat Enterprise Linux 7.3
This chapter describes system requirements of the Universal RAID Utility.

## Hardware

### Computers

The computers can contain RAID Systems to be managed by the Universal RAID Utility.

### RAID Systems to be managed by Universal RAID Utility

For RAID Systems which can be managed by the Universal RAID Utility, see the documentation attached to the computer in which RAID Systems are installed and that attached to the RAID Controller including the Universal RAID Utility.

## Software (Windows)

### Operating systems

The Universal RAID Utility can operate in the following operating systems. It can operate in either 32-bit or 64-bit environment for any operating system.

- Windows Server 2016
- Windows Server 2012 R2
- Windows Server 2012
- Windows Server 2008 R2
- Windows Server 2008
- Windows Server 2003 R2 SP3 or later
- Windows 10
- Windows 8.1
- Windows 8
- Windows 7
- Windows XP Professional SP3 or later

Microsoft .NET Framework

To use the RAID Viewer and Log Viewer, Microsoft .NET Framework Versions 2.0 to 3.5 is required. Windows Server 2008 and Windows Server 2008 R2, Windows 7 include .NET Framework Version 2.0 to 3.5. Therefore, you do not need to install .NET Framework in case of using them.

For the installation of Microsoft .NET Framework Version 2.0 to 3.5, see "Preparing installation (Windows)".

Software (Linux)

Operating systems

The Universal RAID Utility can operate in the following operating systems. It can operate in either 32-bit or 64-bit environment for any operating system.

- Red Hat Enterprise Linux 5.7 or later
- Red Hat Enterprise Linux 6.1 or later
- Red Hat Enterprise Linux 7.1 or later
- SUSE Linux Enterprise Server 11 SP 2 or later
- SUSE Linux Enterprise Server 12 or later

Software (VMware ESX)

VMware ESX

The Universal RAID Utility can operate in the following VMware ESX.

- VMware ESX 4.1

You must install the Universal RAID Utility in the service console. Do not install in the virtual machine.
## Others

### Resources

<table>
<thead>
<tr>
<th>Resource</th>
<th>Windows</th>
<th>Linux/VMware ESX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Hard Disk Space</td>
<td>280MB or more (not include Microsoft .NET Framework Ver2.0)</td>
<td>←</td>
</tr>
<tr>
<td>RAM</td>
<td>512MB or more</td>
<td>←</td>
</tr>
</tbody>
</table>

### TCP ports used by Universal RAID Utility

The Universal RAID Utility uses the following three TCP ports.

<table>
<thead>
<tr>
<th>Description</th>
<th>Port numbers in Ver2.6 and earlier versions</th>
<th>Port numbers in Ver2.61 and later versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>data port</td>
<td>52805</td>
<td>5016</td>
</tr>
<tr>
<td>event port</td>
<td>52806</td>
<td>5017</td>
</tr>
<tr>
<td>raidsrv Agent Communication port</td>
<td>52807</td>
<td>5018</td>
</tr>
</tbody>
</table>

Other ports than those described above will be used when you manage the RAID System using NEC ESMPRO Manager Ver. 5.5. See “NEC ESMPRO Manager Installation Guide” for details.

The TCP ports Universal RAID Utility uses have been changed in Universal RAID Utility Version 2.61. Some of the users may have to change the settings of Universal RAID Utility or other applications depending on the current settings of the system environment when you are going to update Universal RAID Utility from Ver2.6 or earlier versions to Ver2.61 or later versions. See the following table for details.
<table>
<thead>
<tr>
<th>Users who use the port in the range from 52805 to 520807</th>
<th>Taking over TCP port numbers</th>
<th>Settings for Firewall, etc.</th>
<th>When other applications are using 5016 to 5018</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Updating Universal RAID Utility by following the procedure in the section “Installation and Uninstallation”: The port numbers from 5016 to 5018 are automatically set.</td>
<td>Change the port numbers [52805-52807] to [5016-5018].</td>
<td>Change the TCP port numbers manually that Universal RAID Utility uses. See “Changing Port Number” for details.</td>
</tr>
<tr>
<td></td>
<td>Updating Universal RAID Utility by using ExpressUpdate: The port numbers from 52805 to 52807 are not taken over and those from 5016 to 5018 are automatically set.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Users who have changed the ports from [52805-520807] to other numbers</td>
<td>Updating Universal RAID Utility by following the procedure in the section “Installation and Uninstallation”: The port numbers from 5016 to 5018 are automatically set. To change the TCP port numbers to the original one, see “Changing Port Number” for details.</td>
<td>Updating Universal RAID Utility by following the procedure in the section “Installation and Uninstallation”: Change the port numbers set for Firewall to [5016-5018].</td>
<td>Updating Universal RAID Utility by following the procedure in the section “Installation and Uninstallation”: Change the TCP port numbers manually that Universal RAID Utility uses. See “Changing Port Number” for details.</td>
</tr>
<tr>
<td></td>
<td>Updating Universal RAID Utility by using ExpressUpdate: The port numbers currently used are taken over.</td>
<td>Updating Universal RAID Utility by using ExpressUpdate: No effect on any settings.</td>
<td>Updating Universal RAID Utility by using ExpressUpdate: No effect on any settings.</td>
</tr>
</tbody>
</table>

For the change of TCP port number using Universal RAID Utility, see “Changing TCP port number”.

**Safe Mode and Single User Mode**

The Universal RAID Utility uses the network function. Accordingly, the Universal RAID Utility is not available in any of the following safe modes in which the network function cannot operate.

- Safe Mode
- Safe Mode with Command Prompt
- Safe Mode with Networking

Also, it cannot be used in the single user mode of Linux and VMware ESX. See "Starting Universal RAID Utility in Single User Mode" about how to use the Universal RAID Utility in the single user mode.
Setup of Universal RAID Utility

This chapter describes installation and uninstallation of the Universal RAID Utility.

### Installation image

Use the setup program of Universal RAID Utility for the installation and the uninstallation.

The setup program is contained in the installation image of the Universal RAID Utility. Before the Universal RAID Utility can be installed or uninstalled, you must prepare the installation image.

The installation images of Universal RAID Utility are different by operating system. You need to use correct installation image corresponding to the operating system.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Installation image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012 R2</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2012</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2008 R2</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2008</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2003 R2 SP3 or later</td>
<td></td>
</tr>
<tr>
<td>Windows 10</td>
<td></td>
</tr>
<tr>
<td>Windows 8.1</td>
<td></td>
</tr>
<tr>
<td>Windows 8</td>
<td></td>
</tr>
<tr>
<td>Windows 7</td>
<td></td>
</tr>
<tr>
<td>Windows XP Professional SP3 or later</td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 5.7 or later</td>
<td>Universal RAID Utility (Linux Edition)</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 6.1 or later</td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 7.1 or later</td>
<td></td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 11 SP2 or later</td>
<td></td>
</tr>
<tr>
<td>SUSE Linux Enterprise Server 12 or later</td>
<td></td>
</tr>
<tr>
<td>VMware ESX 4.1</td>
<td>Universal RAID Utility (VMware ESX Edition)</td>
</tr>
</tbody>
</table>

The installation images of Universal RAID Utility are attached to the computer or the RAID Controller except Universal RAID Utility VMware ESX Edition.

The latest version of Universal RAID Utility is released on the “NEC Global Site” (http://www.nec.com/).
Installation and Uninstallation

This section describes the procedure of installation and uninstallation of Universal RAID Utility.

<table>
<thead>
<tr>
<th>kind</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation</td>
<td>Install Universal RAID Utility newly, when there is not Universal RAID Utility in the server.</td>
</tr>
<tr>
<td></td>
<td><strong>Procedure (Windows)</strong></td>
</tr>
<tr>
<td></td>
<td>1. Preparing installation (Windows)</td>
</tr>
<tr>
<td></td>
<td>2. Installation (Windows)</td>
</tr>
<tr>
<td></td>
<td><strong>Procedure (Linux)</strong></td>
</tr>
<tr>
<td></td>
<td>1. Preparing installation (Linux)</td>
</tr>
<tr>
<td></td>
<td>2. Installation (Linux, VMware ESX)</td>
</tr>
<tr>
<td></td>
<td><strong>Procedure (VMware ESX)</strong></td>
</tr>
<tr>
<td></td>
<td>1. Installation (Linux, VMware ESX)</td>
</tr>
<tr>
<td>Uninstallation</td>
<td>Uninstall Universal RAID Utility from the server.</td>
</tr>
<tr>
<td></td>
<td><strong>Procedure (Windows)</strong></td>
</tr>
<tr>
<td></td>
<td>1. Uninstallation (Windows)</td>
</tr>
<tr>
<td></td>
<td><strong>Procedure (Linux, VMware ESX)</strong></td>
</tr>
<tr>
<td></td>
<td>1. Uninstallation (Linux, VMware ESX)</td>
</tr>
<tr>
<td>Installation of NEC ESMPRO</td>
<td>Install NEC ESMPRO Manager Ver. 5.5 or later versions to manage the server where Universal RAID Utility has been installed using NEC ESMPRO Manager</td>
</tr>
<tr>
<td>Manager</td>
<td><strong>Procedure</strong></td>
</tr>
<tr>
<td></td>
<td>1. Installation of NEC ESMPRO Manager</td>
</tr>
</tbody>
</table>

- A user having the administrator authority should install or uninstall the Universal RAID Utility in the computer. Only users having the administrator authority can execute the setup program.


- If you use VMware ESX, press Alt key and F1 key at the same time at boot screen of VMware ESX to switch to the service console. Log in to VMware ESX with the administrator authority to install or uninstall Universal RAID Utility.

- Universal RAID Utility Ver2.3 or later versions do not support the Update Installation function. To update Universal RAID Utility, first uninstall existing Universal RAID Utility and then install the new version of Universal RAID Utility.

- If you have changed following settings from default ones, you have to change them again after installation or uninstallation of Universal RAID Utility.
  - TCP ports that Universal RAID Utility uses
  - RAID System Management Mode at the start of RAID Viewer or raidcmd
  - Scheduled tasks that registered in Operating System and execute Consistency Check

When installing Universal RAID Utility, please also refer to notes such as OS update module, support kit, release memo and so on.

The RAID log is not deleted at the uninstallation of Universal RAID Utility. You can refer the log files even after uninstalling Universal RAID Utility.
Preparing installation (Windows)

RAID Viewer and Log Viewer use Microsoft .NET Framework Versions 2.0 to 3.5. Install these components if it does not exist in the computer where the Universal RAID Utility is to be installed.

Skip this section when you exclude RAID Viewer and Log Viewer from the modules to be installed at the installation of Universal RAID Utility. Go to “Installation (Windows)”.

Installation of Microsoft .NET Framework

Windows Server 2008 and Windows Server 2008 R2, Windows 7 include .NET Framework Versions 2.0 to 3.5. Therefore, you do not need to install .NET Framework in case of using them as operating system.

Install .NET Framework Versions 2.0 to 3.5 when you are going to use Universal RAID Utility on Windows 8, Windows 8.1, Windows 10, Windows Server 2012 and Windows Server 2012 R2 and Windows Server 2016. It is because only .NET Framework 4.5 or later is included in the operating system. You can download it from the following Web site. The word "Windows 8" in this section shall read as "Windows Server 2012", "Windows Server 2012 R2", "Windows Server 2016".


Step 1  Click [Start] - [Control Panel]. Then double-click [Add or Remove Program].

Step 2  Click [Change or Remove Program] to list [Currently installed programs]. If the following program exists in the list of [Currently installed programs], Microsoft .NET Framework is not required to be installed. If the following package does not exist, install the package.

- [Microsoft .NET Framework 2.0] (for x64, [Microsoft .NET Framework 2.0 (x64)]

Step 3  Microsoft .NET Framework Version 2.0 uses different packages depending on the CPU architecture. See the table below to download and install the required packages.

<table>
<thead>
<tr>
<th>CPU architecture</th>
<th>Required components and their vendors</th>
</tr>
</thead>
<tbody>
<tr>
<td>x86</td>
<td>[Microsoft .NET Framework 2.0 Service Pack 1 (x86)]</td>
</tr>
<tr>
<td>x64</td>
<td>[Microsoft .NET Framework 2.0 Service Pack 1 (x64)]</td>
</tr>
</tbody>
</table>
Installation (Windows)

The Setup Program installs Universal RAID Utility when there is no Universal RAID Utility in the server.

**Step 1** Check if the operating system recognizes all the RAID Controllers connected. Please be sure to connect all the RAID Controllers before installing Universal RAID Utility.

> **Important**
> The program to control the RAID Controller depends on the type of RAID Controller. Please be sure to connect all the RAID Controllers first then install Universal RAID Utility.

**Step 2** Click [Start], [Run...], [Browse...]. Click setup.exe in the folder contained the installation image of Universal RAID Utility and click [Open] in the [Browse] dialog box. Recognize that displays "setup.exe" in [Name] box on [Run] dialog box and click [OK].

**Step 3** The installation starts the InstallShield Wizard of the Universal RAID Utility. Click [Next].

**Step 4** The Universal RAID Utility is installed in \Program Files\Universal RAID Utility (or Program Files (x86) for x64) in the drive where the OS is started by default. To change the installation folder, click [Change] and enter another installation folder. Click [Next].

**Step 5** Select the modules you would like to install. All the modules are selected in default. Uncheck the checkbox depending on your requirement. Note that the raidsrv service and raidcmd must be installed. Click [Next].
Step 6  The “Ready to Install the Program” screen appears. Confirm the modules to be installed displayed on the screen and click [Install] to start installation. To change the modules to be installed, click [Back] to reselect the modules.

Step 7  At the completion of the installation, the “InstallShield Wizard Complete” screen appears. Click [Finish].

Step 8  When the installation completes, “Universal RAID Utility” is registered to the program list in the [Change or Remove Programs]. Also, either program or both programs to manage the RAID Controllers shown below will be registered depending on the type of the RAID Controller.

- WebPAMPRO Agent

- Please check the setting of [When maximum log size is reached] in the [Properties] of [System] event log. In case that [When maximum log size is reached] is not [Overwrite events as needed], when the log size reaches the maximum size, Universal RAID Utility cannot register the detected RAID event to the Windows Event Log and alert it to the NEC ESMPRO Manager. Please set [When maximum log size is reached] to the [Overwrite events as needed].

- If you have already had Universal RAID Utility in your computer, be sure to uninstall it first. Then install Universal RAID Utility Ver4.1.

- The message indicating the following application is required to install Universal RAID Utility may appear at Setup with EXPRESSBUILD for Windows:

  Microsoft Visual C++ 2005 Redistributable Package (x86)
  Microsoft Visual C++ 2005 Redistributable
  To remove the program from your computer, click Uninstall.

  In this case install the Microsoft Visual C++ Run-time library. You can delete it after the setup is completed if not required.

NEC ESMPRO Manager Ver. 5.5 or later versions is required to manage the server where Universal RAID Utility Ver4.1 has been installed.

See “Installation of NEC ESMPRO Manager” for details.
Uninstallation (Windows)

The Setup Program uninstalls Universal RAID Utility when there is the same version of Universal RAID Utility in the server.

Use the same version of the Setup Program as the one when you install the current Universal RAID Utility.

You can start the uninstallation by using the clicking [Delete] on "Universal RAID Utility" program in the list of [Add or Remove Program].

Step 1  The procedure to start setup.exe is the same as that described in “Installation (Windows)”.

Step 2  The currently running programs are displayed, such as mmc.exe (Event Viewer, server manager), RAID Viewer, Log Viewer, and raidcmd. You cannot uninstall Universal RAID Utility as long as these programs are running. Terminate the programs and click [Retry].

Step 3  The uninstallation starts the InstallShield Wizard of the Universal RAID Utility. Click [Yes] on the dialog box shown to the right to start the uninstallation. Click [No] to abort the setup program.

Step 4  Uninstallation begins. A right screen is displayed while uninstalling it.
Step 5  At the completion of the uninstallation, the wizard appears as shown in the figure to the right. Click [Finish].

If the uninstallation completes, "Universal RAID Utility" is deleted from the list of [Add or Remove Program].

Also, one or several programs to control RAID Controller in your system are also deleted.
Preparing installation (Linux)

You must prepare the following packages for using the Universal RAID Utility. If the following packages do not exist in the computer that installs Universal RAID Utility, you need to install them.

For the rpm packages indicated with "(*)" in the following tables, be sure to specify the rpm packages as shown below for interdependence. Note that there is no interdependence between the packages indicated with "(**)" and "(***)".

```
rpm -ivh (package-name).rpm (package-name).rpm
```

- Red Hat Enterprise Linux 5.7 or later

<table>
<thead>
<tr>
<th>packages</th>
<th>x86</th>
<th>x64</th>
</tr>
</thead>
<tbody>
<tr>
<td>standard C++ library</td>
<td>libstdc++</td>
<td>libstdc++ (i386)</td>
</tr>
<tr>
<td>standard C library</td>
<td>glibc</td>
<td>glibc (i686)</td>
</tr>
<tr>
<td>GCC library</td>
<td>libgcc</td>
<td>libgcc (i386)</td>
</tr>
<tr>
<td>cron</td>
<td>vixie-cron</td>
<td>vixie-cron</td>
</tr>
<tr>
<td>syslogd</td>
<td>syslogd</td>
<td>syslogd</td>
</tr>
<tr>
<td>others</td>
<td>iptables</td>
<td>iptables</td>
</tr>
<tr>
<td></td>
<td>pciutils</td>
<td>pciutils</td>
</tr>
<tr>
<td></td>
<td>psmisc (Note1)</td>
<td>psmisc (Note1)</td>
</tr>
<tr>
<td></td>
<td>dmidecode</td>
<td>dmidecode</td>
</tr>
</tbody>
</table>

- Red Hat Enterprise Linux 6.1 or later

<table>
<thead>
<tr>
<th>packages</th>
<th>x86</th>
<th>x64</th>
</tr>
</thead>
<tbody>
<tr>
<td>standard C++ library</td>
<td>libstdc++</td>
<td>libstdc++ (i686)</td>
</tr>
<tr>
<td>standard C library</td>
<td>glibc (**)</td>
<td>glibc (i686) (**)</td>
</tr>
<tr>
<td>GCC library</td>
<td>libgcc</td>
<td>libgcc (i686)</td>
</tr>
<tr>
<td>cron</td>
<td>cronie (***)</td>
<td>cronie (***))</td>
</tr>
<tr>
<td></td>
<td>cronie-anacron (***)</td>
<td>cronie-anacron (***))</td>
</tr>
<tr>
<td></td>
<td>crontabs (***)</td>
<td>crontabs (***))</td>
</tr>
<tr>
<td>syslogd</td>
<td>rsyslog</td>
<td>rsyslog</td>
</tr>
<tr>
<td>others</td>
<td>pciutils</td>
<td>pciutils</td>
</tr>
<tr>
<td></td>
<td>nss-softokn-freebl (**)</td>
<td>nss-softokn-freebl (i686)(**)</td>
</tr>
<tr>
<td></td>
<td>iptables</td>
<td>iptables</td>
</tr>
<tr>
<td></td>
<td>psmisc (Note1)</td>
<td>psmisc (Note1)</td>
</tr>
<tr>
<td></td>
<td>dmidecode</td>
<td>dmidecode</td>
</tr>
</tbody>
</table>
- **Red Hat Enterprise Linux 7.1 or later**

<table>
<thead>
<tr>
<th>packages</th>
<th>x64</th>
</tr>
</thead>
<tbody>
<tr>
<td>standard C++ library</td>
<td>libstdc++ (i686)</td>
</tr>
<tr>
<td>standard C library</td>
<td>glibc (i686) (**)</td>
</tr>
<tr>
<td>GCC library</td>
<td>libgcc (i686)</td>
</tr>
<tr>
<td>Network command</td>
<td>net-tools</td>
</tr>
<tr>
<td>cron</td>
<td>cronie (<em><strong>), cronie-anacron (</strong></em>)</td>
</tr>
<tr>
<td></td>
<td>crontabs (**)</td>
</tr>
<tr>
<td>syslogd</td>
<td>rsyslog</td>
</tr>
<tr>
<td>others</td>
<td>pcutils</td>
</tr>
<tr>
<td></td>
<td>nss-softokn-freebl(i686)(**)</td>
</tr>
<tr>
<td></td>
<td>iptables</td>
</tr>
<tr>
<td></td>
<td>dmidecode</td>
</tr>
</tbody>
</table>

- **SUSE Linux Enterprise Server 11 SP2 or later**

<table>
<thead>
<tr>
<th>packages</th>
<th>x64</th>
</tr>
</thead>
<tbody>
<tr>
<td>standard C++ library</td>
<td>libstdc++6-32bit</td>
</tr>
<tr>
<td>standard C library</td>
<td>glibc-32bit</td>
</tr>
<tr>
<td>GCC library</td>
<td>libgcc_s1</td>
</tr>
<tr>
<td>cron</td>
<td>cron</td>
</tr>
<tr>
<td>syslog-ng</td>
<td>syslog-ng (*)</td>
</tr>
<tr>
<td></td>
<td>klogd (*)</td>
</tr>
<tr>
<td></td>
<td>libnet (*)</td>
</tr>
<tr>
<td>others</td>
<td>pcutils</td>
</tr>
<tr>
<td></td>
<td>iptables</td>
</tr>
<tr>
<td></td>
<td>psmisc (Note1)</td>
</tr>
</tbody>
</table>

- **SUSE Linux Enterprise Server 12 or later**

<table>
<thead>
<tr>
<th>packages</th>
<th>x64</th>
</tr>
</thead>
<tbody>
<tr>
<td>standard C++ library</td>
<td>libstdc++6-32bit</td>
</tr>
<tr>
<td>standard C library</td>
<td>glibc-32bit</td>
</tr>
<tr>
<td>GCC library</td>
<td>libgcc_s1</td>
</tr>
<tr>
<td>cron</td>
<td>cron (*)</td>
</tr>
<tr>
<td></td>
<td>cronie (*)</td>
</tr>
<tr>
<td>syslog-ng</td>
<td>rsyslog-*</td>
</tr>
<tr>
<td>others</td>
<td>pcutils</td>
</tr>
</tbody>
</table>
Oracle Linux 6.0 or later

This is required when you use N8103-109/128/134/135 RAID Controllers or NE3108-212 RAID Controller.

Install these packages by the following procedure (This procedure is an example using standard C++ library).

**Step 1** You can check by rpm command if standard C++ library exists in the computer or not. If it has existed in your computer, rpm command appears as shown in the right (the part "**" depends on the operating system). In this case, go to the section "Installation (Linux, VMware ESX)".

```
> rpm -q libstdc++
libstdc++*
```

**Step 2** If standard C++ library has not existed in your computer, rpm command appears as shown in the right. In this case, install it to your computer.

Insert the install disk of operating system that includes the "standard C++ library" to CD-ROM/DVD-ROM drive of your computer.

Change the current directory to the directory where standard C++ library exists and install the standard C++ library by rpm command (the part "**" depends on the operating system).

```
> rpm -ivh libstdc++.rpm
Preparing...           ############################## [100%]
1:libstdc++              [100%]
```

You can see the result of installation by rpm command.

After the installation finishes, the following package will exist in your computer.

`libstdc++*`

(The part "**" depends on the operating system.)

If the installation fails, the package will not exist in your computer.
Installation (Linux, VMware ESX)

Use setup.sh in the installation image to install latest Universal RAID Utility.

You must install the Universal RAID Utility in the ESX Server. Do not install Universal RAID Utility in the virtual machine.

Step 1  Check if the operating system recognizes all the RAID Controllers connected. Please be sure to connect all the RAID Controllers before installing Universal RAID Utility.

The program to control the RAID Controller depends on the type of RAID Controller. Please be sure to connect all the RAID Controllers first then install Universal RAID Utility.

Step 2  Execute setup.sh in the installation image.

Change the current directory to the directory in which the installation image is stored and type as follows:
(In case of Linux)
sh setup.sh --install
(In case of VMware ESX)
sh setup.sh --install –reptbien

- Specify “–nomgr” instead of “–install” as an option at installation to exclude the NEC ESMPRO Manager Communication Module (eciservice package and raidsrv agent service).
- If OpenSLP (openslp-server package) has already been installed in your computer, before you install Universal RAID Utility, please uninstall this package by the following command. However, if you do not install the NEC ESMPRO Manager communication module, this procedure is not required.
rpm -e openslp-server

Step 3  At the end of setup.sh, the installation is completed. Check the result of the installation by using the rpm command. When the installation is completed properly, the following packages are installed:
- UniversalRAIDUtility-x.yy-z (x is major version, yy is minor version, z is release number for x.yy)
- eciservice-a.bb-x.i386 (a is major version, bb is minor version)
(eciservice package and raidsrv agent service are not installed when you specify the –nomgr option at setup.)
Also, the programs to manage the RAID Controllers will be installed with any one of the following combinations depending on the type of the RAID Controller used in your system.
- storelib-a.bb-0 (a.bb is version)
- WebPAMPRO_Agent-3.aa.bbbb-cc (aa.bbbb-cc is version)
- storelib-a.bb-0 (a.bb is version) and WebPAMPRO_Agent-3.aa.bbbb-cc (aa.bbbb-cc is version)
If the installation fails, these packages do not exist in the computer.

Universal RAID Utility does not install the following packages in the VMware ESX environment. Please note that the installation is finished successfully in VMware ESX even after the program does not exist.
- storelib-a.bb-0. (a.bb is version)

NEC ESMPRO Manager Ver. 5.5 or later versions is required to manage the server where Universal RAID Utility Ver4.1 has been installed.
See “Installation of NEC ESMPRO Manager” for details.
Uninstallation (Linux, VMware ESX)

Use setup.sh in the installation image to uninstall Universal RAID Utility.

Use the same version of the Setup Program as the one when you install the current Universal RAID Utility.

Step 1  Stop raidcmd if you are using it. If you uninstall Universal RAID Utility while you are using raidcmd, the uninstallation of Universal RAID Utility will fail.

Step 2  Execute setup.sh in the installation image.
Change the current directory to the directory in which the installation image is stored and type as follows:
sh setup.sh --uninstall

Step 3  At the end of setup.sh, the uninstallation is completed. Check the result of the uninstallation by using the rpm command. When the uninstallation is completed properly, the following packages will be uninstalled:
- UniversalRaidUtility-x.yy-z (x is major version, yy is minor version, z is revision number)
- eciservice-a.bb-x.i386 (a is major version, bb is minor version)
Also, one or several packages to control RAID Controller are uninstalled.

If another application is using "eciservice-a.bb-x.i386" (a is major version, bb is minor version), "eciservice-a.bb-x.i386" (a is major version, bb is minor version) is not uninstalled. Please note that the uninstallation is finished successfully even if the program "eciservice-a.bb-x.i386" exists in this case.

Installation of NEC ESMPRO Manager

Install NEC ESMPRO Manager Ver. 5.5 or later versions is required to manage the RAID System that Universal RAID Utility Ver2.5 or later version manages. If the older version of NEC ESMPRO Manager has been installed, update it to Ver. 5.5 or later versions. But, if you use the function to make/remove Hot Spare by NEC ESMPRO Manager, you must use NEC ESMPRO Manager Ver. 5.72 or later. You cannot manage the RAID System from Windows GUI of NEC ESMPRO Manager. Be sure to use Web GUI to manage the RAID Controller.

Do not click Back/Forward button on a browser of the Web GUI.

You can download NEC ESMPRO Manager from NEC Corporate Website (http://www.nec.com). See “Operation Management” of “Software”.
Change of Universal RAID Utility Configuration

The configuration of Universal RAID Utility must be changed when a RAID Controller is connected or removed. In this case, uninstall existing Universal RAID Utility and then install new Universal RAID Utility.

The following settings must be set again if the following settings has been customized,

- TCP ports that Universal RAID Utility uses
- RAID System Management Mode at the start of RAID Viewer or raidcmd
- Scheduled tasks that registered in Operating System and execute Consistency Check
This chapter describes the procedure of starting or stopping each module in the Universal RAID Utility.

raidsrv service

The raidsrv service is started automatically when your server is booted and stopped automatically when your server is shut down. Without operation of the raidsrv service, the Universal RAID Utility cannot operate normally. Neither makes the raidsrv service be not started nor stop the raidsrv service.

In case that the operating system is Linux or VMware ESX, if the raidsrv service terminates abnormally due to an error or if the process of the raidsrv service is terminated forcibly, the lock file for avoiding multiple starts is left undeleted. The raidsrv service may not be started in this case.

If this occurs, delete the following file before restarting the raidsrv service:
/var/lock/subsys/raidsrv

Starting Universal RAID Utility in Single User Mode

The Universal RAID Utility uses network functions. Accordingly, the Universal RAID Utility cannot be used in the single user mode of Linux and VMware ESX without network functions. To use the Universal RAID Utility in the single user mode, first enable the network functions in the following procedure and start the raidsrv service.

(If you use Red Hat Enterprise Linux 7.1 or later)

Step 1 Start the NetworkManager service.
Step 2 Start the network service.
Step 3 Start the raidsrv service.
Step 4 Check that the raidsrv service is started normally. If the value of the [Active] is active, the raidsrv service is started normally.

(If you use other OS than the above)

Step 1 Start the network service.
Step 2 Start the raidsrv service.
Step 3 Check that the raidsrv service is started normally. If a process ID appears, the raidsrv service is started normally.
raidsrv Agent Service

The raidsrv Agent service is started automatically when your server is booted and stopped automatically when your server is shut down.
Without operation of the raidsrv Agent service, Universal RAID Utility cannot be communicated with NEC ESMPRO Manager. Do not set the raidsrv Agent service not to be started. Do not stop the raidsrv Agent service.

- In case that the operating system is Linux or VMware ESX, if the raidsrv Agent Service terminates abnormally due to an error or the process of the raidsrv Agent Service is terminated forcibly, the lock file for avoiding double starts is left. If the state remains, the raidsrv Agent Service may not be started.
  If this occurs, delete the following file before restarting the raidsrv Agent Service:
  /var/lock/subsys/raidsrv_agent
- raidsrv Agent service cannot use in Single User Mode.

RAID Viewer

Use [Start] menu to open the RAID Viewer.

Click [Start], and point menu in order to [Programs], [Universal RAID Utility] and [RAID Viewer].

- To use the RAID Viewer, you should log on to the computer as a user having the administrator authority. Only users having the administrator authority can execute the RAID Viewer.
- When you start the RAID Viewer on the server not connected to internet, may wait a few minutes until startup the RAID Viewer. See "Verification of Authenticode signature at the startup of the RAID Viewer and Log Viewer" for detail.
- Only a single RAID Viewer can be started at a time.
- The RAID Viewer cannot be started if the raidsrv service does not operate. An error may occur if the RAID Viewer is started just after the start of the OS. It is because the raidsrv service has not been started completely. In this case, wait for a while before restarting the RAID Viewer.

Select [File] on the Menu Bar of the RAID Viewer and click [Exit] to close the RAID Viewer.
Log Viewer

Use [Start] menu to open the Log Viewer.

Click [Start], and point menu in order to [Programs], [Universal RAID Utility], [Log Viewer].

Or select [Tool] menu of the RAID Viewer and click [Log Viewer].

- To use the Log Viewer, you should log on to the computer as a user having the administrator authority. Only users having the administrator authority can execute the Log Viewer.

- When start the Log Viewer on the server not connected to internet, may wait a few minutes until startup the Log Viewer. See "Verification of Authenticode signature at the startup of the RAID Viewer and Log Viewer" for detail.

Only a single Log Viewer can be started at a time.

Select [File] on the Menu Bar of the Log Viewer and click [Exit] to close the Log Viewer.
raidcmd is command on console as "Command Prompt" or "Windows PowerShell" in Windows and console (terminal) in Linux and VMware ESX. The raidcmd is executed on a console. Use the raidcmd by the methods described in "Functions of raidcmd".

- A user having the administrator authority should run the raidcmd. Only users having the administrator authority can execute the raidcmd.
- In case of the operating system is Linux or VMware ESX, the raidcmd can't start by existing the lock file after aborted it. If you start the raidcmd when the lock file exists, the raidcmd displays the following message.

raidcmd:<RU4009> The raidcmd command is already running.

Delete the lock file (/var/lock/subsys/raidcmd), if the raidcmd displays this message when some processes of the raidcmd do not execute at same time,

Only a single raidcmd can be started at a time.


"[Administrator: Command Prompt]" starts by the following procedure.

**Step 1**  Click [Start] menu, and point menu in order to [Programs], [Accessories], [Command Prompt], click [Run as administrator] on shortcut menu.

**Step 2**  The operating system may display [User Account Control] dialog box after clicked [Run as Administrator]. If you want to run the raidcmd, click [Continue].

**Step 3**  [Administrator: Command Prompt] will start soon. You should check the window title is "[Administrator: Command Prompt]".
"[Administrator: Windows PowerShell]" starts by the following procedure.

**Step 1** Click [Start] menu, and point menu in order to [Programs], [Accessories], [Windows PowerShell], click [Run as administrator] on shortcut menu.

If you are using a 64bit OS, please use the [Windows PowerShell] menu and do not use the [Windows PowerShell (x86)] menu. Should you use the [Windows PowerShell (x86)] menu, you would not be able to execute raidcmd.

**Step 2** The operating system may display [User Account Control] dialog box after clicked [Run as Administrator]. If you want to run the Windows PowerShell, click [Yes].

**Step 3** [Administrator: Command Prompt] will start soon. You should check the window title is "[Administrator: Windows PowerShell]".
Standard and Advanced Modes

The RAID Viewer and raidcmd can operate in two RAID System Management Modes, which are Standard Mode and Advanced Modes. The Standard Mode provides the RAID Viewer and raidcmd with standard management functions for RAID Systems. The Advanced Mode provides the RAID Viewer and raidcmd with advanced management and maintenance functions for RAID Systems. Using the two RAID System Management Modes appropriately depending on users and jobs allows the usability of the RAID Viewer to be improved and malfunctions to be avoided.

The table below lists the functions of the RAID Viewer and raidcmd available in each mode.

<table>
<thead>
<tr>
<th>Function</th>
<th>RAID Viewer function</th>
<th>raidcmd command</th>
<th>Standard mode</th>
<th>Advanced mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>See the version</td>
<td>About... in [Help] menu</td>
<td>run raidcmd without command</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>view</td>
<td>Tree View</td>
<td>run raidcmd without command</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Start Log Viewer</td>
<td>Log Viewer</td>
<td>NA</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Update display information</td>
<td>Rescan</td>
<td>rescan</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Change RAID System Management Mode</td>
<td>Standard Mode</td>
<td>runmode</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>See property</td>
<td>Property</td>
<td>property</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>See status of operation</td>
<td>Operation View</td>
<td>oplist</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Hot Spare (make)</td>
<td>Make Hot Spare</td>
<td>hotspare</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Hot Spare (remove)</td>
<td>Remove Hot Spare</td>
<td>hotspare</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Easy Configuration</td>
<td>Easy Configuration</td>
<td>econfig</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Create Logical Drive (simple)</td>
<td>Create Logical Drive (Simple)</td>
<td>mklds</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Create Logical Drive (custom)</td>
<td>Create Logical Drive (Custom)</td>
<td>mkldc</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Delete Logical Drive</td>
<td>Delete Logical Drive</td>
<td>delld</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Create SSD Cache Drive</td>
<td>Create SSD Cache Drive</td>
<td>mkscd</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Delete SSD Cache Drive</td>
<td>Delete SSD Cache Drive</td>
<td>delscd</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Set option parameters of RAID Controller</td>
<td>Property of RAID Controller</td>
<td>optctrl</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Set option parameters of Logical Drive</td>
<td>Property of Logical Drive</td>
<td>optld</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Consistency Check (start)</td>
<td>Start Consistency Check</td>
<td>cc</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Consistency Check (stop)</td>
<td>[Stop] on Operation View</td>
<td>cc</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Consistency Check (start) for schedule running</td>
<td>NA</td>
<td>ccs</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Initialize (start)</td>
<td>Start Initialize</td>
<td>init</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Initialize (stop)</td>
<td>[Stop] on Operation View</td>
<td>init</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Rebuild (start)</td>
<td>Start Rebuild</td>
<td>rebuild</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Rebuild (stop)</td>
<td>[Stop] on Operation View</td>
<td>rebuild</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Location of Physical Device</td>
<td>Locate</td>
<td>slotlamp</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Change Status of Physical Device (Online)</td>
<td>Make Online</td>
<td>stspd</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Change Status of Physical Device (Failed)</td>
<td>Make Offline</td>
<td>stspd</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Refresh Battery</td>
<td>Refresh Battery</td>
<td>refresh</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Refresh Battery for schedule running</td>
<td>NA</td>
<td>refreshs</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Silence Buzzer</td>
<td>Silence Buzzer</td>
<td>sbuzzer</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Update firmware of RAID Controller</td>
<td>NA</td>
<td>fwup</td>
<td></td>
<td>✔️</td>
</tr>
</tbody>
</table>
The following message will be displayed when you operate in the Standard Mode with raidcmd. Change the RAID System Management Mode to Advanced Mode.

raidcmd:<RU4004> Invalid RAID System Management Mode.

**RAID System Management Mode when startup RAID Viewer and raidcmd**

**RAID Viewer**

RAID Viewer always starts with Standard Mode. You can change the RAID System Management Mode when RAID Viewer starts. See "Changing RAID System Management Mode at Start of RAID Viewer".

**raidcmd**

raidcmd starts with Standard Mode at first after installing Universal RAID Utility. If you want to change the RAID System Management Mode, you must use "runmode" command (The RAID System Management Mode does not change the mode when restart the server).

**Changing RAID System Management Mode**

The procedure of changing the RAID System Management Mode is below.

**RAID Viewer**

Use [Advanced Mode] or [Standard Mode] in [Tool] menu.

See "[Tool] menu" for detail.

**raidcmd**

**Step 1** If you want to change from Standard Mode to Advanced Mode, run "runmode" command with -md=a parameter.

> raidcmd runmode -md=a Changed RAID System Management Mode to "Advanced Mode".

**Step 2** If you want to change from Advanced Mode to Standard Mode, run "runmode" command with -md=s parameter.

> raidcmd runmode -md=s Changed RAID System Management Mode to "Standard Mode".
Functions of RAID Viewer

This chapter describes the functions of the RAID Viewer.

Structure of RAID Viewer

As shown in the figure below, the RAID Viewer is composed of four parts, Tree View, Operation View, Menu Bar and Status Bar.

Figure 2 Structure of RAID Viewer

Tree View

The Tree View shows the configuration of RAID Systems managed by the Universal RAID Utility as a hierarchical structure. The Tree View also indicates the types and status of components with relevant icons.

The Tree View displays each RAID System existing in your server as a RAID Controller node. Each RAID Controller node has the node of a Battery and Flash Backup Unit on RAID Controller, created all Logical Drives and Disk Array and connected all Physical Devices. A single node includes at least a single component of each type. Every component is accompanied by an icon. The icons indicate the type and the status of each component (server, RAID Controller, Battery, Flash Backup Unit, Logical Drive, and Physical Device) graphically.
**Server**

The first level node shows the server in which the Universal RAID Utility operates.

- ![Server icon] <Server name>

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Server name&gt;</td>
<td>Indicates the name of server having the RAID System.</td>
</tr>
</tbody>
</table>

The server icon indicates the status of all the RAID Systems existing in the server.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Server icon]</td>
<td>Server - Normal</td>
<td>All RAID Systems in the server operate normally. Problems which RAID Controllers define as failures do not occur.</td>
</tr>
<tr>
<td>![Server icon]</td>
<td>Server - Warning</td>
<td>One or more RAID Systems in the warning condition exist in the server.</td>
</tr>
<tr>
<td>![Server icon]</td>
<td>Server - Fatal</td>
<td>One or more RAID Systems in the warning or fatal condition exist in the server.</td>
</tr>
</tbody>
</table>

**RAID Controller**

Each RAID System on the server is the RAID Controller node. A RAID Controller node equals a RAID Controller, and shows the number and model of the RAID Controller.

- ![RAID Controller icon] RAID Controller #<Number> <Model>

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Number&gt;</td>
<td>Indicates the management number (logical address) of the RAID Controller in the Universal RAID Utility.</td>
</tr>
<tr>
<td>&lt;Model&gt;</td>
<td>Indicates the model name of the RAID Controller.</td>
</tr>
</tbody>
</table>

A RAID Controller icon indicates the status of all the RAID Systems on the RAID Controller.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![RAID Controller icon]</td>
<td>RAID Controller - Normal</td>
<td>All components on the RAID Controller including Battery, Flash Backup Unit, Logical Drives, and Physical Devices operate normally. No failures or decrease of endurance have not been detected by the RAID Controller</td>
</tr>
</tbody>
</table>
| ![RAID Controller icon] | RAID Controller - Warning | One or more components on the RAID Controller including Battery, Flash Backup Unit, Logical Drives, and Physical Devices are in the following condition :
"Containing one or more failed or endurance decreased components but being operable" |
| ![RAID Controller icon] | RAID Controller - Fatal | One or more components on the RAID Controller including Battery, Flash Backup Unit, Logical Drives, and Physical Devices are in the following condition :
"Containing one or more failed or endurance decreased components and being inoperable" |
Battery

If the RAID Controller has the Battery, the RAID Controller node has a Battery node. A Battery node and icon shows the status of Battery.

- **[Icon] Battery [<Status>]**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Status&gt;</td>
<td>Indicates the status of the Battery installed in the RAID Controller.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Battery]</td>
<td>Battery - Normal</td>
<td>The Battery operates normally.</td>
</tr>
<tr>
<td>![Battery]</td>
<td>Battery - Warning</td>
<td>The RAID Controller detects any problem of the Battery.</td>
</tr>
</tbody>
</table>

Flash Backup Unit

If the RAID Controller has the Flash Backup Unit, the RAID Controller node has a Flash Backup Unit node. A Flash Backup Unit node and icon shows the status of Flash Backup Unit.

- **[Icon] Flash Backup Unit [<Status>]**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Status&gt;</td>
<td>Indicates the status of the Flash Backup Unit installed in the RAID Controller.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Flash Backup Unit]</td>
<td>Flash Backup Unit - Normal</td>
<td>The Flash Backup Unit operates normally.</td>
</tr>
<tr>
<td>![Flash Backup Unit]</td>
<td>Flash Backup Unit - Warning</td>
<td>The RAID Controller detects any problem of the Flash Backup Unit.</td>
</tr>
</tbody>
</table>

Disk Array

If there are some Logical Drive in the RAID Controller, the RAID Controller node has the Disk Array nodes included the Logical Drives. The Disk Array node equals a Disk Array, and shows the number of the Disk Array. The Logical Drives you have created, all Physical Devices as the members of the Logical Drives, and Dedicated Hot Spares you have assigned to the Logical Drives exist in the Disk Array node.

- **[Icon] Disk Array #<Number>**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Number&gt;</td>
<td>Indicates the management number (logical address) of the Disk Array in the Universal RAID Utility.</td>
</tr>
</tbody>
</table>

A Disk Array icon indicates the status of the Disk Array.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Disk Array]</td>
<td>Disk Array - Normal</td>
<td>All the created Logical Drives, all the member Physical Devices and all the Dedicated Hot Spares operate normally. No failures or decrease of endurance have been detected by the RAID Controller.</td>
</tr>
<tr>
<td>![Disk Array]</td>
<td>Disk Array - Warning</td>
<td>One or more Logical Drives, Physical Devices, or Dedicated Hot Spares are in the warning condition in the Disk Array.</td>
</tr>
<tr>
<td>![Disk Array]</td>
<td>Disk Array - Fatal</td>
<td>One or more Logical Drives, Physical Devices, or Dedicated Hot Spares are in the warning or fatal condition in the Disk Array.</td>
</tr>
</tbody>
</table>
SSD Cache Disk Array

When you create SSD Cache Drive in the RAID Controller, you can see that SSD Cache Disk Array node for that SSD Cache Drive is in the RAID Controller node. A single SSD Cache Disk Array node equals an SSD Cache Disk Array, and shows the number of the SSD Cache Disk Array. The SSD Cache Drive you have created, all the member Physical Devices exist in the SSD Cache Disk Array node.

- **[Icon] Disk Array #<Number> SSD Cache**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Number&gt;</td>
<td>Indicates the management number (logical address) of the SSD Cache Disk Array in the Universal RAID Utility.</td>
</tr>
</tbody>
</table>

An SSD Cache Disk Array icon indicates the status of SSD Cache Disk Array.

<table>
<thead>
<tr>
<th>Icon</th>
<th>SSD Cache Disk Array</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>SSD Cache Disk Array - Normal</td>
<td>All the SSD Cache Drives you have created, all the member Physical Devices operate normally. No failures have been detected by the RAID Controller.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>SSD Cache Disk Array - Warning</td>
<td>One or more Physical Devices in the warning condition exist in the SSD Cache Disk Array.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>SSD Cache Disk Array - Fatal</td>
<td>One or more Physical Devices in the warning or fatal condition exist in the SSD Cache Disk Array.</td>
</tr>
</tbody>
</table>

Logical Drive

The Logical Drive node exists in the Disk Array node. A Logical Drive node equals a Logical Drive, and shows the number, status and RAID Level of the Logical Drive.

- **[Icon] LD #<Number> [<Status>] <RAID Level>**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Number&gt;</td>
<td>Indicates the management number (logical address) of the Logical Drive in the Universal RAID Utility.</td>
</tr>
<tr>
<td>&lt;Status&gt;</td>
<td>Indicates the status of the Logical Drive.</td>
</tr>
<tr>
<td>&lt;RAID Level&gt;</td>
<td>Indicates the RAID Level of the Logical Drive.</td>
</tr>
</tbody>
</table>

A Logical Drive icon indicates the status of the Logical Drive.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Logical Drive - Normal</td>
<td>The Logical Drive operates normally.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Logical Drive - Warning</td>
<td>Because the Logical Drive contains one or more Physical Devices with Status being Failed, the redundancy of the Logical Drive is lost or degraded. Alternatively, Logical Drive contains one or more Physical Devices with Endurance Remaining being “Running out (20-11%)” or “Need to replace (10% or less)”.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Logical Drive - Fatal</td>
<td>Because the Logical Drive contains one or more Physical Devices with Status being Failed, the Logical Drive is offline and accessing to the Logical Drive is disabled. Alternatively, Logical Drive contains one or more Physical Devices with “Endurance Remaining is End of Life” event detected by the RAID Controller.</td>
</tr>
</tbody>
</table>

A RAID10/RAID50/RAID60 Logical Drive consists of more than one Disk Array according to the type of the RAID Controller. Such Logical Drive nodes are located in more than one Disk Array nodes.
SSD Cache Drive

The SSD Cache Drive node exists in the SSD Cache Disk Array node. An SSD Cache Drive node equals an SSD Cache Drive, and shows the number and status of the SSD Cache Drive.

- [Icon] LD #<Number> [Status> SSD Cache

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Number&gt; Indicates the management number (logical address) of the SSD Cache Drive in the Universal RAID Utility. The number starts from 1 for HDD Logical Drive and SSD Cache Drive.</td>
</tr>
<tr>
<td>&lt;Status&gt; Indicates the status of the SSD Cache Drive.</td>
</tr>
</tbody>
</table>

An SSD Cache Drive icon indicates the status of the SSD Cache Drive.

| Icon | Meaning |
|--------------------------------|
| SSD Cache Drive - Normal | The SSD Cache Drive operates normally. |
| SSD Cache Drive - Fatal | Because Status of all Physical Devices for the SSD Cache Drive is Failed, the SSD Cache Drive is offline and accessing the SSD Cache Drive is disabled. |

Physical Device

The Physical Device node exists in either the Disk Array node or the RAID Controller node. The Physical Device which has created the Logical Drive and created Dedicated Hot Spare exists in the Disk Array node. The other Physical Device exists in RAID Controller node. The Physical Device node equals a Physical Device, and shows the number, status, interface, device type and power status of the Physical Device.

- [Icon] PD <Number> [Status> [Interface]>[Device Type]<<Power Status>

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Number&gt; Indicates the management number (logical address) of the Physical Device in the Universal RAID Utility.</td>
</tr>
<tr>
<td>&lt;Status&gt; Indicates the status of the Physical Device.</td>
</tr>
<tr>
<td>&lt;Interface&gt; Indicates the type of the interface to which the Physical Device is connected.</td>
</tr>
<tr>
<td>&lt;Device Type&gt; Indicates the type of Physical Device.</td>
</tr>
<tr>
<td>&lt;Power Status&gt; Indicates the Power Status of Physical Device. Displayed only when Power Status is Power Saving or Transitioning.</td>
</tr>
</tbody>
</table>

A Physical Device icon indicates the device type and the status of the Physical Device.

| Icon | Meaning |
|--------------------------------|
| Physical Device - Ready | The Physical Device is not used to create a Logical Drive yet. |
| Physical Device - Online | The Physical Device is already used to create a Logical Drive. Problems which the RAID Controller detects as failures do not occur. |
| Physical Device - Hot Spare | The Physical Device is registered as a Hot Spare. |
| Physical Device - Rebuilding | The Physical Device which is rebuilding now. |
| Physical Device - Warning | The Physical Device which detects one or more S.M.A.R.T. errors or Endurance Remaining being “Running out (20-11%)” or “Need to replace (10% or less)”. |
| Physical Device - Fatal | The Physical Device which is detected a failure or “Endurance Remaining Error” event by RAID Controller. |
| Tape Drive | The Physical Device which device type is [Tape Drive]. |
| CD Drive/DVD Drive | The Physical Device which device type is [CD/DVD]. |
A Physical Device icon indicates the power status of the Physical Device when HDD Power Saving function is enabled.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td>Physical Device - Power Saving</td>
<td>The Physical Device which Power Status has been moved to Power Saving by the HDD Power Saving function. “■” is placed at the lower left of the Physical Device icon.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Physical Device - Transitioning</td>
<td>The Physical Device which Power Status is transitioning from Power Saving to Power On by the HDD Power Saving function. “●” is placed at the lower left of the Physical Device icon.</td>
</tr>
</tbody>
</table>

Every node of Dedicated Hot Spare created for more than one Disk Array is located in each node of Disk Array.

### Assigning Physical Device Number

In Universal RAID Utility Ver2.4 and the earlier versions, the number starting from 1 is assigned to each Physical Device in the ascending order of the ID of Physical Devices. From Ver2.5, the policy has been changed that the Physical Device number is assigned based on the enclosure number and slot number, in the format “e<enclosure number>s<slot number>”.

When you install Universal RAID Utility Ver2.5 or later version in the environment where Universal RAID Utility Ver2.4 has been installed, the order of Physical Devices may change. See the property of the Physical Device to check the ID of the Physical Device. For details on the property of Physical Devices, see “Referring to Property of Physical Device”.

### Shortcut Menu

Right-clicking the node of RAID Controller, Disk Array, Logical Drive, Physical Device, Battery, and Flash Backup Unit allows the shortcut menu to appear. On the shortcut menu, you can display the property and execute the something operation. See “Menu Bar” for detail of each function.
The Operation View indicates the status and results of operations executed in the server after the RAID Viewer is started.

The following operations may appear on the Operation View. For each operation, the target RAID Controller, Logical Drive, or Physical Device, and the status of the operation appear.

- Initialize
- Rebuild
- Consistency Check

Operations being executed while the RAID Viewer is started and those started after the RAID Viewer is started are listed. You can see the status and result of operations by the value of [Status].

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running (N %)</td>
<td>The operation is running (N is progress).</td>
</tr>
<tr>
<td>Completed</td>
<td>The operation completed.</td>
</tr>
<tr>
<td>Failed</td>
<td>The operation failed.</td>
</tr>
<tr>
<td>Stopped</td>
<td>The operation stopped (by [Stop]).</td>
</tr>
<tr>
<td>Paused (N %)</td>
<td>The operation is paused (N is progress).</td>
</tr>
<tr>
<td>Queued (N %)</td>
<td>The operation is queued (N is progress).</td>
</tr>
<tr>
<td>Stop Processing</td>
<td>The operation is being stopped (by [Stop]).</td>
</tr>
</tbody>
</table>

Terminated operations continue to appear until the RAID Viewer is closed. However, the terminated operations will not appear at the next start of the RAID Viewer.

To delete an operation terminated while the RAID Viewer is started, click the operation to be deleted and [Delete].

An operation being executed can be stopped on the way. To do this, click the operation to be stopped and [Stop].

- Operations allowed to be stopped vary depending on RAID System Management Modes. See “Standard and Advanced Modes” for details.
- The stop of the operation might not be supported according to the kind of RAID Controller. In that case, the [Stop] does not become effective.
When progress is frequently updated such as initializing a Logical Drive with extremely small capacity, the progress of [Status] might not be able to be displayed correctly. Correct progress is displayed when [Rescan] in [File] menu is run at such time.

**Menu Bar**

The RAID Viewer has four menu items on the Menu Bar, or [File], [Control], [Tool] and [Help].

![Figure 5 Menu of RAID Viewer](image)

The following describes the menu items.

- With the RAID System Management Mode of the RAID Viewer being "Standard", the functions unavailable in the Standard Mode do not appear on the pull-down menus of the menu items.
- Depending on the type or status of the target component selected on the Tree View, some menu items cannot be executed. If so, clicking such a menu item is disabled.

### [File] menu

[File] menu includes items for updating the display information on the RAID Viewer, displaying the property of each component, and terminating the RAID Viewer.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Rescan]</td>
<td>The Universal RAID Utility acquires the configuration and state information from all of RAID System again, and updates the management information by them. The RAID Viewer displays the newest information.</td>
</tr>
<tr>
<td>[Properties...]</td>
<td>Indicates the property of the RAID Controller, Battery, Flash Backup Unit, Disk Array, Logical Drive, or Physical Device selected on the Tree View.</td>
</tr>
<tr>
<td>[Exit]</td>
<td>Closes the RAID Viewer.</td>
</tr>
</tbody>
</table>

### [Control] menu

[Control] menu includes items for operating RAID Controllers, Logical Drives, and Physical Devices. To use a function subordinate to [Control] menu, first click the target component on the Tree View and select the menu item to be executed from the pull-down menu.

Some functions of [Control] menu may be disabled depending on the type or status of the selected component. If the RAID System Management Mode of the RAID Viewer is set to the Standard Mode, the functions restricted in the Standard Mode are disabled. See "Standard and Advanced Modes" for the functions available depending on RAID System Management Modes.
### Executable functions by RAID Controller

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Create Logical Drive]</td>
<td>Creates a Logical Drive in the selected RAID Controller.</td>
</tr>
<tr>
<td></td>
<td>[Create Logical Drive] has two modes, [Simple] and [Custom]. In the [Simple] mode, a Logical Drive can be simply created only by selecting a RAID Level and Physical Devices. In the [Custom] mode, a Logical Drive can be created by specifying detailed settings.</td>
</tr>
<tr>
<td>[Create SSD Cache Drive]</td>
<td>Creates an SSD Cache Drive in the selected RAID Controller.</td>
</tr>
<tr>
<td></td>
<td>[Create SSD Cache Drive] is available only when CacheCade is enable.</td>
</tr>
<tr>
<td>[Silence Buzzer]</td>
<td>Stops the Buzzer in the RAID Controller.</td>
</tr>
</tbody>
</table>

### Executable functions for Battery

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Refresh Battery]</td>
<td>Executes Refresh for the selected Battery.</td>
</tr>
</tbody>
</table>

### Executable functions for Logical Drive

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Start Consistency Check]</td>
<td>Executes Consistency Check for the selected Logical Drive.</td>
</tr>
<tr>
<td></td>
<td>[Start Consistency Check] has two modes, [Automatic Stop Enabled] and [Automatic Stop Disabled]. In the [Automatic Stop Enabled] mode, Consistency Check is stopped automatically when a medium error was detected frequently on a Physical Device. In the [Automatic Stop Disabled] mode, Consistency Check is performed on entire Physical Devices even if a medium error was detected frequently on a Physical Device. See the section “Checking Logical Drive Consistency” for detail.</td>
</tr>
<tr>
<td>[Start Initialize]</td>
<td>Initializes the selected Logical Drive.</td>
</tr>
<tr>
<td></td>
<td>[Start Initialize] has two modes, [Full] and [Quick]. In the [Full] mode, initializes the entire area of a Logical Drive. In the [Quick] mode, initializes only several leading blocks including the information on managing a Logical Drive.</td>
</tr>
<tr>
<td>[Delete Logical Drive]</td>
<td>Deletes the selected Logical Drive.</td>
</tr>
</tbody>
</table>

### Executable functions for SSD Cache Drive

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Delete SSD Cache Drive]</td>
<td>Deletes the SSD Cache Drive.</td>
</tr>
<tr>
<td></td>
<td>[Delete SSD Cache Drive] is available when CacheCade is enable.</td>
</tr>
</tbody>
</table>

### Executable functions for Physical Device

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Start Rebuild]</td>
<td>Rebuilds the selected Physical Device.</td>
</tr>
<tr>
<td>[Hot Spare]</td>
<td>Makes a Hot Spare with the selected Physical Device or removes a Hot Spare.</td>
</tr>
<tr>
<td></td>
<td>[Make Global Hot Spare] makes Physical Devices be Global Hot Spares available as Hot Spares of all Logical Drives in the relevant RAID System.</td>
</tr>
<tr>
<td></td>
<td>[Make Dedicated Hot Spare...] makes Physical Devices be Dedicated Hot Spares available as Hot Spares of specific Logical Drives.</td>
</tr>
<tr>
<td></td>
<td>[Remove Hot Spare] removes Physical Devices from Hot Spares.</td>
</tr>
<tr>
<td>[Make Online]</td>
<td>Sets the selected Physical Device to online.</td>
</tr>
<tr>
<td>[Make Offline]</td>
<td>Sets the selected Physical Device to offline.</td>
</tr>
</tbody>
</table>
[Locate] Goes on (or blinks) the lamp on the slot where the selected Physical Device is installed. [ON] goes on (or blinks) the lamp. [OFF] goes off the lamp.

**[Tool] menu**

[Tool] menu includes tools used to manage RAID Systems and items for changing the operation of the RAID Viewer.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Easy Configuration...]</td>
<td>Executes Easy Configuration allowing a RAID System to be configured easily.</td>
</tr>
<tr>
<td>[Log Viewer]</td>
<td>Starts the Log Viewer.</td>
</tr>
<tr>
<td>[Option...]</td>
<td>Allows you to provide settings for the Universal RAID Utility.</td>
</tr>
</tbody>
</table>

**[Help] menu**

[Help] menu includes the item of indicating the version and revision of the Universal RAID Utility and the version of the RAID Viewer.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[About...]</td>
<td>Indicates the version and revision of the Universal RAID Utility and the version of the RAID Viewer.</td>
</tr>
</tbody>
</table>

**Status Bar**

The Status Bar indicates the current RAID System Management Mode of the RAID Viewer.

![Status Bar of RAID Viewer](image)

Figure 6 Status Bar of RAID Viewer
This chapter describes the functions of the Log Viewer.

### Structure of Log Viewer

As shown in the figure below, the Log Viewer is composed of three parts, or Log View, Menu Bar and Status Bar.

![Figure 7 Structure of Log Viewer](image)

The Status Bar is used only for changing the size of the Log Viewer window.
Log View

The Log View indicates RAID System operation logs logged by the raidsrv service. You can view the following information on the Log View.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Logs are classified into three types as follows:</td>
</tr>
<tr>
<td></td>
<td>✖️ Fatal: A log of the type is registered when a fatal error occurs.</td>
</tr>
<tr>
<td></td>
<td>⚠️ Warning: A log of the type is registered when a problem occurs which is not fatal but requires your attention.</td>
</tr>
<tr>
<td></td>
<td>📊 Information: A log of the type is registered at occurrence of an event such as execution of an operation without any problem.</td>
</tr>
<tr>
<td>Date</td>
<td>Indicates the date on which the event occurred.</td>
</tr>
<tr>
<td>Time</td>
<td>Indicates the time at which the event occurred in the 24-hour format.</td>
</tr>
<tr>
<td>ID</td>
<td>Indicates the event ID of the log.</td>
</tr>
<tr>
<td>Description</td>
<td>Indicates the contents of the log.</td>
</tr>
</tbody>
</table>

Double-clicking an arbitrary log allows the detailed information on the log to be displayed.
Menu Bar

The Log Viewer has two menu items, or [File] and [Help] on the Menu Bar.

![Universal RAID Utility - Log Viewer](image)

**Figure 8 Menu of Log Viewer**

The following describes each menu item.

### [File] menu

[File] menu includes items for updating the display information on the Log Viewer and terminating the Log Viewer.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Refresh]</td>
<td>Reads the contents in the RAID Log and updates the Log View to the latest.</td>
</tr>
<tr>
<td>[Properties...]</td>
<td>Opens the [Event Properties] dialog box and displays the detailed information on the log selected by the Log Viewer.</td>
</tr>
<tr>
<td>[Exit]</td>
<td>Closes the Log Viewer.</td>
</tr>
</tbody>
</table>

### [Help] menu

[Help] menu includes the item of indicating the version of the Log Viewer.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[About...]</td>
<td>Indicates the version of the Log Viewer.</td>
</tr>
</tbody>
</table>
Functions of raidcmd

This chapter describes the functions of the raidcmd.

Command Line

To use the raidcmd, specify a command and one or more parameters for the command if necessary.

```
raidcmd command <parameters of command>
```

Executing the raidcmd without any command and its parameters indicates the version of the raidcmd and the configuration of the RAID system.

Returned Value from raidcmd

The returned value of the raidcmd is the result of executing the command.

<table>
<thead>
<tr>
<th>Returned value</th>
<th>Execution result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Normal termination of command</td>
</tr>
<tr>
<td>1</td>
<td>Abnormal termination of command</td>
</tr>
</tbody>
</table>

Error Messages of raidcmd

When a command of the raidcmd terminates abnormally, the relevant error message appears in the following format:

```
raidcmd (command) (parameters of command)
raidcmd : error message
```

Commands of raidcmd

See "Appendix B : raidcmd Command Reference " for commands of the raidcmd. Use "help" command, displays the help of raidcmd.

Termination of raidcmd

In case of the operating system is Windows, raidcmd is the batch file in system folder (the batch file in system folder call raidcmd binary in the installed folder of Universal RAID Utility). Therefore, if you terminate raidcmd by CTRL + C key, the operating system displays the message as "Terminate batch job (Y/N)?". When this message is displayed, raidcmd binary has already been terminated.
raidcmd displays the RAID System configuration in a tree view, the same as RAID Viewer. Execute raidcmd without a command to display the RAID System configuration.

The version of Universal RAID Utility and the configuration of the current RAID System will appear.

```
raidcmd
Universal RAID Utility Ver 4.10
Revision: xxxx

raidcmd Ver 4, 1, 0, 0

RAID Controller #1 LSI MegaRAID SAS 9267-8i
Battery [Normal]
Disk Array #1
  LD #1 [Online] RAID 1
  PD e252s0 [Online] SATA-HDD
  PD e252s1 [Online] SATA-HDD
Disk Array #2
  LD #2 [Online] RAID 5
  PD e252s2 [Online] SAS-HDD
  PD e252s3 [Online] SAS-HDD
  PD e252s4 [Online] SAS-HDD
  PD e252s5 [Ready] SAS-HDD
  PD e252s6 [Ready] SATA-SSD
  PD e252s7 [Ready] SATA-SSD
```
Referring to Information on RAID System

This chapter describes how to see the configurations and status of RAID Systems and the RAID System operation log.

Referring to Property of RAID Controller

For the information on a RAID Controller, see the property of the RAID Controller.

To display the property of RAID Controller by RAID Viewer, click the RAID Controller whose information is to be seen on the Tree View and click [Properties] on the [File] menu. The [RAID Controller Properties] dialog box has the [General] and [Option] tabs. The [General] tab indicates the property of the RAID Controller.

The [Option] tab allows you to see the settings of the RAID Controller. You can change the settings in the Advanced Mode.

Use "property" command to see property of a RAID Controller by raidcmd.

```
raidcmd property -tg=rc -c=1
```

RAID Controller #1

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>0</td>
</tr>
<tr>
<td>Vendor</td>
<td>Avago</td>
</tr>
<tr>
<td>Model</td>
<td>LSI MegaRAID SAS 9267-8i</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>3.140.05-1294</td>
</tr>
<tr>
<td>Cache Size</td>
<td>1.024MB</td>
</tr>
<tr>
<td>Premium Feature</td>
<td>CacheCade</td>
</tr>
<tr>
<td>Battery Status</td>
<td>Normal</td>
</tr>
<tr>
<td>Rebuild Priority</td>
<td>Middle</td>
</tr>
<tr>
<td>Consistency Check Priority</td>
<td>Low</td>
</tr>
<tr>
<td>Patrol Read</td>
<td>Enable</td>
</tr>
<tr>
<td>Patrol Read Priority</td>
<td>Low</td>
</tr>
<tr>
<td>Buzzer Setting</td>
<td>Disable</td>
</tr>
<tr>
<td>HDD Power Saving</td>
<td>Enable</td>
</tr>
<tr>
<td>Device Standby Time</td>
<td>30 minutes</td>
</tr>
</tbody>
</table>

Some items are left blank or not displayed depending on the type of the RAID Controller because they are not supported in that RAID Controller.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID Viewer</td>
<td>RAID Controller #X indicates the management number (logical address) of the RAID Controller in the Universal RAID Utility. The Universal RAID Utility assigns a number beginning with 1 for each RAID Controller.</td>
</tr>
<tr>
<td>ID</td>
<td>Indicates the original identification value of the RAID Controller. The BIOS utility of the RAID Controller uses the address of the identification value.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Indicates the vendor of the RAID Controller.</td>
</tr>
<tr>
<td>Model</td>
<td>Indicates the model name of the RAID Controller.</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>Indicates the version of the RAID Controller.</td>
</tr>
<tr>
<td>Cache Size</td>
<td>Indicates the size of cache on RAID Controller in MB.</td>
</tr>
<tr>
<td>Item RAID Viewer</td>
<td>Item raidcmd</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Premium Feature</td>
<td>Premium Feature</td>
</tr>
<tr>
<td>- Battery Status</td>
<td>-</td>
</tr>
<tr>
<td>- Flash Backup Unit</td>
<td>-</td>
</tr>
<tr>
<td>Initialize Priority</td>
<td>Initialize Priority</td>
</tr>
<tr>
<td>Rebuild Priority</td>
<td>Rebuild Priority</td>
</tr>
<tr>
<td>Consistency Check Priority</td>
<td>Consistency Check Priority</td>
</tr>
<tr>
<td>Patrol Read</td>
<td>Patrol Read</td>
</tr>
<tr>
<td>Patrol Read Priority</td>
<td>Patrol Read Priority</td>
</tr>
<tr>
<td>Buzzer Setting</td>
<td>Buzzer Setting</td>
</tr>
<tr>
<td>HDD Power Saving (Hot Spare)</td>
<td>HDD Power Saving (Hot Spare)</td>
</tr>
<tr>
<td>Device Standby Time</td>
<td>Device Standby Time</td>
</tr>
</tbody>
</table>
Referring to Property of Battery

For the information on a Battery on RAID Controller, see the property of the Battery by RAID Viewer, and see the property of the RAID Controller by raidcmd.

To display the property of Battery by RAID Viewer, click the Battery whose information is to be seen on the Tree View and click [Properties] on the [File] menu. The [General] tab indicates the property of the Battery.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Indicates the status of the Battery installed in the RAID Controller. Two possible statuses are as follows: Normal: Indicates that the Battery can be used normally. Warning: Indicates that the Battery cannot be used normally due to some reason.</td>
</tr>
</tbody>
</table>

Referring to Property of Flash Backup Unit

For the information on a Flash Backup Unit on RAID Controller, see the property of the Flash Backup Unit by RAID Viewer, and see the property of the RAID Controller by raidcmd.

To display the property of Flash Backup Unit by RAID Viewer, click the Flash Backup Unit whose information is to be seen on the Tree View and click [Properties] on the [File] menu. The [General] tab indicates the property of the Flash Backup Unit.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Indicates the status of the Flash Backup Unit installed in the RAID Controller. Two possible statuses are as follows: Normal: Indicates that the Flash Backup Unit can be used normally. Warning: Indicates that the Flash Backup Unit cannot be used normally due to some reason.</td>
</tr>
</tbody>
</table>
Referring to Property of Logical Drive

For the information on a Logical Drive, see the property of the Logical Drive.

To display the property of Logical Drive by RAID Viewer, click the Logical Drive whose information is to be seen on the Tree View and click [Properties] on the [File] menu.


The [General] tab indicates the property of the Logical Drive.

The [Option] tab allows you to see the settings of the Logical Drive. You can change the settings in the Advanced Mode.

Use "property" command to see property of a Logical Drive by raidcmd.

- **tg**: Specify "ld" to see property of a Logical Drive
- **c**: Number of the RAID Controller
- **l**: Number of the Logical Drive

Ex. Refer to the property of the Logical Drive with RAID Controller Number:1 and Logical Drive Number:2.
raidcmd property -tg=ld -c=1 -l=2

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID Controller</td>
<td>#1</td>
</tr>
<tr>
<td>RAID Drive</td>
<td>#2</td>
</tr>
<tr>
<td>Disk Array Information</td>
<td>2 (order 1/1)</td>
</tr>
<tr>
<td>RAID Level</td>
<td>RAID 5</td>
</tr>
<tr>
<td>Sector Format</td>
<td>512</td>
</tr>
<tr>
<td>Capacity</td>
<td>135GB</td>
</tr>
<tr>
<td>Stripe Size</td>
<td>256KB</td>
</tr>
<tr>
<td>Cache Mode (Current)</td>
<td>Write Through</td>
</tr>
<tr>
<td>Cache Mode (Setting)</td>
<td>Auto Switch</td>
</tr>
<tr>
<td>Type</td>
<td>Logical Drive</td>
</tr>
<tr>
<td>Status</td>
<td>Online</td>
</tr>
<tr>
<td>Item</td>
<td>Item</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Number</td>
<td>RAID Viewer</td>
</tr>
<tr>
<td>ID</td>
<td>ID</td>
</tr>
<tr>
<td>Disk Array</td>
<td>Disk Array</td>
</tr>
<tr>
<td>Information</td>
<td>Information</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>RAID Level</td>
<td>RAID Level</td>
</tr>
<tr>
<td>Sector Format</td>
<td>Sector Format</td>
</tr>
<tr>
<td>Capacity</td>
<td>Capacity</td>
</tr>
<tr>
<td>Type</td>
<td>Type</td>
</tr>
<tr>
<td>Stripe Size</td>
<td>Stripe Size</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Cache Mode</td>
</tr>
<tr>
<td>(Setting)</td>
<td>(Setting)</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Cache Mode</td>
</tr>
<tr>
<td>(Current)</td>
<td>(Current)</td>
</tr>
<tr>
<td>Status</td>
<td>Status</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Each RAID Controller supports specific RAID Levels and Stripe Sizes. Unsupported items indicate space or do not appear in the list.

Each RAID Controller supports specific Cache Modes. Unsupported Cache Modes do not appear.

Each RAID Controller supports specific items appearing on the Property tab of the Logical Drive and specific items whose settings can be changed. Unsupported items indicate space or do not appear in the list.

The status of a Logical Drive is defined depending on the RAID Level and the number of Physical Devices failed.

If the RAID Level is RAID 10 or RAID 50 and two Physical Devices are failed (or RAID 60 and three or four Physical Devices are failed), the status will be [Degraded] or [Offline] depending on the failed Physical Devices.

### Referring to Property of Physical Device

For the information on a Physical Device, see the property of the Physical Device.

To display the property of Physical Device by RAID Viewer, click the Physical Device whose information is to be seen on the Tree View and click [Properties] on the [File] menu. The [General] tab indicates the property of the Physical Device.

Use "**property**" command to see property of a Physical Device by raidcmd.

- **tg**: Specify "pd" to see property of a Physical Device
- **c**: Number of the RAID Controller
- **p**: Number of the Physical Device

Ex. Refer to the property of the Physical Device with RAID Controller:1 and Physical Device Number: e252s0).

```
raidcmd property -tg=pd -c=1 -p=e252s0
```
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID Viewer</td>
<td>Indicates the number of Enclosure inserted Physical Device. This value is the original identification value of Enclosure.</td>
</tr>
<tr>
<td>Enclosure Position</td>
<td>Indicates the location where Enclosure in which Physical Device is inserted is connected.</td>
</tr>
<tr>
<td>Slot</td>
<td>Indicates the number of Slot inserted Physical Device. This value is a number starting from 0 or 1.</td>
</tr>
<tr>
<td>ID</td>
<td>Indicates the original identification value of the Physical Device. Use this value to match Physical Devices managed by the RAID Configuration utility of the RAID Controller and those managed by the Universal RAID Utility. The format of the ID varies depending on the types of RAID Controllers.</td>
</tr>
<tr>
<td>Device Type</td>
<td>Indicates the type of Physical Device. Four possible types are as follows: HDD : Hard Disk Drive SSD : Solid State Drive Tape Drive : Tape Drive CD/DVD : CD drive or DVD drive</td>
</tr>
<tr>
<td>Interface</td>
<td>Indicates the type of the interface to which the Physical Device is connected. Two possible types are as follows: SAS : Serial Attached SCSI SATA : Serial ATA</td>
</tr>
<tr>
<td>Vendor/Model</td>
<td>Indicates the vendor and model name of the Physical Device.</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>Indicates the version of the Physical Device.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Indicates the serial number of the Physical Device. This item is indicated when Device Type item is HDD or SSD.</td>
</tr>
<tr>
<td>Sector Format</td>
<td>Indicates the Sector Format of the Physical Device. The value can be 512, 512e or 4Kn.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Indicates the capacity of the Physical Device in GB. This item is indicated when Device Type item is HDD or SSD.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates the status of the Physical Device. Five possible status are as follows: Online: Indicates that the Physical Device is incorporated into a Logical Drive to operate normally. Failed: Indicates that the Physical Device is incorporated. Rebuilding: Indicates that the Physical Device is rebuilding. Hot Spare: Indicates that the Physical Device is set as a Hot Spare. Ready: Indicates that the Physical Device is not incorporated into a Logical Drive. This item is indicated when Device Type item is HDD or SSD.</td>
</tr>
<tr>
<td>Hot Spare Information</td>
<td>Indicates the Hot Spare mode of the Physical Device if it is specified as a Hot Spare. Two possible modes are as follows: Global: The Physical Device can be used as a Hot Spare of any Disk Array in the RAID Controller. Dedicated: The Physical Device can be used as a Hot Spare of the specified Disk Array. Also indicates the number of the specified Disk Array. This item is displayed only when Status is Hot Spare.</td>
</tr>
<tr>
<td>Item RAID Viewer</td>
<td>Item raidcmd</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
*Normal:* Does not detect any error caused by the S.M.A.R.T. function.  
*Detected:* Detects one or more errors caused by the S.M.A.R.T. function.  
*This item is indicated when Device Type item is HDD or SSD.* |
| Endurance Remaining | Endurance Remaining | *Indicates the endurance remaining of the SSD.*  
*Five possible status are as follows:*  
*Safe (100-51%):* Indicates that the endurance of the SSD is safety.  
*Reducing (50-21%):* Indicates that the endurance of the SSD is progressing.  
*Running out (21-10%):* Indicates that the endurance of the SSD is warning.  
*Need to replace (10% or less):* Indicates that the SSD need to be replaced.  
*End of life:* Indicates that the SSD need to be replaced.  
*This item is indicated when Device Type item is SSD.* |
| Power Status | Power Status | *Indicates the Power Status of Physical Device.*  
*Three possible conditions are as follows:*  
*On:* Power Status is active.  
*Power Saving:* Power Status is Power Saving.  
*Transitioning:* Power Status is transitioning from Power Saving to active. |

---

**Check the numbers of enclosure and slot to compare the Physical Devices which are managed by the RAID Configuration Utility with those which is managed by Universal RAID Utility.**

- Each RAID Controller supports specific items appearing on the Property tab of the Physical Device and specific items whose settings can be changed. Unsupported items indicate space or do not appear in the list.
- Even if Physical Device does not break down when you execute Make Offline, [Status] item is changed to [Failed].
Referring to Property of Disk Array

For the information on a Disk Array, see the property of the Disk Array.

To display the property of Disk Array by RAID Viewer, click the Disk Array whose information is to be seen on the Tree View and click [Properties] on the [File] menu. The [General] tab indicates the property of the Disk Array.

Use “property” command to see property of a Disk Array by raidcmd.

- **tg** : Specify “da” to see property of a Disk Array
- **c** : Number of the RAID Controller
- **a** : Number of the Disk Array

Ex. Refer to the property of Disk Array with RAID Controller number:1 and Disk Array number:1).

```
raidcmd property -tg=da -c=1 -a=1
```

<table>
<thead>
<tr>
<th>Item</th>
<th>Item raidcmd</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number RAID Controller #X</td>
<td>RAID Controller #X</td>
<td>Indicates the management number (logical address) of the Disk Array in the Universal RAID Utility.</td>
</tr>
<tr>
<td>ID Disk Array #Y</td>
<td>ID</td>
<td>Indicates the original identification value of the Disk Array. Use this value to create Disk Array managed by the RAID Configuration utility of the RAID Controller correspond with those managed by the Universal RAID Utility.</td>
</tr>
<tr>
<td>Sector Format</td>
<td>Sector Format</td>
<td>Indicates the Sector Format of the Disk Array. The value can be 512, 512e or 4Kn. It depends on the sector format of the Physical Devices which configure the Disk Array.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Capacity</td>
<td>Indicates the total capacity of Physical Device in Disk Array in GB.</td>
</tr>
<tr>
<td>Unused Capacity</td>
<td>Unused Capacity</td>
<td>Indicates the capacity of unused area in the Disk Array in GB.</td>
</tr>
<tr>
<td>Type</td>
<td>Type</td>
<td>Indicates the Type of Disk Array. Indicates [Disk Array] or [SSD Cache Disk Array].</td>
</tr>
<tr>
<td>Physical Device N</td>
<td>Physical Device N</td>
<td>Indicates the number of the Physical Devices which are the members of Disk Array.</td>
</tr>
</tbody>
</table>
**Checking Execution Status of Operation**

RAID Viewer and raidcmd allows the checking execution status of operation in the RAID System.

To check the execution status of operation by RAID Viewer, use Operation View on RAID Viewer. See “Operation View” for detail.

To check the execution status of operation by raidcmd, use "oplist" command.

The following operations are displayed by "oplist" command.
The target components and status appear in operations:
- Initialize
- Rebuild
- Consistency Check

The operation performed at execution of the raidcmd appears. Terminated operations do not appear. For the results of terminated operations, see the RAID Log and/or properties.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running (N %)</td>
<td>The operation is running (N is progress).</td>
</tr>
<tr>
<td>Paused (N %)</td>
<td>The operation is paused (N is progress).</td>
</tr>
<tr>
<td>Queued (N %)</td>
<td>The operation is queued (N is progress).</td>
</tr>
</tbody>
</table>

**Updating Information of RAID System**

The management information of RAID System managed by the Universal RAID Utility is corrected by the raidsrv service at the following timings:
- Starting raidsrv service
- Receiving an event such as change of RAID System status or change of execution status of an operation having occurred

To update the management information of the RAID System to the latest, collect the newest information of all RAID System by the RAID Viewer and raidcmd.

**RAID Viewer**

Use [Rescan] in [File] menu.

**Step 1** Start the RAID Viewer. The raidsrv service acquires the information on the RAID System from the RAID System again and updates the management information to the latest.

**raidcmd**

Use "rescan" command.

**Step 1** Execute "rescan" command. The raidsrv service acquires the information of the RAID System again and updates the management information to the latest.
Referring to RAID System Operation Log

Operations done for RAID Systems and events occurred in the RAID Systems are registered to the RAID Log of the Universal RAID Utility. See “Logging Events to RAID Log” for detail.

In case of the operating system is Windows, use Log Viewer to see RAID Log.

The information saved in the RAID Log at the start of the Log Viewer appears on it. To update the information, click [Refresh] on the [File] menu. The Log Viewer acquires the RAID Log again and updates the displayed information to the latest.

In case of the operating system is Linux, use text editor or otherwise to see “Logging Events to RAID Log.”
Configuration of RAID System

This chapter describes the configuration of a RAID System by using the Universal RAID Utility.

The Universal RAID Utility provides a variety of functions depending on purposes.

Would like to make Hot Spare as measures against failure of Physical Device.

Allows Global or Dedicated Hot Spare to be made without errors.

See "Making Hot Spare".

Would like to configure RAID System easily due to no expert knowledge of RAID System.

Provides "Easy Configuration" allowing RAID System to be configured without expert knowledge of RAID System.

See "Configuring RAID System Easily".

Would like to add a Logical Drive easily.

Allows Logical Drive to be made only by setting two selection items.

See "Creating Logical Drive Easily".

Would like to specify configuration of Logical Drive closely or create more than one Logical Drive at a time.

Allows information on Logical Drive to be set closely or more than one Logical Drive to be created at a time at will.

See "Creating Logical Drive Freely".

Would like to delete unnecessary Logical Drive.

You can delete the Logical Drive without stopping the System.

See "Deleting Logical Drive".

Would like to improve access performance of the Logical Drive.

You can improve access performance of the Logical Drive by using the SSD Cache Drive.

See "Using CacheCade".

Figure 9 RAID System configuration functions
Making Hot Spare

The Universal RAID Utility can make a Hot Spare to be replaced with a Physical Device in which a failure occurs. Hot spares can have the following two modes.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global (Hot Spare)</td>
<td>Available as a Hot Spare of every Disk Array for a single RAID Controller.</td>
</tr>
<tr>
<td>Dedicated (Hot Spare)</td>
<td>Available as a Hot Spare of a specific Disk Array for a single RAID Controller.</td>
</tr>
</tbody>
</table>

In either mode, note the following to have a Hot Spare operate normally.

- The Physical Device used for rebuild should have the same capacity, rotation speed, other specification, and sector format as the defected Physical Device.
- The Physical Devices with the different size must be used as Dedicated Hot Spares.
- A Physical Device in which a S.M.A.R.T. error is detected cannot be used as a Hot Spare.
- A Physical Device in which an Endurance Remaining is [Running out (20-11%)] or [Need to replace (10% or less)] or [End of Life] cannot be used as a Hot Spare.

The maximum number of Hot Spares that can be created is 8 for N8103-109/128/134/135 RAID Controllers or NE3108-212 RAID Controller.

About Global Hot Spare

Global Hot Spare is a Hot Spare for all the Disk Arrays under a single RAID Controller.

Ex.1 : If you make the Global Hot Spare on the RAID Controller which has Disk Arrays #1 and #2, the Global Hot Spare is a Hot Spare of Disk Arrays #1 and #2.

Ex.2 : If you create the Disk Array #3 on the RAID System of Ex.1, the Global Hot Spare is a Hot Spare for the Disk Array #3 too.
About Dedicated Hot Spare

Dedicated Hot Spare is a Hot Spare for the specified Disk Arrays under a single RAID Controller. The Dedicated Hot Spare has the following features:

- Dedicated Hot Spare is a Hot Spare for specified Disk Arrays.
- One Dedicated Hot Spare can be a Hot Spare for one or more Disk Arrays.
- One or more Dedicated Hot Spares can be a Hot Spare for one or more Disk Arrays.

- Dedicated Hot Spares cannot be created in a Disk Array containing Logical Drives with the RAID Level being RAID 0.
- Dedicated Hot Spares cannot be created in a Disk Array which does not have any Logical Drive.
- Dedicated Hot Spare can be created by a Physical Device as which a Physical Device of the same Interface Type and Device Type to create the Disk Array.

Ex 1: You make the Dedicated Hot Spare on the RAID Controller which has Disk Arrays #1 and #2. If you specify only the Disk Array #1 as the target Disk Array, the Dedicated Hot Spare is a Hot Spare of Disk Array #1.

Ex 2: If you specify the Disk Arrays #1 and #2 as the target Disk Array, the Dedicated Hot Spare is a Hot Spare of Disk Arrays #1 and #2.

Ex 3: In case of the RAID System in Ex1, you can add more Dedicated Hot Spare. If you add the Dedicated Hot Spare #2 to the Disk Array #1, the both Dedicated Hot Spare are the Hot Spare for the Disk Array #1.

Figure 12 Dedicated Hot Spare 1

Figure 13 Dedicated Hot Spare 2
Ex 4: In case of the RAID System in Ex2, you can add more Dedicated Hot Spare likely Ex2. If you add the Dedicated Hot Spare to the Disk Arrays #1 and #2, the both Dedicated Hot Spare are the Hot Spare for the Disk Arrays #1 and #2.

Making Global Hot Spare

The procedure of making a Global Hot Spare is described below.

**RAID Viewer**

**Step 1**  
Start the RAID Viewer. Click a Physical Device with [Status] being [Ready] on the Tree View.

**Step 2**  
Select [Hot Spare] on the [Control] menu and click [Make Global Hot Spare].

**Step 3**  
If the Global Hot Spare is created successfully, you can find that the value of [Status] is set to [Hot Spare] and Item [Hot Spare Information] appears newly with value [Global].
**raidcmd**

**Step 1** Execute "hotspare" command with –mr option and the following parameters.

- **-c**: Number of the RAID Controller containing the Physical Device with which a Hot Spare is made
- **-p**: Number of the Physical Device with which a Global Hot Spare is made
- **-mr**: Specify 'make' to make Global Hot Spare

Ex. Create a Global Hot Spare using the Physical Device with RAID Controller:1 and Physical Device number:e252s5.

```
raidcmd hotspare -c=1 -p=e252s5 -mr=make
```

**Step 2** If the Global Hot Spare is created successfully, you find that the value of [Status] is changed to [Hot Spare] and new item [Hot Spare Information] appears with value [Global].

Use the "property" command to refer to the property of Physical Device.

- **-tg**: Specify pd to refer to the property of Physical Device.
- **-c**: Number of the RAID Controller to which the Physical Device is connected
- **-p**: Number of the Physical Device

Ex. Refer to the property of the Physical Device with RAID Controller number:1 and Physical Device number: e252s5.

```
raidcmd property -tg=pd -c=1 -p=e252s5
```

**Making Dedicated Hot Spare**

The procedure of making a Dedicated Hot Spare is described below.

**RAID Viewer**

**Step 1** Start the RAID Viewer. Click a Physical Device with [Status] being [Ready] on the Tree View.

**Step 2** Select [Hot Spare] on the [Control] menu and click [Make Dedicated Hot Spare...].

**Step 3** The [Make Dedicated Hot Spare] dialog box appears. Check the check box of the Disk Array for which a Dedicated Hot Spare is to be made. The Dedicated Hot Spare may be made for more than one Disk Array.

The capacity of the Physical Device to be used as a Hot Spare must be the same as that of the Physical Device being used in the target Disk Array.

Click [OK] to make the Dedicated Hot Spare.
**Step 4** If the Dedicated Hot Spare is created successfully, you can find that the value of [Status] is set to [Hot Spare] and item [Hot Spare Information] appears newly with value [Dedicated (Disk Array #X)].

**raidcmd**

**Step 1** Execute "hotspare" command with -mr option and the following parameters.
- `-c`: Number of the RAID Controller containing the Physical Device with which a Hot Spare is made
- `-p`: Number of the Physical Device with which a Dedicated Hot Spare is made (The capacity of the Physical Device should be equal to any Physical Device used by the target Disk Array)
- `-mr`: Specify "make" to make Dedicated Hot Spare
- `-a`: Number of the target Disk Array using the Dedicated Hot Spare

Ex. Create a Dedicated Hot Spare for the Disk Array (Disk Array Number:2) using a Physical Device with RAID Controller number: 1 and Physical Device number: e252s5).

```
$ raidcmd hotspare -c=1 -p=e252s5 -mr=make -a=2
Makes Dedicated Hot Spare.
```

**Step 2** If you see the Dedicated Hot Spare is created successfully, you find that the value of [Status] is changed to [Hot Spare] and new item [Hot Spare Information] appears with value [Dedicated].

Use the “property” command to refer to the property of Physical Device.
- `-tg`: Specify pd to refer to the property of Physical Device.
- `-c`: Number of the RAID Controller to which the Physical Device is connected
- `-p`: Number of the Physical Device

Ex. Refer to the property of the Physical Device with RAID Controller number:1 and Physical Device number: e252s5.

```
$ raidcmd property -tg=pd -c=1 -p=e252s5
RAID Controller #1 Physical Device e252s5
Enclosure                  : 252
Enclosure Position         : Internal
Slot                       : 5
ID                         : 23
Device Type                : RAID
Interface                  : SAS
Vendor/Model               : SEAGATE ST9146853SS
Firmware Version           : NQY1
Serial Number              : 6XM00952
Sector Format              : 512
Capacity                   : 135GB
Status                     : Hot Spare
Hot Spare Information      : Dedicated (Disk Array #2)
S.M.A.R.T.                 : Normal
Power Status               : On
```

**Removing Hot Spare**

The procedure of removing a Hot Spare is described below.

**RAID Viewer**

**Step 1** Start the RAID Viewer. Click a Physical Device with [Status] being [Hot Spare] on the Tree View.

**Step 2** Select [Hot Spare] on the [Control] menu and click [Remove Hot Spare].

**Step 3** If the Hot Spare is created successfully, you can find that the value of [Status] of the Physical Device property is set to [Ready] and item [Hot Spare Information] disappears.
Step 1  Execute "hotspare" command with -mr option and the following parameters.

- **c**: Number of the RAID Controller containing the Physical Device from which the Hot Spare is removed
- **p**: Number of the Physical Device from which the Hot Spare is removed
- **mr**: Specify "remove" to remove Hot Spare

Ex. Remove a Hot Spare with RAID Controller number: 1 and Physical Device number: e252s5.

```
raidcmd hotspare -c=1 -p=e252s5 -mr=remove
```

Step 2  If you see the Hot Spare is created successfully, the value of [Status] is changed to [Ready] and item [Hot Spare Information] disappears.

Use the "property" command to refer to the property of Physical Device.

- **tg**: Specify pd to refer to the property of Physical Device.
- **c**: Number of the RAID Controller to which the Physical Device is connected
- **p**: Number of the Physical Device

Ex. Refer to the property of the Physical Device with RAID Controller number:1 and Physical Device number: e252s5.

```
raidcmd property -tg=pd -c=1 -p=e252s5
```
Configuring RAID System Easily

The Universal RAID Utility supports the Easy Configuration function allowing configurations such as creating Logical Drive and making a Hot Spare to be provided in the state where unused Physical Devices are connected to RAID Controllers.

If you decide the number of Physical Devices used for data storage (or the number of Physical Devices configuring Logical Drives) and the number of Physical Devices used as Hot Spares among unused Physical Devices connected to RAID Controllers, the Universal RAID Utility automatically configure the RAID System.

The benefits of configuring a RAID System by using the Easy Configuration are as follows. The Universal RAID Utility performs the jobs which must be examined and manipulated to configure a RAID System instead.

- Allowing a RAID System to be configured only by specifying three items, or a RAID Controller, the number of Physical Devices used for Logical Drives and the number of Logical Drives to be created.
- Allowing the Universal RAID Utility to set all the items associated with Logical Drives (including RAID Level, Capacity, and Stripe Size) automatically.
- Allowing more than one Logical Drive to be created at a time.
- Making Dedicated Hot Spares for Logical Drives automatically created by Universal RAID Utility if Physical Devices are left for Hot Spares.

Procedure of Easy Configuration of RAID System

The following describes the procedure of configuring a RAID System easily.

**RAID Viewer**

**Step 1**  Connect Physical Devices used for Easy Configuration to the RAID Controller before starting the RAID Viewer if required. If the Physical Devices are connected completely, start the RAID Viewer.

**Step 2**  Click [Easy Configuration...] on the [Tool] menu.

**Step 3**  The [Easy Configuration...] wizard is started. In step 1/3, select the RAID Controller to be configured by clicking it. Then click [Next]. In the [RAID Controller] area, RAID Controllers which do not meet the conditions on Easy Configuration do not appear.
Step 4  In step 2/3, specify the number of Physical Devices used by Logical Drives (or the number of Physical Devices used for data storage) and the number of Logical Drives created in the RAID Controller. If Physical Devices of different interface types or device type exist, specify the number of Physical Devices in each type. After the specification, click [Next].

Step 5  Step 3/3 shows the configuration of the RAID System to be configured by the Easy Configuration. To the RAID System according to the displayed information, click [OK]. To change the configuration, click [Back].

Step 6  If you click [OK] in step 3/3, then the RAID System will be configured. After the Logical Drives are created and the makings of Hot Spares are successfully completed, [Completing the “Easy Configuration” Wizard] appears. Now creating the Logical Drives and making Hot Spares is completed. After the wizard is closed, see the Tree View to check the configuration. However, the Initialize of the Logical Drives having been created may not be completed. The progress and result of initializing the Logical Drives can be checked on the Operation View.
raidcmd

Step 1  Connect Physical Devices used for Easy Configuration to the RAID Controller before executing raidcmd if required.

Step 2  Execute "econfig" command.

Step 3  Specify the conditions on Easy Configuration.
In step 1/3, select the RAID Controller to be configured. Enter the RAID Controller number to be configured.

Step 4  In step 2/3, specify the number of Physical Devices used for Logical Drive(s) ("Physical Device count using Logical Drive(s)") and the number of Logical Drives to be created in the RAID Controller ("Making Logical Drive count"). If Physical Devices of different Interface Types, Device Type or Sector Format exist, specify the number of Physical Devices in each type (in the example shown to the right, proper settings are provided for Physical Devices of the SAS interface. If other Physical Devices of different types exist, perform the operation in each type).

Step 5  Step 3/3 shows the configuration of the RAID System to be configured by the Easy Configuration. To configure the RAID System according to the displayed information, type "yes". To change the configuration, type "no". If you type "yes", the raidcmd executes the configuration of the RAID System. After the easy configuration is finished successfully, raidcmd terminates normally. Making Logical Drives and Hot Spares is now completed. See the property of each component to check the configuration. However, the Initialize of the Logical Drives having been created may not be completed. The progress of initializing the Logical Drives can be checked by using "oplist" command. The result of initializing the Logical Drive can be checked by RAID Log.

> raidcmd econfig
Step 1/3 : Select RAID Controller
RAID Controller #1 LSI MegaRAID SAS 9267-8i
RAID Controller [1] : 1

Step 2/3 : Set the contents of configuration
<Physical Device (Type : SAS-HDD, Sector Format : 512/512e)>
Unused Physical Device count : 4
Physical Device count using Logical Drive(s) [ 2- 4] : 3
Hot Spare count : 1
Do you continue ? [yes(y) or no(n)] : y
Maximum Logical Drive count : 1
Creating Logical Drive count [ 1] : 1
Do you continue ? [yes(y) or no(n)] : y
<Physical Device (Type : SATA-HDD, Sector Format : 512/512e)>
Unused Physical Device count : 2
Physical Device count using Logical Drive(s) [ 2] : 2
Hot Spare count : 0
Do you continue ? [yes(y) or no(n)] : y
Maximum Logical Drive count : 1
Creating Logical Drive count [ 1] : 1
Do you continue ? [yes(y) or no(n)] : y
<Physical Device (Type : SATA-SSD, Sector Format : 512/512e)>
Unused Physical Device count : 2
Physical Device count using Logical Drive(s) [ 2] : 2
Hot Spare count : 0
Do you continue ? [yes(y) or no(n)] : y
Maximum Logical Drive count : 1
Creating Logical Drive count [ 1] : 1
Do you continue ? [yes(y) or no(n)] : y
Step 3/3 : Confirm the contents of configuration
RAID Controller #1(0) LSI MegaRAID SAS 9267-8i

Disk Array #1
LD #1 [Online] RAID 5
PD e252s2 [Online] SAS-HDD
PD e252s3 [Online] SAS-HDD
PD e252s4 [Online] SAS-HDD
PD e252s5 [Dedicated Hot Spare] SAS-HDD

Disk Array #2
LD #2 [Online] RAID 1
PD e252s0 [Online] SATA-HDD
PD e252s1 [Online] SATA-HDD

Disk Array #3
LD #3 [Online] RAID 1
PD e252s6 [Online] SATA-SSD
PD e252s7 [Online] SATA-SSD

<Caution>
Create Logical Drive #2 with different Physical Devices of a capacity. Therefore Logical Drive capacity is decided by the smallest Physical Device of capacity.

Run the above configuration. Initialize all of Logical Drive after creating them. You can see the progress and the result of Initialize by "oplist" and "property" commands.
Do you continue ? [yes(y) or no(n)] : yes
RAID Controller Enabling Easy Configuration to Be Executed

Any RAID Controller enabling Easy Configuration to be executed must meet the following conditions.

1. Allowing Dedicated Hot Spares to be made.
2. Connecting with more than one unused Physical Devices which have the same sector format.

Physical Devices Available for Easy Configuration

Only unused Physical Devices are available for Easy Configuration. Unused Physical Devices are those with their [Status] being [Ready].

Creating Logical Drives by Easy Configuration

Logical Drives created by Easy Configuration are described below.

### RAID Levels and the number of Logical Drives allowed to be created

The RAID Level of a Logical Drive created by Easy Configuration should be RAID 1 or RAID 5. Whether RAID 1 or RAID 5 is used is defined by RAID Levels supported by the RAID Controller and the number of Physical Devices used by the Logical Drive. The number of Logical Drives allowed to be created is also defined by the similar conditions.

#### RAID Controller supporting RAID Levels RAID 1 and RAID 5

<table>
<thead>
<tr>
<th>Number of Physical Devices used by Logical Drive</th>
<th>RAID Level of Logical Drive</th>
<th>Number of Logical Drives allowed to be created</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>RAID 1</td>
<td>1</td>
</tr>
<tr>
<td>3 - 5</td>
<td>RAID 5</td>
<td>1</td>
</tr>
<tr>
<td>6 or more</td>
<td>RAID 5</td>
<td>Number of Physical Devices used by Logical Drive / 3</td>
</tr>
</tbody>
</table>

#### RAID Controller supporting RAID 1 only

<table>
<thead>
<tr>
<th>Number of Physical Devices used by Logical Drive</th>
<th>RAID Level of Logical Drive</th>
<th>Number of Logical Drives allowed to be created</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 or more</td>
<td>RAID 1</td>
<td>Number of Physical Devices used by Logical Drive / 2</td>
</tr>
</tbody>
</table>

- The Easy Configuration can only create Logical Drives of RAID 1 or RAID 5.
Physical Devices used for Logical Drives

Physical Devices of lower Physical Device Numbers are used preferentially for Logical Drives to be created excluding those for making Hot Spares.

Ex. : If Physical Devices 1 - 7 can be used for Easy Configuration, Logical Drives #1 is created with Physical Devices 1, 2, and 3 in the ascending order of Physical Device Numbers and Logical Drives #2 is created with Physical Devices 4, 5, and 6. Physical Device 7 (the largest number) is used as a Hot Spare.

If more than one Logical Drive are created and the number of Physical Devices configuring a Logical Drive is not equal to others, a larger number of Physical Devices should be assigned to a Logical Drive having a smaller logical number.

Ex.: If Physical Devices 1 - 7 can be used for Easy Configuration and two Logical Drives are created, Logical Drives #1 and #2 are created with four Physical Devices 1 - 4 and three Physical Devices 5 - 7, respectively.

- Physical Devices in which S.M.A.R.T. errors are detected cannot be used to create Logical Drives.
- Physical Devices in which an Endurance Remaining is [Running out (20-11%)] or [Need to replace (10% or less)] or [End of Life] cannot be used to create Logical Drives.
**Capacity of Logical Drive**

The capacity of a Logical Drive to be created is defined by the RAID Level and the capacities of Physical Devices used for the Logical Drive.

The Easy Configuration uses the entire areas of the Physical Devices to create a Logical Drive.

Ex.: If Physical Devices 1 - 7 can be used in Easy Configuration to create two Logical Drives, use Physical Devices 1 - 4 and 5 - 7 to create Logical Drives #1 and #2, respectively. The capacity of each Logical Drive is defined by the whole capacity of those of the Physical Devices for the Logical Drive.

![Diagram showing Capacities of Logical Drives in Easy Configuration](image)

**Figure 18 Capacities of Logical Drives in Easy Configuration**

**Items set for Logical Drive**

The values of other selection items set for a Logical Drive to be created are defined as shown in the table below.

<table>
<thead>
<tr>
<th>Selection item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stripe Size</td>
<td>Uses the default value set for the RAID Controller. (The value varies depending on the type of the RAID Controller.)</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Uses the default value set for the RAID Controller. (The value varies depending on the type of the RAID Controller.)</td>
</tr>
<tr>
<td>Initialize Mode</td>
<td>Full</td>
</tr>
</tbody>
</table>
Making Hot Spares by Easy Configuration

This section describes the information on Hot Spares to be made by the Easy Configuration.

Number of Hot Spares

The number of Hot Spares is defined by the number of unused Physical Devices connected to the RAID Controller and the number of Physical Devices used for Logical Drives. The number of Hot Spares results from subtracting [Number of Physical Devices specified for Logical Drives] from [Unused Physical Device count] in step 2/3 of the [Easy Configuration...] wizard of RAID Viewer or "econfig" command of raidcmd.

The maximum number of Hot Spares that can be created is 8 for N8103-109/128/134/135 RAID Controllers or NE3108-212 RAID Controller.
Easy Configuration will fail if you leave more than 8 Physical Devices for Hot Spares.

Physical Devices used as Hot Spares

Physical Devices of larger capacities are preferentially used as Hot Spares.

Ex.: For the example shown below, Physical Devices 1 - 7 can be used in Easy Configuration to make two Hot Spares. Use Physical Devices 5 and 6 of larger Physical Device Numbers among the three Physical Devices as Hot Spares.

Physical Device 1 100GB
Physical Device 2 100GB
Physical Device 3 100GB
Physical Device 4 100GB
Physical Device 5 100GB
Physical Device 6 100GB
Physical Device 7 100GB
Hot Spare
Hot Spare

Figure 19 Assigning Hot Spares in Easy Configuration

- Physical Devices in which S.M.A.R.T. errors are detected cannot be used to make Hot Spares.
- Physical Devices in which an Endurance Remaining is [Running out (20-11%)] or [Need to replace (10% or less)] or [End of Life] cannot be used to make Hot Spares.
Modes of Hot Spares

The Easy Configuration can only make Dedicated Hot Spares but cannot make Global Hot Spares. If more than one Logical Drive is created, the Dedicated Hot Spare can be used for all Logical Drives to be created.

Ex.: If Physical Devices 1 - 7 are used in Easy Configuration to create two Logical Drives and a single Hot Spare, the Hot Spare will be the Dedicated Hot Spare for each Logical Drive.

![Figure 20 Making Dedicated Hot Spare in Easy Configuration 1](image1)

Ex.: If Physical Devices 1 - 7 are used in Easy Configuration to create two Logical Drives and two Hot Spares, Physical Devices 7 will be the Dedicated Hot Spares for both Logical Drives #1 and #2.

![Figure 21 Making Dedicated Hot Spares in Easy Configuration 2](image2)
Creating Logical Drive Easily

The Universal RAID Utility supports "Create Logical Drive - Simple Mode" in which a Logical Drive can be created only by selecting two selection items according to the guide.

"Create Logical Drive - Simple Mode" allows you to create a Logical Drive only by specifying two selection items, or the RAID Level of the Logical Drive and Physical Devices to be used.

The benefits of creating a Logical Drive with "Create Logical Drive - Simple Mode" are as follows. The Universal RAID Utility defines selection items which you should examine to create a Logical Drive instead of you.

- Allowing a Logical Drive to be created only by specifying two selection items (RAID Level and Physical Devices to be used).
- Allowing the Universal RAID Utility to set all setting items (including Capacity and Stripe Size) other than the RAID Level and Physical Devices to be used automatically.

Operation Procedure of "Create Logical Drive - Simple Mode"

This section describes the procedure of creating a Logical Drive by "Create Logical Drive - Simple Mode".

RAID Viewer

**Step 1** Connect Physical Devices used for a Logical Drive to the RAID Controller before starting the RAID Viewer if required. If the Physical Devices are connected completely, start the RAID Viewer.

**Step 2** Click the RAID Controller on the Tree View, select [Create Logical Drive] on the [Control] menu, and click [Simple...].

- If only a single unused Physical Device exists in the RAID Controller, "Create Logical Drive - Simple Mode" is disabled.
- You cannot create a Logical Drive if each Physical Device has a different sector format.

**Step 3** The [Create Logical Drive (Simple)] wizard is started. In step 1/3, select the RAID Level of the Logical Drive to be created. After the selection, click [Next].
Step 4  In step 2/3, select Physical Devices to be used to create the Logical Drive. If Physical Devices of different types or Sector Format exist in the RAID Controller, click the type or Sector Format to be used on [Type] or [Sector Format]. Next, check the check boxes of Physical Devices to be used on [Physical Device]. You must select Physical Devices to be used by the number allowing the RAID Level selected in Step 1/3 to be created. After selecting Physical Devices properly, click [Next].

Step 5  Step 3/3 indicates the information on the Logical Drive to be created. Click [OK] to create the Logical Drive with the functions. Click [Back] to change one or more functions.

Step 6  In step 3/3, click [OK] to create the Logical Drive. After the Logical Drive is created completely, [Completing the "Create Logical Drive (Simple)" Wizard] appears. Now the Logical Drive has been created completely. Close the wizard and check the information on the Logical Drive on the Tree View. However, the Logical Drive having been created may not be initialized yet. Check the progress or result of the Initialize of the Logical Drive on the Operation View.

raidcmd

Physical Devices used for creating a Logical Drive should have the same sector format.

Step 1  Connect Physical Devices used for a Logical Drive to the RAID Controller before executing raidcmd if required.
Step 2  Execute "mklds" command with the following parameters.

- **c**: Number of the RAID Controller in which a Logical Drive is created
- **p**: Numbers of the Physical Devices with which a Logical Drive is created (The required number of Physical Devices varies depending on the RAID Level of the Logical Drive to be created).
- **rl**: RAID Level at which a Logical Drive is made ("Create Logical Drive - Simple Mode" allows a Logical Drive with RAID Level being RAID 1 or RAID 5 to be created)

Ex. Create RAID 5 Logical Drive in the Simple Mode using Physical Devices (RAID Controller Number:1 and Physical Devices e252s2, e252s3, and e252s4).

```
raidcmd mklds -c=1 -p=e252s2,e252s3,e252s4 -rl=5
```

Step 3  Type 'yes' to reply to the confirmation message. Then a Logical Drive is created.

Step 4  After the Logical Drive is created successfully, the raidcmd terminates normally. The Logical Drive has been created completely. You can check the information on the Logical Drive by using "property" command. However, the Initialize of the Logical Drive having been created may not be completed. The progress of initializing the Logical Drive can be checked by using "oplist" command. The result of initializing the Logical Drive can be checked by RAID Log.

Physical Devices Available for "Create Logical Drive - Simple Mode"

Unused Physical Devices are available for "Create Logical Drive - Simple Mode".

- Physical Devices in which S.M.A.R.T. errors are detected cannot be used to create Logical Drives.
- Physical Devices in which an Endurance Remaining is [Running out (20-11%)] or [Need to replace (10% or less)] or [End of Life] cannot be used to create Logical Drives.

Unused Physical Devices are those with their [Status] being [Ready].

Creating Logical Drives by "Create Logical Drive - Simple Mode"

This section describes the information on Logical Drives to be created by "Create Logical Drive - Simple Mode".

RAID Level

The RAID Level of a Logical Drive which can be created by "Create Logical Drive - Simple Mode" should be RAID 1 or RAID 5.

Capacity of Logical Drive

The capacity of a Logical Drive to be created is defined by the RAID Level and the capacities of Physical Devices used for the Logical Drive. In "Create Logical Drive - Simple Mode", a Logical Drive is created by using the entire areas of the Physical Devices.

Items set for Logical Drive

The values of other selection items set for a Logical Drive to be created are defined as shown in the table below.

<table>
<thead>
<tr>
<th>Selection item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stripe Size</td>
<td>Uses the default value set for the RAID Controller. (The value varies depending on the type of the RAID Controller.)</td>
</tr>
</tbody>
</table>
Creating Logical Drive Freely

The Universal RAID Utility supports "Create Logical Drive - Custom Mode" in which a Logical Drive can be created as required by specifying the setting items of the Logical Drive closely.

"Create Logical Drive - Custom Mode" allows you to create a Logical Drive by specifying the setting items of the Logical Drive closely. It can also be used to create Logical Drives of several RAID Levels or create a Logical Drive by using unused area of Disk Array. In addition, "Create Logical Drive - Custom Mode" enables more than one Logical Drive to be created at a time (only RAID Viewer).

The benefits of creating Logical Drives by "Create Logical Drive - Custom Mode" are as follows:

- Allows to specify Logical Drives of various RAID Levels (RAID 0, RAID 1, RAID 5, RAID 6, RAID 10, RAID 50 and RAID 60) to be created.
- Allows to specify selection items (including Capacity, Stripe Size, Cache Mode and Initialize Mode) to be specified closely.
- Allows to specify not only unused Physical Devices but also unused area of Disk Array to be used to create a Logical Drive.
- Allows to specify more than one Logical Drive to be created by a set of operations (only RAID Viewer).

Operation Procedure of "Create Logical Drive - Custom Mode"

This section describes the procedure of creating a Logical Drive by "Create Logical Drive - Custom Mode".

*Create Logical Drive - Custom Mode* is available only in the Advanced Mode.

### RAID Viewer

**Step 1** Connect Physical Devices used for a Logical Drive to the RAID Controller before starting the RAID Viewer if required. If the Physical Devices are connected completely, start the RAID Viewer.

**Step 2** Change the RAID System Management Mode to the Advanced Mode if it is set to the Standard Mode. To do this, click [Advanced Mode] on the [Tool] menu. Click a RAID Controller on the Tree View, select [Create Logical Drive] on the [Control] menu, and click [Custom...].

**Step 3** The [Create Logical Drive (Custom)] dialog box is started. In the Custom Mode, register a Logical Drive to be created to the list of the dialog box. If the Logical Drive may be registered, click [Add]. To delete a registered Logical Drive, click the Logical Drive to be deleted and click [Delete].
Step 4  If you click [Add] in the [Create Logical Drive (Custom)] dialog box, the [Register Logical Drive] wizard is started. In step 1/3, select the RAID Level of the Logical Drive to be registered. After the selection, click [Next].

Step 5  Select an existing Disk Array Group or create another Disk Array Group.

When you select an existing Disk Array Group, select the Disk Array Group on [Disk Array Group]. If the RAID Controller contains Physical Devices of different types or Sector Format, click the type to be used on [Type] and [Sector Format]. Next, click the Disk Array node to be used on [Disk Array Group]. After the selection, click [Next].

To create a Disk Array to be used newly, click [Add Disk Array Group]. Then the [Add Disk Array Group] dialog box appears. Check the check boxes of Physical Devices to be used for the added Disk Array by the number required for the RAID Level to be created. Then click [OK]. The newly created Disk Array and Disk Array Group is added to [Disk Array Group] in step 2/3 of the [Register Logical Drive] wizard.
Step 6  In step 3/3, select the setting items of the Logical Drive to be registered. [Capacity] should be a value within the max Capacity of the Logical Drive to be created. If you want to specify the Capacity of Logical Drive, invalidate the check box.

Select [Stripe Size], [Cache Mode] and [Initialize Mode]. After selecting all the setting items, click [Next].

Step 7  If you click [Next] in step 3/3, then [Completing the "Register Logical Drive" Wizard] will appear. Click [Finish] to register the Logical Drive with the data selected on the wizard. To change some data, click [Back].

Step 8  At the completion of the [Register Logical Drive] wizard, the Logical Drive is registered in the list of the [Create Logical Drive (Custom)] dialog box.

Step 9  To create other Logical Drives, click [Add] and repeat steps 4 to 8 by the number of Logical Drives to be created. After registering the Logical Drive to create, click [OK]. Then the dialog box is closed and the registered Logical Drive is created. Check the contents of the Logical Drive on the Tree View and/or its properties. However, the Initialize of the Logical Drive having been created may not be completed. The progress and result of initializing the Logical Drive can be checked on the Operation View.
raidcmd

Physical Devices used for creating a Logical Drive should have the same sector format.

A count of Logical Drive created by raidcmd is 1 at same time.

**Step 1** Connect Physical Devices used for a Logical Drive to the RAID Controller before executing raidcmd if required.

**Step 2** Execute "mkldc" command with the following parameters.
- **c**: Number of the RAID Controller in which a Logical Drive is created
- **p**: Numbers of the Physical Devices used to create a Logical Drive if used (The required number of Physical Devices varies depending on the RAID Level of the Logical Drive to be created)
- **a**: Number of the Disk Array used to create a Logical Drive if used
- **r**: RAID Level of a Logical Drive to be created ("Create Logical Drive - Custom Mode" allows a Logical Drive with RAID Level being RAID 0 RAID 1, RAID 5, RAID 50, RAID 6, RAID 60 to be created)
- **c**: Capacity of a Logical Drive to be created. (This value may be omitted if a Logical Drive is created by using the whole area of unused Physical Devices.)
- **ss**: Stripe Size of a Logical Drive to be created (This value may not be specified if the default value for the RAID Controller is used)
- **cm**: Cache Mode of a Logical Drive to be created (This value may not be specified if the default value for the RAID Controller is used)
- **im**: Operation mode for Initialize executed after a Logical Drive is created (The [Full] mode is recommended. In the [Full] mode, the Initialize Mode may not be specified)

Ex. Create a Logical Drive (RAID5, 20GB, 64 KB stripe size, Auto Switch Cache Mode, and Full Initialization Mode) in the Custom Mode using Physical Devices (RAID Controller Number: 1 and Physical Devices e252s2, e252s3, and e252s4).

```
raidcmd mkldc -c=1 -p=e252s2,e252s3,e252s4 -rl=5 -cp=20 -ss=64 -cm=auto -im=full
```

**Step 3** Type "yes" to reply to the confirmation message. Then a Logical Drive is created.

**Step 4** After the Logical Drive is created successfully, the raidcmd terminates normally. The Logical Drive has been created completely. You can check the information on the Logical Drive by using "property" command. However, the Initialize of the Logical Drive having been created may not be completed. The progress of initializing the Logical Drive can be checked by using "oplist" command. The result of initializing the Logical Drive can be checked by RAID Log.

**Disk Arrays and Physical Devices Available for "Create Logical Drive - Custom Mode"**

For "Create Logical Drive - Custom Mode", Disk Arrays or unused Physical Devices are available depending on the RAID Level of the Logical Drive to be created.
Among empty areas in a Disk Array, the empty area existing at the end of the Disk Array can be used. The RAID Level of a Logical Drive to be created must be the same as that of the Logical Drives existing in the area used on the Disk Array.
If unused Physical Devices are used, create a Disk Array and create a Logical Drive on it.

- Physical Devices in which S.M.A.R.T. errors are detected cannot be used to create Logical Drives.
- Physical Devices in which an Endurance Remaining is [Running out (20-11%)] or [Need to replace (10% or less)] or [End of Life] cannot be used to create Logical Drives.
- Disk Array which does not have any Logical Drive cannot be used to create Logical Drives.

Unused Physical Devices are those with their [Status] being [Ready].
Creating Logical Drives by "Create Logical Drive - Custom Mode"

This section describes the information on Logical Drives to be created by "Create Logical Drive - Custom Mode".

**RAID Levels**

The RAID Level of a Logical Drive which can be created by "Create Logical Drive - Custom Mode" should be RAID 0, RAID 1, RAID 5, RAID 6, RAID 10, RAID 50 or RAID 60.

> Supported RAID Levels vary in RAID Controllers. Unsupported RAID Levels cannot be selected.

**Capacity of Logical Drive**

A Logical Drive to be created in the Custom Mode can have any capacity by the GB unit also the capacity of the rest less than GB.

**Items set for Logical Drive**

The values of other selection items set for a Logical Drive to be created are defined as shown in the table below.

<table>
<thead>
<tr>
<th>Selection Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stripe Size</td>
<td>Select a value out of 1KB, 2KB, 4KB, 8KB, 16KB, 32KB, 64KB, 128KB,</td>
</tr>
<tr>
<td></td>
<td>256KB, 512KB, and 1024KB.</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Three possible values are as follows:</td>
</tr>
<tr>
<td></td>
<td>Auto Switch: Switches the mode automatically between Write Back and</td>
</tr>
<tr>
<td></td>
<td>Write Through depending on the existence and/or status of Battery</td>
</tr>
<tr>
<td></td>
<td>and Flash Backup Unit.</td>
</tr>
<tr>
<td></td>
<td>Write Back: Writes data to the cache memory asynchronously.</td>
</tr>
<tr>
<td></td>
<td>Write Through: Writes data to the cache memory synchronously.</td>
</tr>
<tr>
<td>Initialize Mode</td>
<td>Two possible values are as follows:</td>
</tr>
<tr>
<td></td>
<td>Full: Initializes both the management and data areas in the Logical</td>
</tr>
<tr>
<td></td>
<td>Drive.</td>
</tr>
<tr>
<td></td>
<td>Quick: Initializes only the management information in the Logical</td>
</tr>
<tr>
<td></td>
<td>Drive.</td>
</tr>
</tbody>
</table>

> Supported Stripe Sizes and cache mode vary in RAID Controllers. Unsupported Stripe Sizes and cache modes cannot be selected.
Deleting Logical Drive

The Universal RAID Utility can delete a Logical Drive becoming unnecessary.

- The function of deleting a Logical Drive is available only in the Advanced Mode.
- Before deleting a Logical Drive, check if the Logical Drive contains required data. Deleting a Logical Drive causes all the data saved in the Logical Drive to be lost.
- You can delete Logical Drive with partitions.

You can delete only the Logical Drive that is located at the end of Disk Array.

Deleting Logical Drive

The procedure of deleting a Logical Drive is described below.

**RAID Viewer**

**Step 1** Start the RAID Viewer.

**Step 2** Click the Logical Drive to be deleted on the Tree View. Click [Delete Logical Drive] on the [Control] menu.

**Step 3** Click [yes] on the dialog box shown to the right to run the delete. Click [No] to abort the delete Logical Drive.

**raidcmd**

**Step 1** Execute "delld" command with the following parameters.
- c : Number of the RAID Controller containing the Logical Drive to be deleted
- l : Number of the Logical Drive to be deleted

**Step 2** Displays the Warning message and the confirmation message. Type "yes" to reply to the confirmation message. Then a Logical Drive is deleted. Type "no" to abort the delete Logical Drive.
Using CacheCade

The CacheCade is the function to create the SSD Cache Drive using Solid State Drive(s) (SSD). The SSD Cache Drive operates as the Cache of Logical Drive. SSD Cache Drive that improves access performance of the Logical Drive.

- The function of creating SSD Cache Drive is available when the CacheCade function is enabled.
- The function of Create and Delete SSD Cache Drive are available with N8103-151/152/168/174 RAID Controller.

Create SSD Cache Drive

This section describes the procedure of creating SSD Cache Drive by “Create SSD Cache Drive”. [Create SSD Cache Drive] is function of creating SSD Cache Drive by selected Solid State Drive. The SSD Cache Drive is can create from one Solid State Drive.

- The function of Create SSD Cache Drive is available only in the Advanced mode. Make sure that the RAID System management mode is Advanced mode.
- Be sure to use the same size and spec of solid state drives when you create SSD Cache Drive with more than one solid state drives.

RAID Viewer

Step 1  Connect Solid State Drive(s) used for an SSD Cache Drive to the RAID Controller before starting [Create SSD Cache Drive] if required. If the Solid State Drive(s) is connected completely, start the RAID Viewer.

Step 2  Click a RAID Controller on the Tree View. Click [Create SSD Cache Drive] on the [Control] menu.

Step 3  The [Create SSD Cache Drive] dialog box is started. Select Solid State Drive(s) to be used to create the SSD Cache Drive. If the different types of Solid State Drives exist in the RAID Controller, select the interface type to be used on [Type]. Next, check the check boxes of Solid State Drive to be used on [Physical Device]. You can select one or more Solid State Drives. After selecting Solid State Drive(s) properly, click [Next].
Click [Next]. The [Check the contents, and completing the "Create SSD Cache Drive" Wizard] window appears. The window shows the contents of SSD Cache Drive to be created. To create an SSD Cache Drive with the settings displayed, click [Finish]. To change the settings, click [Back].

Click [Finish] to create an SSD Cache Drive and close the wizard. After the wizard closes, see the Tree View to check the contents. Click [Back] to cancel the creation of SSD Cache Drive.

raidcmd

Connect Solid State Drive(s) used for an SSD Cache Drive to the RAID Controller before executing raidcmd if required.

Execute "mkscd" command with following parameters:
- \(-c\): Number of RAID Controller in which an SSD Cache Drive is created.
- \(-p\): Numbers of the Physical Device(s) used for creating of SSD Cache Drive.

Ex) Create SSD Cache Drive using the Solid State Drives (RAID Controller Number is 1, Physical Device Number is e252s6, e252s7).

raidcmd mkscd -c=1 -p= e252s6,e252s7

Display the confirmation message. Type *yes* to create an SSD Cache Drive. Type *no* to cancel the creation of SSD Cache Drive.

raidcmd terminates normally when SSD Cache Drive is created successfully. You can check the property of the created SSD Cache Drive by using "property" command.
Capacity of SSD Cache Drive

The capacity of SSD Cache Drive to be created depends on the capacity of Solid State Drive(s). The maximum size of SSD Cache Drive is 512GB in total.

The SSD Cache Drive is created by using the entire areas of Solid State Drive. Be sure to use the same size and spec of solid state drives when you create a single SSD Cache Drive with more than one solid state drives.

Ex. : [Create SSD Cache Drive] creates the SSD Cache Drive by using Solid State Drives (Physical Devices (SSD) 5, 6).

![Diagram of SSD Cache Drive Capacities](image)

Figure 22 Capacities of SSD Cache Drive
Deleting SSD Cache Drive

The procedure of deleting an SSD Cache Drive is described below.

The function of Delete SSD Cache Drive is available only in the Advanced mode. Make sure that the RAID System management mode is Advanced mode.

RAID Viewer

**Step 1** Start the RAID Viewer.

**Step 2** Click the SSD Cache Drive to be deleted on the Tree View. Click [Delete SSD Cache Drive] on the [Control] menu.

**Step 3** Click [yes] on the dialog box shown to the right to delete the SSD Cache Drive. Click [No] to cancel the deletion of the SSD Cache Drive.

raidcmd

**Step 1** Execute "delscd" command with the following parameters.

- `-c`: Number of RAID Controller the SSD Cache Drive to be deleted.
- `-l`: Number of SSD Cache Drive to be deleted.

Ex) Delete SSD Cache Drive (RAID Controller number is 1, Logical Drive number is 2).

```
raidcmd delscd -c=1 -l=2
```

**Step 2** Display the confirmation message. Type "yes" to delete the SSD Cache Drive. Type "no" to cancel the deletion of SSD Cache Drive.
This chapter describes the maintenance of a RAID System using the Universal RAID Utility.

Providing Patrol Read for Physical Devices

The Patrol Read function reads data saved in all Physical Devices in a RAID System entirely to check whether a read error occurs or not regularly in the background. The Patrol Read is effective to find failures including Physical Device medium error early. Be sure to execute Patrol Read for a RAID Controller if it supports the Patrol Read.

The Universal RAID Utility provides the function of indicating whether Patrol Read is executed or not and the function of changing the Patrol Read Priority.

If the Medium Error was detected frequently on the same Physical Device during execution of Patrol Read, Patrol Read is automatically stopped to suppress deterioration of access performance to the Physical Device. When Patrol Read is running on two or more RAID controllers, a target to be stopped Patrol Read is only the Physical Device on which Medium Error was detected frequently. See the section “Monitoring a Medium Error to see if they occur frequently”.

Some RAID Controller may not support the Patrol Read function. In such environment, [Patrol Read] and [Patrol Read Priority] are not displayed on RAID Viewer and raidcmd, and the “optctrl” command will fail.

Setting Whether Patrol Read Is Executed or Not

Whether Patrol Read is executed or not should be set in RAID Controllers. The procedure of setting whether Patrol Read is executed or not is described below.

Changing the setting whether Patrol Read is executed or not is available only in the Advanced Mode.

RAID Viewer

Step 1 Start the RAID Viewer. Click a RAID Controller on the Tree View. Then click [Properties] on the [File] menu.

Step 2 Click the [Options] tab in the [RAID Controller Properties] dialog box. Change the value of [Patrol Read] to [Enable] or [Disable]. Click [OK] or [Apply].

raidcmd

Step 1 Execute “optctrl” command with -pr option and the following parameters.

- \( \text{-c} \) : Number of the RAID Controller for which whether Patrol Read is executed or not is set
- \( \text{-pr} \) : Specify “enable” to allow Patrol Read / Specify “disable” not to allow Patrol Read.

Step 2 Check the execution result by using “property” command. The following parameter of RAID Controller is changed if the settings has been changed successfully.

[Patrol Read]: ‘enable’ to allow Patrol Read “disable” not to allow Patrol Read

Ex. Browse the property of the RAID Controller 1.

raidcmd property -tg=rc -c=1
Checking Result of Executing Patrol Read

You can find the result of executing Patrol Read by checking the RAID Log of the Universal RAID Utility. When detects something problem, Universal RAID Utility records the log in the RAID Log.

Setting Patrol Read Priority

You can set the priority in which Patrol Read is executed in your server. The procedure of setting the Patrol Read Priority is described below.

Changing the priority of Patrol Read is available only in the Advanced Mode.

RAID Viewer

Step 1 Start the RAID Viewer. Click the RAID Controller on the Tree View. Then click [Properties] on the [File] menu.

Step 2 Click the [Options] tab in the [RAID Controller Properties] dialog box. Change the value of [Patrol Read Priority] to [High], [Middle], or [Low]. Click [OK] or [Apply].

raidcmd

Step 1 Execute "optctrl" command with -prp option and the following parameters.

- `c`: Number of the RAID Controller for which Patrol Read Priority is set
- `-prp`: Select high, middle, or low to change the Patrol Read Priority.

Ex. Set the Patrol Read Priority to High on the RAID Controller 1.

```
raidcmd optctrl -c=1 -prp=high
```

Step 2 Check the execution result by using "property" command. The property of the RAID Controller changes the value as below.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Patrol Read Priority]</td>
<td>High</td>
</tr>
<tr>
<td>[Buzzer Setting]</td>
<td>High</td>
</tr>
<tr>
<td>[HDD Power Saving(Hot Spare)]</td>
<td>Enable</td>
</tr>
</tbody>
</table>

Ex. Browse the property of the RAID Controller (RAID Controller number: 1).

```
raidcmd property -tg=rc -c=1
```

Example output:

```
RAID Controller #1
ID                         : 0
Vendor                     : Avago
Model                      : LSI MegaRAID SAS 9267-8i
Firmware Version           : 3.140.05-1294
Cache Size                 : 1,024MB
Premium Feature            : CacheCade
Battery Status             : Normal
Rebuild Priority           : Middle
Consistency Check Priority : Low
Patrol Read                : Enable
Patrol Read Priority       : High
Buzzer Setting             : Enable
HDD Power Saving(Hot Spare): Enable
Device Standby Time        : 30 minutes
```
Checking Logical Drive Consistency

The Consistency Check function checks the consistency between the data in the data area of a Logical Drive and the parity. The Universal RAID Utility can start or stop Consistency Check and change the priority in which Consistency Check is executed.

The Consistency Check is effective next to Patrol Read to find failures including Physical Device medium error early. Execute Consistency Check periodically if the RAID Controller does not support Patrol Read or the Patrol Read is disabled. If the Universal RAID Utility is installed, routine execution of the Consistency Check is set for RAID Controllers not supporting Patrol Read.

Consistency Check is executed for each Logical Drive. If the Medium Error was detected frequently on the same Physical Device during the execution of Consistency Check, Consistency Check is automatically stopped to suppress deterioration of access performance to the Physical Device.

When Consistency Check is running on two or more Logical Drives, a target to be stopped Consistency Check is only the Logical Drive that includes the Physical Device on which Medium Error was detected frequently.

If you want to execute Consistency Check through entire Logical Drive even if Medium Error is detected frequently, use the raidcmd with “Automatic Stop Disabled” option. See the section “Monitoring a Medium Error to see if they occur frequently”.

- Starting or stopping the Consistency Check is enabled both in the Standard Mode and Advanced Mode. The function of changing the priority at which the Consistency Check is executed is available only in the Advanced Mode.
- When you execute Consistency Check with “Automatic Stop Disabled”, please don’t reboot the system and the raidsrv service restart. See the section “Executing Consistency Check Manually (Automatic Stop Disabled)”.  
- When Universal RAID Utility fell into a state where it cannot continue to operate for the target Logical Drive (For example, the Logical Drive is Degenerate), Consistency Check will be stopped regardless of “Automatic Stop Enabled” or “Automatic Stop Disabled” mode.
- When you reboot a system during consistency check a RAID Controller, the time of resume consistency check is different by RAID Controller.

The Consistency Check can be executed only for Logical Drives with [Status] being [Online]. The Consistency Check cannot be executed for Logical Drives with RAID Level being RAID 0.

Executing Consistency Check Manually (Automatic Stop Enabled)

Consistency Check is executed in Logical Drives. The procedure of starting Consistency Check is described below.

If the Medium Error was detected frequently on the Physical Device, Consistency Check is automatically stopped to suppress deterioration of access performance to the Physical Device.

RAID Viewer

Step 1  Start the RAID Viewer. Click a Logical Drive on the Tree View. Then click [Start Consistency Check] ->[Automatic Stop Enabled] on the [Control] menu.
Step 2  After Consistency Check is started, the progress of the Consistency Check appears on the Operation View. At the completion of the Consistency Check, [Status] on the Operation View is changed to [Completed].

raidcmd

Step 1  Execute "cc" command with -op option and the following parameters.
- -c: Number of the RAID Controller containing the Logical Drive for which Consistency Check is executed (If specify "all" as parameter, the targets are all Logical Drives of all RAID Controllers)
- -l: Number of the Logical Drive for which Consistency Check is executed (If specify "all" as parameter, the targets are all Logical Drives of RAID Controllers specified by -c)
- -op: Specify "start" to start Consistency Check

To execute Consistency Check for all Logical Drives of a RAID Controller which not support Patrol Read or of which the Patrol Read is disabled, use "ccs" command of the raidcmd.

raidcmd ccs

For the RAID Controller which support Patrol Read or of which the Patrol Read is enabled, "ccs" command is actually not executed even if you execute it.

Step 2  After the Consistency Check is started, the raidcmd terminates normally. Check the execution status of the Consistency Check by using "oplist" command.

Executing Consistency Check Manually (Automatic Stop Disabled)

You can execute the Consistency Check through entire Logical Drive without stop even if a Medium Error is detected frequently.
The procedure of starting Consistency Check (Automatic Stop Disabled) is described below.

If you carries out this function at the physical device which media error occurs frequently, there is a fear that the access performance to this physical device degrades. When you’d like to confirm the consistency until the end, please use this function before replacing the Physical Device.

RAID Viewer

Step 1  Start the RAID Viewer. Click a Logical Drive on the Tree View. Then click [Start Consistency Check] -> [Automatic Stop Disabled] on the [Control] menu.

Step 2  After Consistency Check is started, the progress of the Consistency Check appears on the Operation View. At the completion of the Consistency Check, [Status] on the Operation View is changed to [Completed].
**raidcmd**

Use "cc" command.

**Step 1** Execute "cc" command with -op option and the following parameters.

- **c**: Number of the RAID Controller containing the Logical Drive for which Consistency Check is executed (If specify "all" as parameter, the targets are all Logical Drives of all RAID Controllers)
- **l**: Number of the Logical Drive for which Consistency Check is executed (If specify "all" as parameter, the targets are all Logical Drives of RAID Controllers specified by -c)
- **op**: Specify "force" Consistency Check at "Automatic Stop Disabled" mode.

(Example)consistency check of the Logical drive (the RAID Controller number 1 and Logical drive number 2) is begun.

```
raidcmd cc -c=1 -l=2 -op=force
```

**Step 2** After the Consistency Check is started, the raidcmd terminates normally. Check the execution status of the Consistency Check by using "oplist" command.

(Example)the execution situation of the operation is confirmed.

---

**Executing Consistency Check for arbitrary Logical Drive**

You can register the task to schedule the Consistency Check using the Task Scheduler on Windows or cron on Linux or VMware ESX.

After installing Universal RAID Utility, a task to schedule the Consistency Check will be registered that makes it possible to detect failures such as media errors on the RAID Controller which does not support the Patrol Read function.

For the RAID Controller which does not support Patrol Read or of which the Patrol Read is disabled, Universal RAID Utility executes Consistency Check using the function of task scheduler.

**Tasks registered by Universal RAID Utility (Windows)**

The Universal RAID Utility registers a task such as that shown in the table below in a Windows task if it is installed.

The Windows task can be used to change the schedule of executing Consistency Check or delete tasks. For how to use tasks, see the Windows help.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task name</td>
<td>Consistency Check</td>
</tr>
<tr>
<td>Execution day of the week</td>
<td>Wednesday</td>
</tr>
<tr>
<td>Starting time</td>
<td>AM 0:00</td>
</tr>
<tr>
<td>Execution command</td>
<td>(Universal RAID Utility installation folder)\cli\raidcmd.exe ccs</td>
</tr>
<tr>
<td>Execution account</td>
<td>NT AUTHORITY\SYSTEM</td>
</tr>
</tbody>
</table>

Note the following point when changes the setting of the task on operating system excluding Windows XP.
- Specify "/V1" option with "/Create" option when uses schtasks command for changing the setting of the task.
- Do not change the [Configure for] of the task of "Consistency Check".
  If does not specify "/V1" option or changes [Configure for] of the task, this task is going to remain in your server after uninstalling Universal RAID Utility. When this task remains after uninstalling Universal RAID Utility, delete it.
Task registered by Universal RAID Utility (Linux, VMware ESX)

The Universal RAID Utility registers a task such as that shown in the table below in a Linux cron if it is installed.

The functions of cron can be used to change the schedule of executing Consistency Check or delete tasks. For how to use cron, see the manual of cron(8), crontab(1), crontab(5) by "man" command.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution day of the week</td>
<td>Wednesday</td>
</tr>
<tr>
<td>Starting time</td>
<td>AM 0:00</td>
</tr>
<tr>
<td>Execution command</td>
<td>/opt/nec/raidcmd/raidcmd ccs</td>
</tr>
<tr>
<td>Execution account</td>
<td>root</td>
</tr>
</tbody>
</table>

Executing Consistency Check for all Logical Drives for a RAID Controller which not support Patrol Read or of which the Patrol Read is disabled.

Use "ccs" command of the raidcmd.

Stopping Consistency Check

You can stop Consistency Check being executed on the way. The procedure of stopping Consistency Check is described below.

RAID Viewer

Step 1  Start the RAID Viewer. See [Operation View] while Consistency Check is executed.

Step 2  Click operation [Consistency Check] which you want to stop. Click [Stop] on the Operation View. After the Consistency Check is stopped, [Status] on the Operation View is changed to [Stopped].

raidcmd

Step 1  Execute "cc" command with -op option and the following parameters.
- -c : Number of the RAID Controller containing the Logical Drive for which Consistency Check is stopped (If specify "all" as parameter, the targets are all Logical Drives of all RAID Controllers)
- -l : Number of the Logical Drive for which Consistency Check is stopped (If specify "all" as parameter, the targets are all Logical Drives of RAID Controllers specified by -c)
- -op : Specify "stop" to stop Consistency Check

Step 2  After the Consistency Check is stopped, the raidcmd terminates normally. The stopped Consistency Check disappears from the list of "oplist" command.

Checking Result of Executing Consistency Check

You can find the result of executing Consistency Check by checking the RAID Log of the Universal RAID Utility. If a problem is detected, the Consistency Check logs both the message indicating the result if Consistency Check has been finished successfully and that indicating the error in the RAID Log.
Setting Consistency Check Priority

You can set the priority at which Consistency Check is executed in the server. The procedure of setting the Consistency Check Priority is described below.

Setting Consistency Check Priority are available only in the Advanced Mode.

RAID Viewer

**Step 1** Start the RAID Viewer. Click the RAID Controller on the Tree View. Then click [Properties] on the [File] menu.

**Step 2** Click the [Options] tab in the [RAID Controller Properties] dialog box. Change the value of [Consistency Check Priority] to [High], [Middle], or [Low]. Click [OK] or [Apply].

raidcmd

**Step 1** Execute `optctrl` command with -ccp option and the following parameters.
- `-c` : Number of the RAID Controller for which Consistency Check Priority is set
- `-ccp` : Select high, middle, or low to change the consistency check priority.

Ex. Set the priority of the Consistency Check of the RAID Controller (RAID Controller Number: 1) to Middle

```
raidcmd optctrl -c=1 -ccp=middle
```

**Step 2** The property of the RAID Controller changes as follows.

Check the execution result by using `property` command.

- `-tg` : Specify rc to browse the property of RAID Controller
- `-c` : The number of the RAID Controller

Ex. Browse the property of RAID Controller (RAID Controller Number: 1)

```
raidcmd property -tg=rc -c=1
```
Initializing Logical Drive

The Initialize writes 0s into the entire area of a Logical Drive to erase the data saved in the Logical Drive. Use the function when you want to erase the data saved in a Logical Drive fully. Initialize has two modes listed in the table below.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>Writes 0s into the entire area of a Logical Drive to erase the data fully.</td>
</tr>
<tr>
<td>Quick</td>
<td>Writes 0s into some blocks in a Logical Drive. Only erases OS installation and partition management information. Initialize of the mode is completed earlier than that of the full mode. However, because 0s are not written into the remaining area, data consistency is not held in the Logical Drive.</td>
</tr>
</tbody>
</table>

- Initialize are available only in the Advanced Mode.
- You can initialize Logical Drive with partitions. Before initializing Logical Drive, check if the Logical Drive contains required data. Initializing a Logical Drive causes all the data saved in the Logical Drive to be lost.
- The Consistency Check of a Logical Drive initialized in the quick mode causes a data inconsistency error to occur due to no data consistency.
- Initialize cannot be executed for any Logical Drive with [Status] being [Online].

Executing Initialize

Initialize should be executed in Logical Drives. The procedure of executing Initialize is described below.

RAID Viewer

Step 1  Start the RAID Viewer. Click a Logical Drive on the Tree View. Select [Start Initialize] on the [Control] menu and click [Full] or [Quick].

Step 2  Click [yes] on the dialog box shown to the right to run the initialize. Click [No] to abort the initialize Logical Drive.
Step 3  After Initialize is started, the progress of the Initialize appears on the Operation View. At the completion of the Initialize, [Status] on the Operation View is changed to [Completed].

raidcmd

Step 1  Execute "init" command with -op option and the following parameters.
- \( -c \) : Number of the RAID Controller containing the Logical Drive for which Initialize is started
- \( -l \) : Number of the Logical Drive for which Initialize is started
- \( -op \) : Specify "start" to start Initialize

Step 2  After the Initialize is started, the raidcmd terminates normally. Check the execution status of the Initialize by using "oplist" command.

Stopping Initialize

You can stop Initialize being executed on the way. The procedure of stopping Initialize is described below.

RAID Viewer

Step 1  Start the RAID Viewer.
Step 2  Start the RAID Viewer. See [Operation View] while Initialize is executed.
Step 3  Click operation [Initialize] which you want to stop. Then click [Stop] on the Operation View. After the Initialize is stopped, [Status] on the Operation View is changed to [Stopped].

raidcmd

Step 1  Execute "init" command with -op option and the following parameters.
- \( -c \) : Number of the RAID Controller containing the Logical Drive for which Initialize is stopped
- \( -l \) : Number of the Logical Drive for which Initialize is stopped
- \( -op \) : Specify "stop" to stop Initialize

Step 2  After the Initialize is stopped, the raidcmd terminates normally. The stopped Initialize disappears from the list of "oplist" command.

Checking Result of Executing Initialize

You can find the result of executing Initialize by checking the RAID Log of the Universal RAID Utility. Detecting a problem, the Initialize records the log in the RAID Log.
Setting Initialize Priority

You can set the priority at which Initialize is executed in the server. The procedure of setting the Initialize Priority is described below.

Setting Initialize Priority are available only in the Advanced Mode.

RAID Controllers of some types may not support the setting Initialize Priority. If does not support this function, RAID Viewer and raidcmd do not display this item in the property of RAID Controller and the execution of "optctrl" command of raidcmd fails.

RAID Viewer

Step 1  Start the RAID Viewer. Click the RAID Controller on the Tree View. Then click [Properties] on the [File] menu.

Step 2  Click the [Options] tab in the [RAID Controller Properties] dialog box. Change the value of [Initialize Priority] to [High], [Middle], or [Low]. Click [OK] or [Apply].

raidcmd

Step 1  Execute "optctrl" command with the following parameters.

- \( c \): Number of the RAID Controller for which Initialize Priority is set
- \( ip \): Select high, middle, or low to change the Initialize Priority.

Ex. Set the Initialize Priority of the RAID Controller (RAID Controller number:1) to Low

\[
\text{raidcmd optctrl}-c=1 -ip=low
\]

Step 2  The property of the RAID Controller changes as follows when the setting has been changed successfully.

[Initialize Priority]: Priority after change

Step 3  Check the execution result by using "property" command.

- \( tg \) : Specify rc to browse the property of RAID Controller
- \( c \) : The number of the RAID Controller

Ex. Browse the property of RAID Controller (RAID Controller Number: 1)

\[
\text{raidcmd property -tg=rc -c=1}
\]
Changing Cache Mode of Logical Drive

You can change the cache mode of Logical Drive. The range of change differs depending on the type of the RAID Controller.

<table>
<thead>
<tr>
<th>RAID Controller</th>
<th>Changed cache</th>
<th>Range of change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboard RAID Controller (LSI Embedded MegaRAID)</td>
<td>Hard Disk Drive</td>
<td>All the Logical Drives in a single Disk Array.</td>
</tr>
<tr>
<td>Option and Internal RAID Controller (NB103-128/G128/134/135 or NE3108-212)</td>
<td>RAID Controller</td>
<td>All the Logical Drives in a single RAID Controller.</td>
</tr>
<tr>
<td>Option and Internal RAID Controller</td>
<td>RAID Controller (You can change each of Logical Drive.)</td>
<td>Only the Logical Drive selected</td>
</tr>
</tbody>
</table>

The setting of the cache mode of Logical Drive influences the performance of server. Please change carefully.

Setting cache mode

The procedure of setting cache mode of Logical Drive is described below.

Changing cache mode is available only in the Advanced Mode.

RAID Viewer

**Step 1** Start the RAID Viewer. Click the Logical Drive on the Tree View. Then click [Properties] on the [File] menu.

**Step 2** Click the [Options] tab in the [Logical Drive Properties] dialog box. Change the value of [Cache Mode (Setting)] to [Auto Switch], [Write Back], or [Write Through]. Click [OK] or [Apply].

raidcmd

**Step 1** Execute `optld` command with -cm option and the following parameters.
- `-c` : Number of the RAID Controller for which Cache Mode change
- `-l` : Number of the Logical Drive for which Cache Mode change
- `-cm` : Select auto, writeback, or writethru to change the Cache Mode.

Ex. Set the Cache Mode of the Logical Drive (RAID Controller number: 1, Logical Drive number: 1) to Write Back

```
raidcmd optld -c=1 -l=1 -cm=writeback
```

**Step 2** The property of the RAID Controller changes as follows when the setting has been changed successfully.

[Cache Mode (Setting)]: Cache Mode after change

Check the execution result by using `property` command.
- `-tg` : Specify rc to browse the property of Logical Drive
- `-c` : The number of the RAID Controller in which the Logical Drive
- `-l` : The number of the Logical Drive

Ex. Browse the property of Logical Drive (RAID Controller Number: 1, Logical Drive: 1)

```
raidcmd property -tg=ld -c=1 -l=1
```

> raidcmd optld -c=1 -l=1 -cm=writeback
> raidcmd property -tg=ld -c=1 -l=1
> RAID Controller #1 Logical Drive #1
> ID : 0
> Disk Array Information : 1 (order 1/1)
> RAID Level : RAID 5
> Sector Format : 512
> Capacity : 20GB
> RAID Controller #1 Logical Drive #1
> Capacity : 20GB
> Sector Format : 512
> ID : 0
> Disk Array Information : 1 (order 1/1)
> RAID Level : RAID 5
> Status : Online
> Type : Logical Drive
> Cache Mode (Current) : Write Back
> Cache Mode (Setting) : Write Back
> Status : Online
> Type : Logical Drive
> raidcmd property -tg=ld -c=1 -l=1

101
Rebuilding Physical Device

Rebuild means incorporation of a new Physical Device to a Logical Drive after a Physical Device is replaced with the new one due to occurrence of an event such as a failure. In general, the Rebuild is automatically started by a function of the RAID Controller called standby rebuild or hot-swap rebuild. Accordingly, manual Rebuild is not required so often. If required, use the Universal RAID Utility.

Rebuild can be executed if [Status] of a Physical Device is set to [Failed] and [Status] of the Logical Drive using the Physical Device is set to [Degraded].

Executing Rebuild

Rebuild is executed for a Physical Device. The procedure of executing Rebuild is described below.

Manual Rebuild is available only in the Advanced Mode.

RAID Viewer

Step 1  Start the RAID Viewer. Click the Physical Device used for the Rebuild on the Tree View. Then click [Start Rebuild] on the [Control] menu.

Step 2  After the Rebuild is started, the progress of the Rebuild appears on the Operation View. At the completion of the Rebuild, [Status] on the Operation View is changed to [Completed].
**raidcmd**

**Step 1** Execute "rebuild" command with -op option and the defined parameters.

- **c**: Number of the RAID Controller containing the Physical Device for which Rebuild is executed
- **p**: Number of the Physical Device for which Rebuild is executed
- **op**: Specify "start" to start Rebuild

Ex. Start rebuilding on the Physical Device (RAID Controller Number: 1 and Physical Device Number: e252s4).

```
raidcmd rebuild -c=1 -p=e252s4 -op=start
```

**Step 2** After the Rebuild is started, the raidcmd terminates normally. Check the execution status of the Rebuild by using "oplist" command.

Ex. Check the status

```
raidcmd oplist
```

**Stopping Rebuild**

You can stop Rebuild being executed on the way. The procedure of stopping Rebuild is described below.

- **The function of stopping Rebuild is available only in the Advanced Mode.**
- **Some types of RAID Controller do not support stopping rebuild. If it does not support this function, the stop button of operation view of RAID Viewer does not become enable. When the "op" option of raidcmd "rebuild" is "stop", the message saying it is not supported is displayed and the command is terminated.**

**RAID Viewer**

**Step 1** Start the RAID Viewer. See [Operation View] while Rebuild is executed.

**Step 2** Click operation [Rebuild] which you want to stop. Then click [Stop] on the Operation View. After the Rebuild is stopped, [Status] on the Operation View is changed to [Stopped].

**raidcmd**

**Step 1** Execute "rebuild" command with the following parameters.

- **c**: Number of the RAID Controller containing the Physical Device for which Rebuild is stopped
- **p**: Number of the Physical Device for which Rebuild is stopped
- **op**: Specify "stop" to stop Rebuild

Ex. Stop rebuilding on the Physical Device (RAID Controller Number: 1 and Physical Device Number: e252s4).

```
raidcmd rebuild -c=1 -p=e252s4 -op=stop
```

**Step 2** After the Rebuild is stopped, the raidcmd terminates normally. The stopped Rebuild disappears from the list of "oplist" command.

Ex. Check the status

```
raidcmd oplist
```
Checking Result of Executing Rebuild

You can find the result of executing Rebuild by checking the Tree View, the property of the Physical Device and the RAID Log of the Universal RAID Utility.

If Rebuild succeeds, the icon of the Physical Device subject to the Rebuild changes to [Online] on the Tree View. In addition, the [Status] in the Property tab of the Physical Device is set to [Online].

When detects something problem, Universal RAID Utility records the log in the RAID Log.

Setting Rebuild Priority

You can set the priority at which Rebuild is executed in the server. The procedure of setting the Rebuild Priority is described below.

Setting Rebuild Priority are available only in the Advanced Mode.

RAID Viewer

Step 1  Start the RAID Viewer. Click the RAID Controller on the Tree View. Then click [Properties] on the [File] menu.

Step 2  Click the [Options] tab in the [RAID Controller Properties] dialog box. Change the value of [Rebuild Priority] to [High], [Middle], or [Low]. Click [OK] or [Apply].

raidcmd

Step 1  Execute "optctrl" command with -rp option and the defined parameters.
- **c**: Number of the RAID Controller for which Rebuild Priority is set
- **rp**: Select high, middle, or low to change the Rebuild Priority.

Ex. Set the Rebuild Priority of the RAID Controller (RAID Controller number: 1) to Middle.

raidcmd optctrl -c=1 -rp=middle

Step 2  The property of the RAID Controller changes to the following value when the setting has been changed successfully.
[Rebuild Priority]: Priority after change

Check the execution result by using "property" command.
- **tg**: Specify rc to browse the property of Logical Drive
- **c**: The number of the RAID Controller

Ex. Browse the property of the RAID Controller (RAID Controller Number: 1)

raidcmd property -tg=rc -c=1
Reducing the power consumption of the Physical Device

The HDD Power Saving is the function to spin down the Physical Device that is not in use. The HDD Power Saving reduces the power consumption of the System by spinning down the Physical Device.

Set the Power Saving in each RAID Controllers.
You can see which type of the Physical Device is available for the HDD Power Saving function in the table below.

<table>
<thead>
<tr>
<th>Device Type</th>
<th>Ready</th>
<th>Status Online</th>
<th>Hotspare</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk Drive (HDD)</td>
<td>N/A</td>
<td>N/A</td>
<td>✓</td>
</tr>
<tr>
<td>Solid State Drive (SSD)</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Tape device / CD/DVD</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

The settings for HDD Power Saving are available only in the Advanced Mode.

Setting Power Saving Devices

The procedure of setting the Power Saving Devices for each RAID Controller is described below.
The Physical Device that can see the HDD Power Saving function is the Hard Disk Drive of which the status is Hot Spare.

Some types of RAID Controller do not support HDD Power Saving. If it does not support this function, the items [HDD Power Saving (Hot Spare)] and [Device Standby Time] on the [Options] tab do not appear. "optctrl" command of raidcmd is failed.

RAID Viewer

Step 1 Start the RAID Viewer. Click the RAID Controller on the Tree View. Then click [Properties] on the [File] menu.

Step 2 Click the [Options] tab in the [RAID Controller #X Properties] dialog box. Change the value of [HDD Power Saving (Hot Spare)] to [Enable] or [Disable]. Click [OK] or [Apply].
**raidcmd**

**Step 1** Execute "optctrl" command with -psd option and the defined parameters.

- `c`: Number of RAID Controller for which Power Saving Device is set.
- `-psd`: Select none or hotspare to change the Power Saving Device.

Ex) Changes value of HDD Power Saving (Hot Spare) to "enable" (RAID Controller Number is 1)

```plaintext
raidcmd optctrl -c=1 -psd=hotspare
```

**Step 2** Checking the execution result by using "property" command. The following parameter of RAID Controller is changed.

[Power Saving (Hot Spare)]: "Enable" to selected "hotspare", "Disable" to selected "none".

Ex) Referring to property of the RAID Controller (RAID Controller number is 1)

```plaintext
raidcmd property -tg=rc -c=1
```

*Only a single parameter can be set at a time. If execute "optctrl" command with -psd option and -dst option at the same time, command is failed.*

---

**Setting Device Standby Time**

Set the time of transitioning to Power Saving the Physical Device which is not in use.
You can select the time of transitioning from 30 minutes, 1 hour, 2 hours, 4 hours, and 8 hours.

- Some types of RAID Controller do not support this function. If it does not support this function, the items do not appear. "optctrl" command of raidcmd is failed.
- If you set any value (other than 30 minutes, 1 hour, 2 hours, 4 hours, or 8 hours that can be selected on Universal RAID Utility) by the offline utility, the value appears in a selectable list on Universal RAID Utility as a current value.

---

**RAID Viewer**

**Step 1** Start the RAID Viewer. Click the RAID Controller on the Tree View. Then click [Properties] on the [File] menu.

**Step 2** Click the [Option] tab in the [RAID Controller #X Properties] dialog box. Change the value of [Device Standby Time]. Click [OK] or [Apply].
**raidcmd**

**Step 1**  Execute the "optctrl" command with -dst option and the defined parameters.
- **-c**: Number of RAID Controller for which Device Standby Time is set.
- **-dst**: Select 0.5, 1, 2, 4, or 8 hours to change the Device Standby Time.

Ex. Changes the value of Device Standby Time to "2hours" (RAID Controller Number is 1).

`raidcmd optctrl -c=1 -dst=2`

**Step 2**  The property of the RAID Controller changes after the setting has been changed successfully.
[Device Standby Time]: Value after change

Use the “property” command to see the property of the RAID Controller.
- **-tg**: Specify rc to see the property of the RAID Controller.
- **-c**: The Number of the RAID Controller of which you are going to check the property.

Ex. Referring to property of the RAID Controller (RAID Controller Number 1)

`raidcmd property -tg=rc -c=1`

Only a single parameter can be set at a time. If execute "optctrl" command with -psd option and -dst option at the same time, command is failed.
Checking Location of Physical Device

The locate function can be used when you want to know the slot to which a specific Physical Device appearing in the RAID Viewer is inserted in the server or enclosure. In actual, locate turns on the DISK lamp on the server or enclosure in which the specified Physical Device is installed. (The DISK lamp blinks depending on the types of the server or enclosures.) Searching for the Physical Device with the DISK lamp being ON allows the Physical Device for which “check location” is executed on the RAID Viewer and raidcmd to be identified. The DISK lamp automatically is turned off in 3 minutes. Also, the RAID Controller may have the Turn off function according to the kind of RAID Controller.

RAID Viewer and raidcmd do not support the indication of the status (ON or OFF) of DISK lamp. Therefore, you can't recognize the location of the Physical Device when you turn ON the lamp of two or more Physical Devices at same time. You should turn ON the lamp of Physical Device one by one. It is convenient when you put down the number of the Physical Device which turned on a DISK lamp because you can confirm the number of the Physical Device when turn off the DISK lamp.

Procedure of Checking Location of Physical Device

Locate is executed for a Physical Device. The locate procedure is described below.

**RAID Viewer**

**Step 1**  
Start the RAID Viewer. Click a Physical Device to be located on the tree view, select [Locate] on the [Control] menu, and click [ON]. Then the DISK lamp on the Physical Device goes on (or blinks depending on the type of the server). The DISK lamp automatically is turned off in 3 minutes.

**Step 2**  
In case of the RAID Controller with Turn off function, [OFF] of [Locate] in the [Control] menu becomes enable. To turn off the DISK lamp, click a Physical Device to be located on the Tree View, select [Locate] on the [Control] menu and click [OFF].

**raidcmd**

**Step 1**  
To turn on the DISK lamp for locate, execute "slotlamp" command with the -sw option set to "on" using the following parameters.

- `c`: Number of the RAID Controller containing the Physical Device for which its location is checked
- `p`: Number of the Physical Device for which its location is checked
- `sw`: Specify "on" to turn on the DISK lamp

Ex. Turn on the DISK lamp of the Physical Device (RAID Controller Number: 1 and Physical Device Number: e252s4).

`raidcmd slotlamp -c=1 -p=e252s4 -sw=on`

**Step 2**  
To turn off the lighting DISK lamp, execute "slotlamp" command with the -sw option set to "off". If the RAID Controller does not support the "turning off the Disk lamp" function, the message indicating that it does not support the function is displayed and raidcmd is finished.

- `c`: Number of the RAID Controller containing the Physical Device for which its location is checked
- `p`: Number of the Physical Device for which its location is checked
- `sw`: Specify "off" to turn off the DISK lamp

Ex. Turn off the DISK lamp of the Physical Device (RAID Controller Number: 1 and Physical Device Number: e252s4).

`raidcmd slotlamp -c=1 -p=e252s4 -sw=off`
Changing Status of Physical Device Forcibly

The function of changing status of a Physical Device forcibly can be used when you want to change the Status of a Physical Device to Online or Failed forcibly for a maintenance job or another. The function may not be used in normal operation.

- The function of changing the status of a Physical Device forcibly is available only in the Advanced Mode.
- The system may not start if you forcibly change the status of the Physical Device used for the system drive. Do not change the status of the Physical Device used for the system drive forcibly.

The function of changing the status of a Physical Device forcibly may not be able to change the status to the desired one depending on the status of the Physical Device (such as a severe failure).

To Online Forcibly

To set the Status of a Physical Device to Online forcibly, use Make Online. The procedure of executing Make Online is described below.

The consistency of Logical Drive will be lost if you forcibly change the status of the Physical Device used for the Logical Drive.

RAID Viewer

**Step 1** Start the RAID Viewer. Click a Physical Device with Status being Failed on the Tree View. Then click [Make Online] on the [Control] menu.

**Step 2** Displays the Warning message and the confirmation message. Click [Yes], then Status of the Physical Device is changed to Online. Then click [No], without changing the status of the Physical Device.

**Step 3** After the Make Online succeeds, Status of the Physical Device is changed to Online.
**raidcmd**

**Step 1**  Execute "stspd" command with `-st` option and the following parameters.
- `-c`: Number of the RAID Controller containing the Physical Device with its status set to Online forcibly
- `-p`: Number of the Physical Device with its status set to Online forcibly
- `-st`: Specify "online"

Ex. Make the Physical Device (RAID Controller Number: 1 and Physical Device Number: e252s4) Online forcibly.

```bash
raidcmd stspd -c=1 -p=e252s4 -st=online
```

**Step 2**  Displays the Warning message and the confirmation message. Type "yes" to reply to the confirmation message. Then Status of the Physical Device is changed to Online. Type "No" to abort the change status of the Physical Device.

**Step 3**  If "stspd" command succeeds, the Status of the Physical Device is set to Online. Use the "property" command to see the property of the Physical Device.
- `-tg`: Specify `pd` to see the property of the Physical Device.
- `-c`: The number of the RAID Controller in which the Physical Device exists.
- `-p`: The number of the Physical Device.

Ex. Check the property of the Physical Device (RAID Controller number: 1 and Physical Device number: e252s4).

```bash
raidcmd property -tg=pd -c=1 -p=e252s4
```

**To Failed Forcibly**

To set the Status of a Physical Device to Failed forcibly, use Make Offline. The procedure of executing Make Offline is described below.

The redundancy of Logical Drive will be degraded or lost if you forcibly change the status of the Physical Device used for the Logical Drive.

**RAID Viewer**

**Step 1**  Start the RAID Viewer. Click a Physical Device with Status being Online on the Tree View. Then click [Make Offline] on the [Control] menu.

**Step 2**  Displays the Warning message and the confirmation message. Click [Yes], then Status of the Physical Device is changed to Failed. Then click [No], without changing the status of the Physical Device.

**Step 3**  After the Make Offline succeeds, Status of the Physical Device is changed to Failed.
raidcmd

Step 1  Execute "stspd" command with -st option and the following parameters.
- Number of the RAID Controller containing the Physical Device with its status set to Failed forcibly
- Number of the Physical Device with its status set to Failed forcibly
- Specify "offline"

Ex. Set the Physical Device (RAID Controller number: 1 and Physical Device number: e252s4) to Failed.

raidcmd stspd -c=1 -p=e252s4 -st=offline

Step 2  Displays the Warning message and the confirmation message. Type "yes" to reply to the confirmation message. Then Status of the Physical Device is changed to Failed. Type "No" to abort the change status of the Physical Device.

Step 3  If "stspd" command succeeds, the Status of the Physical Device is set to Failed.

Use the “property” command to see the property of the Physical Device.
- Specify pd to see the property of the Physical Device.
- The number of the RAID Controller in which the Physical Device exists.
- The number of the Physical Device.

Ex. Check the property of the Physical Device (RAID Controller number: 1 and Physical Device number: e252s4).

raidcmd property -tg=pd -c=1 -p=e252s4
Refreshing the battery of the RAID Controller

The Refresh Battery is a function to refresh the battery connected to the RAID Controller. The function restores the battery degraded due to charge and discharge.
Universal RAID Utility provides the function to manually execute the battery refreshing. The function can be done for each RAID Controller.
You can use a Windows task scheduler to do a regular battery refreshing.

- The Refresh Battery is not supported for some RAID Controllers. The menu of the Refresh Battery does not appear if it is not supported. Also the "refresh" command of raidcmd is failed.
- If the value of the [Cache Mode (Setting)] is [Auto Switch], after executing Refresh Battery, the value of [Cache Mode (Current)] is changed to once [Write Through], and return to the [Write Back] in few hours.
  After executing the Refresh Battery, if it is registered in the log to change the [Write Back], the Refresh Battery has completed successfully.

Executing Refresh Battery Manually

The procedure of executing Refresh Battery is described below.

The manual Refresh Battery is available only in the Advanced Mode.

RAID Viewer

**Step 1** Start the RAID Viewer. Click the battery on the Tree View. Then click [Refresh Battery] on the [File] menu.

**Step 2** The confirmation windows will open. Click [Yes] to execute the battery refreshing. Click [No] to cancel the battery refreshing.
**raidcmd**

**Step 1** Execute "refresh" command using the following parameter.
- `-c` : Number of RAID Controller for which Refresh Battery is set.

Ex) Refresh the battery (RAID Controller number: 2).
   `raidcmd refresh -c=2`

**Step 2** Execute the "refresh" command to display the confirmation message. Enter [Yes] to execute battery refreshing. Enter [No] to cancel battery refreshing.

---

**Scheduling Refresh Battery**

You can register the task to schedule Refresh Battery using the Task Scheduler on Windows or cron on Linux or VMware ESX.

If you are using the RAID Controller which supports the Refresh Battery function, Universal RAID Utility executes Refresh Battery in a regular manner according to the task registered.

(Example 1) Register the task to execute the batter refresh at AM 0:00 on April 1st in the Windows environment.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task name</td>
<td>Refresh Battery</td>
</tr>
<tr>
<td>Execution day</td>
<td>April 1st</td>
</tr>
<tr>
<td>Starting time</td>
<td>AM 0:00</td>
</tr>
<tr>
<td>Execution command</td>
<td>(Universal RAID Utility installation folder)/cli/raidcmd.exe refreshs</td>
</tr>
<tr>
<td>Execution account</td>
<td>NT AUTHORITY\SYSTEM</td>
</tr>
</tbody>
</table>

The Windows task can be used to change the schedule of executing Refresh Battery or delete tasks. For how to use tasks, see the Windows help.

(Example 2) Register the task to execute the batter refresh at AM 0:00 on April 1st in the Linux or VMware ESX environment.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution day</td>
<td>April 1st</td>
</tr>
<tr>
<td>Starting time</td>
<td>AM 0:00</td>
</tr>
<tr>
<td>Execution command</td>
<td>/opt/nec/raidcmd/raidcmd refreshs</td>
</tr>
<tr>
<td>Execution account</td>
<td>root</td>
</tr>
</tbody>
</table>

The functions of cron can be used to change the schedule of executing Refresh Battery or delete tasks. For how to use cron, see the manual of cron(8),crontab(1),crontab(5) by "man" command.
Updating firmware of the RAID Controller

The Update firmware of the RAID Controller is a function to update the firmware of the RAID Controller.

- The function of update firmware of the RAID Controller are available with N8103-176/177/178/179/188/7177/7178/7179 RAID Controllers, NE3303-177/178/H004 RAID Controllers, or Onboard RAID Controllers (LSI SAS 3008 iMR RoMB).
- Do not stop raidsrv service (including restart), abort raidcmd and stop system (including restart) when updating the firmware of the RAID Controller.

Executing Update Firmware Of The RAID Controller

The procedure of executing update firmware of the RAID Controller is described below.

- The update firmware of the RAID Controller is available only in the Advanced Mode.

RAID Viewer

The update firmware of the RAID Controller can use only raidcmd.

raidcmd

Step 1  After downloading firmware of the RAID controller you use, extract to the arbitrary place.

- The firmware of the RAID Controller is released on the “NEC Global Site” (http://www.nec.com/).
  However, the firmware of the RAID Controller you use is not released on “NEC Global Site” if it is not updating.

Step 2  Execute “fwup” command using the following parameter.

- `-c`: Number of RAID Controller for which update firmware.
- `-f`: Absolute path of stored area of the firmware file of the RAID Controller.
- `-ocr`: Specify “yes” if resetting the RAID Controller. Specify “no” if not resetting the RAID Controller. If you do not specify [-ocr], it is automatically “yes”.

Ex) Updating firmware of the RAID Controller with resetting RAID Controller (RAID Controller number: 2).

raidcmd fwup -c=2 -f=C:\XXX.rom -ocr=yes

- If blanks and parentheses are included in a absolute path, the path cannot sometimes be recognized by the OS you use. Please confirm the specification of the specifying absolute path of OS you use.
- If specifying "yes" in [ocr] parameter, firmware of RAID Controller is updated without restarting the system.
- If specifying "no" in [ocr] parameter, firmware of RAID Controller is updated after restarting the system.

If “fwup” command was executed, you cannot execute other function of Universal RAID Utility until update firmware of RAID Controller is completed. If a message as "Please reboot the computer." was appeared after execution the "fwup" command, please restarting the system to update firmware of RAID Controller.
This chapter describes the troubleshooting of a RAID System done by using the Universal RAID Utility. The Universal RAID Utility provides various measures to monitor occurrences of failures in the RAID System. The figure below shows the image of the troubleshooting function provided by the Universal RAID Utility.

**Measure 1**
Failures in RAID System detected by RAID controllers appear on RAID Viewer and raidcmd, NEC ESMPRO Manager.

**Measure 2**
All events occurred in RAID Systems are recorded to RAID Log. In case of Windows, Log Viewer allows referring RAID Log. In case of Linux, text editor or otherwise allow referring RAID Log.

**Measure 3**
Buzzer sounds at occurrence of failure if installed in RAID Controller.

**Measure 4**
Among events recorded in RAID Log, important events are also recorded to OS Log.

**Measure 5**
For events logged in OS Log, alerts are sent to NEC ESMPRO Manager.

*Figure 23 Troubleshooting image of RAID System*
Failure Detection Measures

The Universal RAID Utility provides several fault detection measures as shown in Figure 23 Troubleshooting image of RAID System. The measures are described below.

**Status Display by RAID Viewer**

The RAID Viewer indicates the status of the RAID System with the icons of components on the Tree View and the [Status] in the Property tab of each component.

For details of the icons of components on the Tree View, see "Tree View".

See "Referring to Information on RAID System" about details of [Status] in the Property tab.

**Status Display by raidcmd**

The structure of the RAID Controller will be displayed in a hierarchical structure by using the raidcmd without command. You can see the status of each component in a RAID System by using "property" command. For the information in the property, see "Referring to Information on RAID System".

**Logging Events to RAID Log**

The Universal RAID Utility logs all events occurred in the RAID System to the RAID Log in the Universal RAID Utility.

The data in the RAID Log can be seen by using a text editor or Log Viewer (when the operating system is Windows). For details of the Log Viewer, see "Functions of Log Viewer".

Note the character code when you see the RAID Log.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Path and File Name</th>
<th>Character Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>(installed folder)/server/raid.log</td>
<td>UTF-8</td>
</tr>
<tr>
<td>Linux</td>
<td>/var/log/raidsrv/raid.log</td>
<td>When the character code of the operating system is EUC : EUC When the character code of the operating system is not EUC : UTF-8</td>
</tr>
<tr>
<td>VMware ESX</td>
<td>/var/log/raidsrv/raid.log</td>
<td>UTF-8</td>
</tr>
</tbody>
</table>

For details of events to be registered to the RAID Log, see "Appendix C : Logs/Events".

The registration of the event to RAID Log starts when raidsrv service is begun, and stops when raidsrv service is stopped. The event happened when raidsrv service has stopped is not registered to RAID Log.

For log rotation, see “Logs output from Universal RAID Utility”.

**Logging Events to OS Log**

Among RAID System events logged in the RAID Log, the Universal RAID Utility also logs important events to the OS Log. OS Log is the event log (system) in Windows or the syslog in Linux.

For events to be logged in the OS log, see "Appendix C : Logs/Events".
Windows

[Example 1] When Logical Drive 2 on RAID Controller 1 is degraded.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;RU0402&gt;</td>
<td>Indicates event ID. The four numeric characters after “RU” is an event ID.</td>
</tr>
<tr>
<td>CTRL:1(ID=0)</td>
<td>Indicates RAID Controller number. The example “CTRL:1(ID=0)” indicates the RAID Controller of which the RAID Controller number is 1 and ID is 0.</td>
</tr>
<tr>
<td>LD:2(ID=1)</td>
<td>Indicates Logical Drive number. The example “LD:2(ID=1)” indicates Logical Drive number 2 and ID 1.</td>
</tr>
</tbody>
</table>

[Example 2] When the status of the Physical Device e252s3 connected to the RAID Controller 1 changes to Ready.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;RU0302&gt;</td>
<td>Indicates event ID. The four numeric characters after “RU” is event ID.</td>
</tr>
<tr>
<td>CTRL:1(ID=0)</td>
<td>Indicates RAID Controller number. The example “CTRL:1(ID=0)” indicates the RAID Controller of which the RAID Controller number is 1 and ID is 0.</td>
</tr>
<tr>
<td>PD:e252s3(ID=19)</td>
<td>Indicates the Physical Device number. The example “PD:e252s3(ID=19)” indicates the Physical Device of which the Physical Device number is e252s3 and ID is 19.</td>
</tr>
<tr>
<td>SEAGATE ST936701SS 0003</td>
<td>Indicates the product name of the Physical Device.</td>
</tr>
</tbody>
</table>
**Linux and VMware ESX**

[Example 1] When Logical Drive 1 on RAID Controller 2 is degraded.
- Jun 27 18:49:04 localhost raidsrv[27370]: <RU0402> [CTRL:2(ID=1) LD:1(ID=0)] Logical Drive is Degraded.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>raidsrv</td>
<td>Indicates the process name of Universal RAID Utility</td>
</tr>
<tr>
<td>&lt;RU0402&gt;</td>
<td>Indicates event ID. The four numeric characters after “RU” is event ID.</td>
</tr>
<tr>
<td>CTRL:2(ID=1)</td>
<td>Indicates the RAID Controller number. The example “CTRL:2(ID=1)” indicates the RAID Controller of which the RAID Controller number is 2 and ID is 1.</td>
</tr>
<tr>
<td>LD:1(ID=0)</td>
<td>Indicates the Logical Drive number. The example “LD:1(ID=0)” indicates the Logical Drive of which the Logical Drive number is 1 and ID is 0.</td>
</tr>
</tbody>
</table>

[Example 2] When the status of the Physical Device e49s1 connected to the RAID Controller 2 changes to Ready.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>raidsrv</td>
<td>Indicates the process name of Universal RAID Utility</td>
</tr>
<tr>
<td>&lt;RU0302&gt;</td>
<td>Indicates event ID. The four numeric characters after “RU” is event ID.</td>
</tr>
<tr>
<td>CTRL:2(ID=1)</td>
<td>Indicates the RAID Controller number. The example “CTRL:2(ID=1)” indicates the RAID Controller of which the RAID Controller number is 2 and ID is 1.</td>
</tr>
<tr>
<td>PD:e49s1(ID=72)</td>
<td>Indicates the Physical Device number. The example “PD: e49s1 (ID=72)” indicates the Physical Device of which the Physical Device number is e49s1 and ID is 72.</td>
</tr>
<tr>
<td>ATA A ST380815AS</td>
<td>Indicates the product name of the Physical Device.</td>
</tr>
</tbody>
</table>

**Buzzer in RAID Controller**

If a RAID Controller is equipped with a Buzzer, the RAID Controller sounds the Buzzer for some types of failures occurred.
The Buzzer sounds until the stopping it by RAID Viewer or raidcmd. This section describes how to stop the Buzzer.

**RAID Viewer**

**Step 1** Start the RAID Viewer. Check the component in which a failure occurs on the Tree View.

**Step 2** Click the RAID Controller containing the component in which the failure occurs. The click [Silence Buzzer] on the [Control] menu.

You can click menu item [Silence Buzzer] whether a Buzzer sounds or not. Nothing is done if no Buzzer sounds.
**raidcmd**

**Step 1** Execute `raidcmd` without command to check the component where a failure occurs.

**Step 2** Execute `sbuzzer` command with the following parameter.

- `-c`: Number of the RAID Controller for which Buzzer is stopped

Ex. Stop the Buzzer of the RAID Controller (RAID Controller number:1)

`raidcmd sbuzzer -c=1`

---

### Sending Alert to ESMPro Manager

Among RAID System events logged in the OS Log, the Universal RAID Utility sends important events which may affect the operations and managements of the server to the NEC ESMPro Manager as alerts. To send alerts, the event monitoring function provided by the NEC ESMPro Agent or the NEC ESMPro ServerAgentService can be used. If the NEC ESMPro Agent or the NEC ESMPro ServerAgentService is installed in the server in which the Universal RAID Utility is installed and alert transmission is set, RAID System events detected by the Universal RAID Utility will be automatically subject to alert transmission to the NEC ESMPro Manager.

For alerts sent to the NEC ESMPro Manager, see "Appendix C : Logs/Events".

For alert transmission provided by the NEC ESMPro Agent or the NEC ESMPro ServerAgentService, see the relevant documentation of these software.

If using the NEC ESMPro ServerAgentService, you should use NEC ESMPro Manager Ver. 6.0 or later.

If OS of the server in which Universal RAID Utility is being installed is VMware ESX, please use NEC ESMPro Agent in spite of the version of NEC ESMPro Manager.

---

### Using report coordination of NEC ESMPro/AlertManager

To use alerts on report coordination of the NEC ESMPro/AlertManager, add the following registry to the computer in which the NEC ESMPro Manager is installed.

If the registry has existed already, you do not need to correct the registry additionally.

**Registry key**

**CPU architecture (x86):**

```
HKLM\SOFTWARE\NEC\NVBASE\AlertViewer\AlertType\URAIDUTL
```

**CPU architecture (x64):**

```
HKLM\SOFTWARE\Wow6432Node\NEC\NVBASE\AlertViewer\AlertType\URAIDUTL
```

**Values**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>WavDefault</td>
<td>REG_SZ</td>
<td>Default.wav</td>
</tr>
<tr>
<td>AniDefault</td>
<td>REG_SZ</td>
<td>Default.bmp</td>
</tr>
<tr>
<td>Image</td>
<td>REG_SZ</td>
<td>Default.bmp</td>
</tr>
<tr>
<td>SmallImage</td>
<td>REG_SZ</td>
<td>Default.bmp</td>
</tr>
</tbody>
</table>

**Permission**

In case of the operation system where ESMPro Manager is installed is Windows XP (exclude Home Edition), Windows Server 2003, add the following permissions.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
<td>Full Control</td>
</tr>
<tr>
<td>Everyone</td>
<td>Read</td>
</tr>
</tbody>
</table>
ESMPRO User Group is the name group for the management of NEC ESMPRO Manager (specified it when installed NEC ESMPRO Manager). If you forget the name of group, see the following registry key.

CPU architecture (x86): HKEY_LOCAL_MACHINE\SOFTWARE\NEC\NVBASE
CPU architecture (x64): HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node \NEC\NVBASE
Value: LocalGroup

Monitoring Faults of Physical Devices

The Universal RAID Utility can take the following measures to monitor failures of Physical Devices detected by RAID Controllers.

<table>
<thead>
<tr>
<th>RAID Viewer</th>
<th>RAID Log</th>
<th>Buzzer</th>
<th>OS Log</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
</tr>
</tbody>
</table>

If a Physical Device used for a Logical Drive is failed, the status of the Physical Device changes to [Failed]. In addition, the status of the Logical Drive using the Physical Device changes to [Degraded] or [Offline] depending on the redundancy. The status of the Physical Device and Logical Drive remains unchanged until the problem is solved.

If the Physical Device (SSD) used as CacheCade fails, the status of the Physical Device (SSD) changes to Fail and the capacity of the SSD Cache Drive that includes the Physical Device (SSD) decreases.

SSD Cache Drive operates as Read Cache of HDD. Therefore, if the status of any one of the Physical Devices (SSD) is “Online”, the status of the SSD Cache Drive is “Online”.

The RAID Viewer indicates the status of Physical Devices and Logical Drives with their icons on the Tree View and their properties. In addition, the RAID Viewer shows the status from the viewpoint of the RAID System and from the viewpoint of the server on the Tree View.

The raidcmd indicates the status of Physical Devices and Logical Drives on their properties.

The display of the RAID Viewer depending on the change of Physical Device status is described below.
Operation in no failures of Physical Devices

If all Physical Devices used by a Logical Drive operates normally (with their [Status] being [Online]), the Logical Drive is in the online status (with its [Status] being [Online]).

---

**Structure and Status of RAID System**

- RAID Level: 5
- Physical Devices:
  - e252s2 [Online]
  - e252s3 [Online]
  - e252s4 [Online]
  - e252s5 [Hot Spare]

**Property of RAID Viewer**

- Logical Drive #1 Properties
  - ID: 0
  - Disk Array Information: 1 (order 1/1)
  - RAID Level: RAID 5
  - Sector Format: 512
  - Capacity: 20GB
  - Stripe Size: 256KB
  - Cache Mode (Setting): Write Through
  - Status: Online

**Property of raidcmd**

- raidcmd property -tg=ld -c=1 -l=1
  - RAID Controller #1 Logical Drive #1
  - ID: 0
  - Disk Array Information: 1 (order 1/1)
  - RAID Level: RAID 5
  - Sector Format: 512
  - Capacity: 20GB
  - Stripe Size: 256KB
  - Cache Mode (Setting): Write Through
  - Cache Mode (Current): Write Through
  - Type: Logical Drive
  - Status: Online

- raidcmd property -tg=pd -c=1 -p=e252s2
  - RAID Controller #1 Physical Device e252s2
  - Enclosure: 252
  - Enclosure Position: Internal
  - Slot: 2
  - ID: 41
  - Device Type: HDD
  - Interface: SAS
  - Vendor/Model: SEAGATE ST3300656SS
  - Firmware Version: N00A
  - Serial Number: 3QP02XY2
  - Sector Format: 512
  - Capacity: 278GB
  - Status: Online
  - S.M.A.R.T.: Normal
  - Power Status: On

---

**Tree View of RAID Viewer**

- Computer
- RAID Controller #1 LSI MegaRAID SAS 9257-8i
- Battery [Normal]
- Disk Array #1
  - LD #1 [Online] RAID 5
  - PD e252s2 [Online] SAS-HDD
  - PD e252s3 [Online] SAS-HDD
  - PD e252s4 [Online] SAS-HDD
  - PD e252s5 [Dedicated Hot Spare] SAS-HDD

Figure 24 Display of RAID Viewer / raidcmd (No failures of Physical Devices)
Operation when redundancy of Logical Drive degraded or lost due to failure of Physical Device

If one or more Physical Devices used by a Logical Drive are failed (with their [Status] being [Failed]) to degraded (one Physical Device of RAID Level 6 is failed) or lost (one Physical Device of RAID Level 1 or 5 is failed, two Physical Devices of RAID Level 6 is failed) the redundancy of the Logical Drive, the Logical Drive is degraded (with its [Status] being [Degraded]).

---

**Structure and Status of RAID System**

- RAID Level: 5
- e252s2 [Online]
- e252s3 [Online]
- e252s4 [Failed]
- e252s5 [Hot Spare]

---

**Property of RAID Viewer**

- Logical Drive #1 Properties
  - RAID Level: RAID 5
  - Sector Format: 512
  - Cache Mode (Setting): Write Through
  - Cache Mode (Current): Write Through
  - Status: Degraded

---

**Property of raidcmd**

- raidcmd property -tg=ld -c=1 -l=1
- RAID Controller #1 Logical Drive #1
- ID: 0
- RAID Level: RAID 5
- Sector Format: 512
- Stripe Size: 135KB
- Cache Mode (Setting): Write Through
- Cache Mode (Current): Write Through
- Status: Degraded

---

**Tree View of RAID Viewer**


---

**Failed Physical Device [Failed]**

- RAID Controller #1 Physical Device e252s2
- Enclosure: 252
- Slot: 2
- ID: 19
- Device Type: HHD
- Interface: SAS
- Vendor/Model: SEAGATE ST936701SS
- Status: Failed

---

**Structure and Status of RAID System**

- RAID Level: 5
- e252s2 [Online]
- e252s3 [Online]
- e252s4 [Failed]
- e252s5 [Hot Spare]
Operation when failed Physical Device is replaced to recover RAID System

Using the RAID System continuously with the redundancy of a Logical Drive remaining degraded may cause the data in the Logical Drive to be lost when another Physical Device is failed further. Recover a Logical Drive of degraded redundancy by Hot Spare or replacement of the failed Physical Device.

If Hot Spare or replacement of a failed Physical Device operates Rebuild, the status of the Physical Device changes during the rebuilding (with its [Status] changed to [Rebuilding]).

After Rebuild starts, various results such as [Status] changes [Ready] cannot recognize existence, and [Status] keep [Failed] are thought by RAID Controller's kind and the kind of the occurring issue as for a Physical Device that failed.
Operation when the Logical Drive is offline due to failure of Physical Device

If you continue to use the RAID System with lost redundancy of a Logical Drive and another Physical Device is failed further, the redundancy of the Logical Drive is lost completely (two or more Physical Devices of RAID Level 1 or 5 is failed, three or more Physical Devices of RAID Level 6 is failed). The status of a Logical Drive without redundancy is offline (with its [Status] being [Offline]). The data in a Logical Drive in the offline status is lost. Replace all failed Physical Devices and Rebuild the RAID System.

Figure 27 Display of RAID Viewer / raidcmd (Under lost redundancy of Logical Drive)
Monitoring Battery Status

The Universal RAID Utility can monitor Battery status which the RAID Controller detects by the following means.

<table>
<thead>
<tr>
<th>RAID Viewer</th>
<th>RAID Log</th>
<th>Buzzer</th>
<th>OS Log</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Depending on type of RAID Controller</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

The Universal RAID Utility monitors events of the Battery installed in the RAID Controller. The Universal RAID Utility logs detected Battery events in the RAID Log. Any event indicating occurrence of a problem in the Battery reflects to the [Status] of Battery on RAID Viewer and the [Battery Status] of RAID Controller on raidcmd (changes the status to [Warning]). The Battery status is retained until the problem is solved.

**Tree View of RAID Viewer**

The status of the node of Battery becomes [Warning] when there are problem in Battery.

**Property of RAID Viewer**

The [Status] of Battery Properties becomes [Warning] when there are problem in Battery.

**Property of raidcmd**

The [Battery Status] of RAID Controller Properties becomes [Warning] when there are problem in Battery.

---

**Figure 28 Display of RAID Viewer / raidcmd (Abnormal Battery operation)**

---

125
Monitoring Flash Backup Unit Status

The Universal RAID Utility can monitor Flash Backup Unit status which the RAID Controller detects by the following means.

RAID Viewer
raidcmd
RAID Log
Buzzer
OS Log
Alert
✔
✔
Dependong on type of RAID Controller
✔
✔

The Universal RAID Utility monitors events of the Flash Backup Unit installed in the RAID Controller. The Universal RAID Utility logs detected Flash Backup Unit events in the RAID Log. Any event indicating occurrence of a problem in the Flash Backup Unit reflects to the [Status] of Flash Backup Unit on RAID Viewer and the [Flash Backup Unit Status] of RAID Controller on raidcmd (changes the status to [Warning]). The Flash Backup Unit status is retailed until the problem is solved.

Figure 29 Display of RAID Viewer / raidcmd (Abnormal Flash Backup Unit operation)
Monitoring Enclosure Status

The Universal RAID Utility can monitor enclosure status which the RAID Controller detects by the following means:

- RAID Viewer
- raidcmd
- RAID Log
- Buzzer
- OS Log
- Alert

The Universal RAID Utility monitors events of the enclosure detected by the RAID Controller. The Universal RAID Utility logs detected enclosure events to the RAID Log. In addition, the Universal RAID Utility records important event to the OS log and sends alerts to the NEC ESMPRO Manager.

The RAID Viewer and raidcmd do not indicate the severity of events in this category to Tree View and the property of RAID System.

See *Appendix C: Logs/Events* for detail about the event of enclosure.

Monitoring Various Events of RAID System

The Universal RAID Utility can monitor other events which the RAID Controller detects by the following means:

- RAID Viewer
- raidcmd
- RAID Log
- Buzzer
- OS Log
- Alert

The Universal RAID Utility monitors various events of the RAID System as well as failures of Physical Devices, Battery events and enclosure events described above. The Universal RAID Utility logs events detected in the RAID System to the RAID Log. In addition, the Universal RAID Utility records important events to the OS log and send alerts to the NEC ESMPRO Manager.

The RAID Viewer and raidcmd do not indicate the severity of events in this category to Tree View and the property of RAID System.

See *Appendix C: Logs/Events* for detail about the various event of RAID System.

Replacing Physical Device for Prevention

If Physical Devices support S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) and the RAID Controller can detects S.M.A.R.T. errors, the Universal RAID Utility can monitor the S.M.A.R.T. errors by the following means.

- RAID Viewer
- raidcmd
- RAID Log
- Buzzer
- OS Log
- Alert

The Universal RAID Utility monitors S.M.A.R.T. errors occurred in Physical Devices. Detecting a S.M.A.R.T. error, the Universal RAID Utility logs the event to the RAID Log. In addition, the Universal RAID Utility reflects the status of S.M.A.R.T. in a Physical Device as the status of the Physical Device (by changing the status of the Physical Device to [Detected]). The status of the Physical Device is retained as its status until the S.M.A.R.T. error is solved.
Figure 30 Display of RAID Viewer / raidcmd (Detection of S.M.A.R.T. error)
Monitoring a Medium Error to see if they occur frequently

The Universal RAID Utility registers a “Physical Device Medium Error Frequently Detected” event message into RAID log when “Physical Device Medium Error (Correctable)” event occurs 20 or more times within one hour on the same Physical Device. When this event message is registered, please replace the Physical Device.

If Patrol Read or Consistency Check is executed when “Physical Device Medium Error Frequently Detected” event occurs, the Patrol Read or the Consistency Check is automatically stopped to suppress deterioration of access performance to the Physical Device. If you want to execute Consistency Check through entire Logical Drive even if a Medium Error is detected frequently, use the raidcmd with “Automatic Stop Disabled” option. See the section “Checking Logical Drive Consistency”.

If you are using a Physical Device with a sector size(Note1) of 512 emulation (512e), replace it if it is detected more than 160 times per hour.

This event is detected more than 20 times in the Physical Device of 512e, if it is less than 160 times per hour(Note2), it is not necessary to replace the Physical Device.

Monitoring a Medium Error to see if they occur intermittently

The Universal RAID Utility registers a “Physical Device Medium Error Intermittently Detected” event message into RAID log when “Physical Device Medium Error (Correctable)” event occurs 20 or more times within a week on the same Physical Device. When this event message is registered, please replace the Physical Device.

Behavior of “Physical Device Medium Error Intermittently Detected” event recorded is different from when “Physical Device Medium Error Frequently Detected” event recorded.

Even if the Patrol Read or the Consistency Check is doing, when the “Physical Device Medium Error Intermittently Detected” event records, these functions are not suspended automatically.

If you are using a Physical Device with a sector size(Note1) of 512 emulation (512e), replace it if it is detected more than 160 times per hour.

This event is detected more than 20 times in the Physical Device of 512e, if it is less than 160 times per hour(Note2), it is not necessary to replace the Physical Device.

(Note1) You can check the sector size with [Sector Format] of Physical Device Properties.

The target is Physical Device which has 512e Sector Format. For details, see “Referring to Property of Physical Device” section in this document.

(Note2) On Physical Device with 512e Sector Format, physical sector size (4096 bytes) is divided into 8 parts every 512 bytes to use logical sector size (512 bytes). Logical data communication is performed in parts per logical sector size (512 bytes), and actual disk I/O is performed in parts per physical sector size (4096 bytes).

Therefore, if any medium error occur with a physical sector (4096 bytes), all of 8 logical sectors which is divided every 512 bytes are reported medium error.

In these reason, Physical Device with 512e Sector Format should replace in every 160 times (20 times x 8) medium error reported.

Monitoring unexpected change of RAID configuration

The Universal RAID Utility registers a “RAID System unstable” event message into RAID log when there is a Physical Device which is excluded from the RAID configuration even though it is not failure. When this event message is registered, please check to see if there is a Physical Device whose status is Online and which is excluded from the RAID configuration. If you find it, please replace the RAID Controller and the Physical Device. This function is supported when you use the N8103-109/128/G128/134/135 RAID Controllers or NE3108-212 RAID Controller.
When you use the N8103-176/177/178/179/188/7177/7178/7179 RAID Controllers or NE3303-177/178/H004 RAID Controllers or Onboard RAID Controllers (LSI Embedded MegaRAID/LSI SAS 3008 iMR RoMB) and SSD which support "Monitoring the lifetime SSD", Universal RAID Utility monitors the lifetime of SSD. The degree of lifetime amounts of SSD can be confirmed by the [Endurance Remaining] in the property of a physical device. [Endurance Remaining] is starts from [Safe (100-51%)] as follows, and the status is transition according as SSD is used by user, indicates [End of life] finally.

If the state of SSD transferred to [Need to replace (10% or less)], an "Physical Device Endurance Remaining Warning" event is recorded. If the state of SSD transferred to [End of Life], an "Physical Device Endurance Remaining Error" event is recorded. If a [Physical Device Endurance Remaining Warning] event or [Physical Device Endurance Remaining Error] is recorded, please replace SSD concerned.

<table>
<thead>
<tr>
<th>[Endurance Remaining]</th>
<th>Safe (100-51%)</th>
<th>Reducing (50-21%)</th>
<th>Running out (20-11%)</th>
<th>Need to replace (10% or less)</th>
<th>End of life</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Danger</strong></td>
<td>Safe</td>
<td>Reducing</td>
<td>Running out</td>
<td>Need to replace (10% or less)</td>
<td>End of life</td>
</tr>
</tbody>
</table>

**Tree View of RAID Viewer**

The status of the node of Physical Device becomes [Fatal] when "Endurance Remaining Error" event is detected.

The status of the node of Physical Device becomes [Warning] when "Endurance Remaining Warning" event or "Endurance Remaining Running Out" event is detected.

If you used SATA SSD, whether it is possible to monitoring the lifetime of SSD is depend on products.

If you used Onboard RAID Controller (LSI Embedded MegaRAID), whether it is possible to monitoring the lifetime of SSD is depend on driver version of RAID Controller.
Management of RAID System using NEC ESMPRO Manager

You can browse, monitor, or operate the RAID System that is managed by Universal RAID Utility using NEC ESMPRO Manager after registering the server as the target server to be monitored by NEC ESMPRO Manager. See the instruction of NEC ESMPRO Manager about system requirements and how to use. This chapter describes the point that should be noted when the RAID System is managed by using NEC ESMPRO Manager.

System Requirement and Installation

Version of NEC ESMPRO Manager

The version of NEC ESMPRO Manager that can manage the system in which Universal RAID Utility Ver4.1 is installed must be Ver. 5.5 or later. But, if you use the function to make/remove Hot Spare by NEC ESMPRO Manager, you must use NEC ESMPRO Manager Ver. 5.72 or later. You cannot manage the RAID System from Windows GUI of NEC ESMPRO Manager. Be sure to use Web GUI to manage the RAID Controller.

Sending Alert to NEC ESMPRO Manager

To send alerts, the event monitoring function provided by the NEC ESMPRO Agent or the NEC ESMPRO ServerAgentService can be used. If the NEC ESMPRO Agent or the NEC ESMPRO ServerAgentService is installed in the server in which the Universal RAID Utility is installed and alert transmission is set, RAID System events detected by the Universal RAID Utility will be automatically subject to alert transmission to the NEC ESMPRO Manager. See the following table.

<table>
<thead>
<tr>
<th>Version of NEC ESMPRO Manager</th>
<th>Installed software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earlier than Ver. 6.0</td>
<td>NEC ESMPRO Agent</td>
</tr>
<tr>
<td>Ver. 6.0 or later</td>
<td>NEC ESMPRO ServerAgentService</td>
</tr>
</tbody>
</table>

However, if OS of the server in which Universal RAID Utility is being installed is VMware ESX, please use NEC ESMPRO Agent in spite of the version of NEC ESMPRO Manager.

Using RAID System Management Mode

The user account of NEC ESMPRO Manager has the attribute of RAID System Management Mode of Universal RAID Utility. There is not the function of changing RAID System Management Mode.

Using "Standard Mode"

The user accounts of NEC ESMPRO Manager (not include Administrator) has the authority of "Standard Mode" in default. If you change the RAID System Management Mode authority of user account, change the setting of [User Information]. In [User Information] view, change the [RAID System Management Mode] to [Standard Mode]. See the instruction of NEC ESMPRO Manager to change the [User Information].
# Using "Advanced Mode"

The Administrator account of NEC ESMPRO Manager has the authority of "Advanced Mode" in default. If you change the RAID System Management Mode authority of user account, change the setting of [User Information]. In [User Information] view, change the [RAID System Management Mode] to [Advanced Mode]. See the instruction of NEC ESMPRO Manager to change the [User Information].

## Function that can be used in NEC ESMPRO Manager

You can use the following functions ("Usable" is "✓") with the RAID System Management function.

<table>
<thead>
<tr>
<th>Category</th>
<th>Function</th>
<th>Standard</th>
<th>Advanced</th>
<th>Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Information</td>
<td>Tree View</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Property</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rescan</td>
<td>✓</td>
<td>✓</td>
<td>Allow it by [Rescan] in [RAID System Information] tree</td>
</tr>
<tr>
<td></td>
<td>View RAID Log</td>
<td>✓</td>
<td>✓</td>
<td>Display it [RAID Log] tree</td>
</tr>
<tr>
<td>Configuration</td>
<td>Make Logical Drive(Simple)</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Make Logical Drive(Custom)</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hot Spare(Make/Remove)</td>
<td>✓</td>
<td>✓</td>
<td>You can use this function only by NEC ESMPRO Manager Ver. 5.72 or later</td>
</tr>
<tr>
<td>Deleting Logical Drive</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Easy Configuration</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create SSD Cache Drive</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete SSD Cache Drive</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Operation</td>
<td>Monitoring Operation (include Stop Running Operation)</td>
<td>✓</td>
<td>✓</td>
<td>Display it [Running Operation] in [RAID System Information] tree</td>
</tr>
<tr>
<td></td>
<td>Start Consistency Check</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Consistency Check (Scheduled)</td>
<td>-</td>
<td>-</td>
<td>Allow it [Remote Batch] tree (Only the user with an administrator right is practicable)</td>
</tr>
<tr>
<td></td>
<td>Start Initialize</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Start Rebuild</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Refresh Battery</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Scheduled Refresh Battery</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Maintenance</td>
<td>Alert to NEC ESMPRO Manager</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop Buzzer</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Locate Physical Device</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changing Status of Physical Device (Online, Failed)</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Changing of Settings</td>
<td>Parameters of RAID Controller</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Parameters of Logical Drive</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Other functions</td>
<td>Change RAID System Management Mode</td>
<td>-</td>
<td>-</td>
<td>Each user account of NEC ESMPRO Manager has the attribute of RAID System Management Mode about Universal RAID Utility</td>
</tr>
</tbody>
</table>
Do not click Back/Forward button on a browser of the Web GUI.

Using ExpressUpdate

Universal RAID Utility supports ExpressUpdate. This feature enables you to install, update, and uninstall Universal RAID Utility. This can enables you the version management of Universal RAID Utility.

For details of the operation environment and procedure of ExpressUpdate, see the manual of ExpressUpdate.

Functions supported by ExpressUpdate

The functions supported in ExpressUpdate for Universal RAID Utility are installation, update, and uninstallation. These features are dependent on the version of Universal RAID Utility as shown below.

<table>
<thead>
<tr>
<th>Version of Universal RAID Utility</th>
<th>install</th>
<th>Update</th>
<th>Uninstall</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ver2.33 or older</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Ver2.4</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Ver2.5 or later</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

To update Universal RAID Utility, the existent Universal RAID Utility must support the uninstallation function by ExpressUpdate.

For example, if you attempt to update Universal RAID Utility from Ver2.33 to Ver4.1, the update will fail.

The update function allows the old version of Universal RAID Utility to take over the following settings and states to the new version.

- The folder to install
- TCP ports Universal RAID Utility uses
  (See “TCP ports used by Universal RAID Utility” for the notices regarding taking over TCP port numbers)
- The mode at the start of RAID Viewer and raidcmd
- Scheduled task to do Consistency Check registered on the operating system

System reboot is required when install, update, or uninstall Universal RAID Utility using ExpressUpdate. Universal RAID Utility may not operate properly without restarting the system.

ESMPRO Manager Ver. 5.5 or later versions are required to use ExpressUpdate.

Version management by ExpressUpdate

The feature enables you to perform version management of Universal RAID Utility. You can select the version of Universal RAID Utility when you install Universal RAID Utility from ExpressUpdate. If you would like to install the old version of Universal RAID Utility, first uninstall existing Universal RAID Utility and then install new Universal RAID Utility by selecting the old version of Universal RAID Utility.
Changing of Settings of Universal RAID Utility

This chapter describes how to change the settings of the Universal RAID Utility.

Changing TCP port number

If the TCP port number using Universal RAID Utility is same one of other application, you can change the TCP port number using Universal RAID Utility.

A user having the administrator authority should change the TCP port number. Only users having the administrator authority can change the TCP port number.

Using Windows as Operating System

Step 1  Log on to the server as a user having the administrator authority.

Step 2  Abort the RAID Viewer, Log Viewer, and raidcmd if they are used.

Step 3  Stop raidsrv service. If manages the RAID System by NEC ESMPRO Manager Ver. 5.5 or later, stop raidsrv Agent service and eciService too. Click [Start] - [Control Panel]. Then double click [Management Tool] - [Services]. Click [raidsrv] service and [Stop] of [Control] menu after displays service list. And stop [Universal RAID Utility raidsrv Agent] service and [eciService] by the same way.

Step 4  There are two of more parts in configuration file of raidsrv service, RAID Viewer, raidcmd and raidsrv Agent service about data port, event port and raidsrv Agent Communication port. Change the two of more parts in each configuration file.

<table>
<thead>
<tr>
<th>module</th>
<th>path and configuration file name</th>
<th>data port</th>
<th>event port</th>
<th>raidsrv Agent Communication port</th>
</tr>
</thead>
<tbody>
<tr>
<td>raidsrv service</td>
<td>\server\raidsrv.conf</td>
<td>[socket] section data port</td>
<td>[socket] section event port</td>
<td>none</td>
</tr>
<tr>
<td>RAID Viewer</td>
<td>\gui\raidview.conf</td>
<td>[network] section port</td>
<td>[network] section port_listen</td>
<td>none</td>
</tr>
<tr>
<td>raidcmd</td>
<td>\cli\raidcmd.conf</td>
<td>[network] section port</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>raidsrv Agent service</td>
<td>\server\raidsrv_agent.conf</td>
<td>[network] section data_port</td>
<td>[network] section event_port</td>
<td>[network] section agent_port</td>
</tr>
</tbody>
</table>

The default folder after installation is %SystemDrive%\Program Files\Universal RAID Utility when the architecture of CPU is x86. It is % SystemDrive%\Program Files (x86)\Universal RAID Utility when the architecture of CPU is x64.

Using Linux or VMware ESX as Operating System

Step 1  Log in to the computer as a user having the administrator authority.

Step 2  Abort the raidcmd if it is used.

Step 3  Stop raidsrv service.
If the RAID System is managed by NEC ESMPRO Manager Ver. 5.5 or later, raidsrv Agent service and eciService will also be stopped.

Step 4  You must change TCP port number in the configuration file of raidsrv service, RAID Viewer, raidcmd or raidsrv Agent service for date port, event port, and raidsrv Agent Communication port.

<table>
<thead>
<tr>
<th>module</th>
<th>path and configuration file name</th>
<th>data port</th>
<th>event port</th>
<th>raidsrv Agent Communication port</th>
</tr>
</thead>
<tbody>
<tr>
<td>raidsrv service</td>
<td>/etc/opt/nec/raidsrv/raidsrv.conf</td>
<td>[socket] section data port</td>
<td>[socket] section event port</td>
<td>none</td>
</tr>
<tr>
<td>raidcmd</td>
<td>/etc/opt/nec/raidcmd/raidcmd.conf</td>
<td>[network] section port</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>raidsrv Agent service</td>
<td>/etc/opt/nec/raidsrv/raidsrv_agent.conf</td>
<td>[network] section data_port</td>
<td>[network] section event_port</td>
<td>[network] section agent_port</td>
</tr>
</tbody>
</table>

Step 5  After the modification is finished, start the raidsrv service, raidsrv Agent service and eciService.

Avoiding TCP port conflict

If the user has customized the TCP ports Universal RAID Utility uses, it may conflict with the TCP ports (Ephemeral Port) that are automatically assigned for other applications. In Red Hat Enterprise Linux 6.0 or later versions or Red Hat Enterprise Linux 5.6 or later version, you can reserve TCP ports which Universal RAID Utility uses. It prevents you from the conflict between Universal RAID Utility and the application that automatically assigns TCP ports. See the following description in the table.

Note that the TCP ports [5016-5018] that Universal RAID Utility Ver2.61 or later versions use are out of the range of the Ephemeral Ports that an application automatically assigns. Therefore it is not necessary to reserve the ports.

<table>
<thead>
<tr>
<th>Path and file name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/etc/sysctl.conf</td>
<td>Add the following line.</td>
</tr>
<tr>
<td></td>
<td>net.ipv4.ip_local_reserved_ports = XXXXX-ZZZZZ (TCP port numbers)</td>
</tr>
</tbody>
</table>
Changing RAID System Management Mode at Start of RAID Viewer

The RAID Viewer is started in the Standard Mode by default. The setting can be changed so that the RAID Viewer is always started in the Advanced Mode as described below.

**Step 1**  Start the RAID Viewer. Click [Option] on the [Tool] menu.

**Step 2**  Check the [Always start with an Advanced Mode] check box in the [General] tab of the [Option] dialog box.

The setting of [Always start RAID Viewer in Advanced Mode] is enabled at the next start of the RAID Viewer.
Notes on Use of Universal RAID Utility

This chapter describes the notes on use of the Universal RAID Utility.

Operation Environment

Use of IPv6

The Universal RAID Utility cannot operate in the IPv6 (Internet Protocol version 6) environment. Use the Universal RAID Utility in the IPv4 environment. To manage a RAID System in the IPv6 environment, use the BIOS utility of the RAID Controller.

Use of Windows PowerShell

When you designate Physical Devices from Windows PowerShell, use single quotes (‘’) to operation.

Ex. Create a Logical Drive (RAID5, 20GB, 64 KB stripe size, Auto Switch Cache Mode, and Full Initialization Mode) in the Custom Mode using Physical Devices (RAID Controller Number: 1 and Physical Devices e252s2, e252s3, and e252s4).

raidcmd mkldc -c=1 '-p=e252s2,e252s3,e252s4' -rl=5 -cp=20 -ss=64 -cm=auto -im=full

When you designate something that include dots (.) by raidcmd from Windows PowerShell, use double quotes (" ") to operation.

Ex. Updating firmware of the RAID Controller with resetting RAID Controller (RAID Controller number: 2).

raidcmd fwup -c=2 -f="C:\XXX.rom" --ocr=yes
OS Fatal Error Event

The event “OS Fatal Error” is registered if the contiguous memory that is required for Universal RAID Utility operation cannot be reserved on the operating system. It may be caused by the lack of system memory or free space. You must resolve the root cause. After the problem is resolved, check "Updating Information of RAID System" to update the RAID system configuration. If you cannot update the RAID system information, restart the raidsrv service.

Doubly Registered Event After Restoring Backup Data

The event may be doubly registered (registered again) after restoring backup data when the log file for the events occurred during Universal RAID Utility is not activated are set as the target of the backup. To avoid it, exclude the following files from the target files for backup.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Path and File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>&lt;Universal RAID Utility installation folder&gt;/server/raidconn-storelib-event.bat</td>
</tr>
<tr>
<td>Linux/VMware ESX</td>
<td>/var/log/raidsrv/raidconn-storelib-event.bat</td>
</tr>
</tbody>
</table>

Fails to Start Consistency Check

You cannot perform Consistency Check to the Logical Drive on which other operation is being done. Check the status of the operation using Operation View or the “oplist” command of raidcmd. The start of Consistency Check may fail even if no operation is in progress. This may be caused by the Background Initialize (BGI) on the Logical Drive. The status of the Background Initialize is not displayed in Operation View and by the “oplist” command of raidcmd. Perform Consistency Check again after BGI is finished. You can check the completion of BGI in the RAID log.

Displaying of progress status when reboot a system during operation

If you reboot a system while some operation is running on the RAID System, the progress status may display as 0% until the operation is resumed. If the progress status is not displayed, please update RAID system management information by rescan function.
Installation / Uninstallation

DistributedCOM event is registered during installing or uninstalling

The following events might be registered in the event log of OS during installation or uninstallation of Universal RAID Utility under Windows Server 2008 R2 or Windows 7. Even if the following events are registered, there is no problem in the operation of the system and Universal RAID Utility.

<table>
<thead>
<tr>
<th>Source</th>
<th>Event ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DistributedCOM</td>
<td>10001</td>
<td>Unable to start a DCOM Server: [E9513610-F218-4DDA-B954-2C7E6BA7CABB] as /</td>
</tr>
</tbody>
</table>

RAID Viewer, Log Viewer

Verification of Authenticode signature at the startup of the RAID Viewer and Log Viewer

RAID Viewer and Log Viewer have an Authenticode signature. When you start the Microsoft .NET Framework Version 2.0 managed application that has an Authenticode signature, .NET Framework Version 2.0 verify the validation of Authenticode signature. Therefore if you use the server not connected network and the server connected bad quality network, may wait a few minutes until startup the RAID Viewer and Log Viewer.

Information

http://support.microsoft.com/kb/936707/en

About the startup without Microsoft .NET Framework Ver2.0 or later

RAID Viewer and Log Viewer will fail to start if you do not install Microsoft .NET Framework Version 2.0 or later in advance.

1. When the version that is older than Microsoft .NET Framework Version 2.0 exists
   The message dialog to show the occurrence of the initialization error of .NET Framework is displayed.

2. When .NET Framework does not exist
   The message dialog to show the occurrence of the application error which generated by the link error of .NET Framework is displayed.
   And, the following events are registered in the event log of OS.

<table>
<thead>
<tr>
<th>Source</th>
<th>Event ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Popup</td>
<td>26</td>
<td>Application popup: raidview.exe (or rlogview.exe) – Application Error : The application failed to initialize properly (0xc0000135). Click on OK to terminate the application.</td>
</tr>
</tbody>
</table>

You must install Microsoft .NET Framework Version 2.0 or higher to use the RAID Viewer and Log Viewer.
About the startup from command prompt or Windows PowerShell

Move the location to the folder where the Log Viewer and RAID Viewer execution files exists to start the RAID Viewer and Log Viewer from the command prompt or Windows PowerShell.
Universal RAID Utility stores the execution files of RAID Viewer and Log Viewer in the following folder.

<Universal RAID Utility installed folder>\gui\n
The different behavior between RAID Viewer and raidcmd

N8103-171(G171)/188 and Onboard RAID Controller (LSI SAS 3008 iMR RoMB) has differences in the time operated from RAID Viewer and the time operated from raidcmd.
Refer to the following table for details.

<table>
<thead>
<tr>
<th>Operation</th>
<th>RAID Viewer</th>
<th>raidcmd</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the value of &quot;Cache Mode(Setting)&quot; in Logical Drive Property.</td>
<td>The items do not appear.</td>
<td>Only &quot;Write Through&quot; is appeared.</td>
</tr>
<tr>
<td>Specify &quot;Cache Mode&quot; in &quot;Create Logical Drive – Custom Mode&quot;.</td>
<td>&quot;Cache Mode&quot; cannot be designated.</td>
<td>Only &quot;Write Through&quot; can be designated.</td>
</tr>
</tbody>
</table>

About "An exception happened in the RAID Viewer" error

"An exception happened in the RAID Viewer" error may occur by failing to get RAID System information because of temporary high-load etc. In this case, please close RAID Viewer once and reopen it. After that, check that RAID Viewer displays RAID System information correctly or not. If RAID Viewer can not open, or displayed RAID System Information is not correct, please restart "Universal RAID Utility" service.

Logs output from Universal RAID Utility

Log Rotation

The maximum capacity of the log output from Universal RAID Utility and the handling when the capacity exceeds the limitation depends on the type of the log described as below.

<table>
<thead>
<tr>
<th>File name</th>
<th>Max capacity</th>
<th>Handling when the capacity exceeds the limitation</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>raid.log</td>
<td>4MB</td>
<td>Removes approximately 512KB old logs.</td>
<td>For User</td>
</tr>
<tr>
<td>raid_log_bin.dat</td>
<td>8MB</td>
<td>Removes approximately 1MB old logs.</td>
<td>For maintenance use</td>
</tr>
<tr>
<td>raidsrv.log</td>
<td>4MB</td>
<td></td>
<td>For maintenance use</td>
</tr>
<tr>
<td>raidapi.log</td>
<td>4MB</td>
<td></td>
<td>For maintenance use</td>
</tr>
<tr>
<td>raidconn-storelib.log</td>
<td>4MB</td>
<td></td>
<td>For maintenance use</td>
</tr>
<tr>
<td>raidconn-i2api.log</td>
<td>4MB</td>
<td></td>
<td>For maintenance use</td>
</tr>
<tr>
<td>raidsrv_agent.log</td>
<td>4MB</td>
<td>Renames the log file by suffixing .bak to the file name. Overwrites it if the .bak file already exists.</td>
<td>For maintenance use</td>
</tr>
<tr>
<td>raidsrv_agent_dll.log</td>
<td>4MB</td>
<td></td>
<td>For maintenance use</td>
</tr>
<tr>
<td>battery.log</td>
<td>4MB</td>
<td></td>
<td>For maintenance use (Created only when the battery is attached to the RAID Controller)</td>
</tr>
</tbody>
</table>
Log for User
The log contains the events of the RAID Controller. The user can confirm the operation history of Universal RAID Utility with this log.

Log for maintenance use
The log is for maintenance use. The user is not required to browse it.

The old logs will be eliminated when the capacity of raid.log exceeds 4MB. You can keep it by renaming the log file. When it is renamed, Universal RAID Utility creates a new raid.log.

Location where log files are created
See “Logging Events to RAID Log” for the location where each log file is created.

NEC ESMPRO Manager

Simultaneous operation from two or more NEC ESMPRO Manager
The following error might occur from NEC ESMPRO Manager to RAID System when runs the operation. When the following error occurs, there is a possibility of running the operation at the same time from other NEC ESMPRO Manager to same RAID System. Please changes timing if whether it operates it like this is confirmed, and it goes and operate it again.

"The system error occurred. Please ask it which component has broken."

Notes on use of Web GUI
Do not click Back/Forward button on a browser of the Web GUI.

Notes on use of function to Make/Remove Hot Spare by NEC ESMPRO Manager
You can use this function only by NEC ESMPRO Manager Ver. 5.72 or later.

NEC ESMPRO ServerAgentService

Notes on use report coordination with Windows Server 2008 R1 ServerCore
If using NEC ESMPRO Manager Ver. 6.0 or later, NEC ESMPRO ServerAgentService is not supporting Windows Server 2008 R1 ServerCore.
Notes on updating firmware of the RAID Controller

Do not stop raidsrv service (including restart), abort raidcmd and stop system (including restart) when updating the firmware of the RAID Controller. If doing these operations during updating firmware of RAID Controller, there is a possibility that the RAID Controller fail.

Consistency Check

Notes on executing Consistency Check Manually (Automatic Stop Disabled)

If restarting a system or raidsrv service during executing "Start Consistency Check (Automatic Stop Disabled)", behavior of Consistency Check changes with kind of RAID Controller you use. See the following table for details.

<table>
<thead>
<tr>
<th>RAID Controller</th>
<th>When system was a restarted</th>
<th>When raidsrv service was a restarted (restarting a system is not included)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onboard RAID Controller (LSI Embedded MegaRAID)</td>
<td>Consistency Check is stopped.</td>
<td>&quot;Consistency Check (Automatic Stop Disabled)&quot; is changed to &quot;Consistency Check (Automatic Stop Disabled)&quot;, and keep running.</td>
</tr>
<tr>
<td>Option and Internal RAID Controller</td>
<td>&quot;Consistency Check (Automatic Stop Disabled)&quot; is changed to &quot;Consistency Check (Automatic Stop Disabled)&quot;, and keep running.</td>
<td>&quot;Consistency Check (Automatic Stop Disabled)&quot; is changed to &quot;Consistency Check (Automatic Stop Disabled)&quot;, and keep running.</td>
</tr>
</tbody>
</table>

If you want to execute Consistency Check through entire Logical Drive even if Medium Error is detected frequently, do not restart a system or stop raidsrv service while executing Consistency Check (Automatic Stop Disabled). See the section "Checking Logical Drive Consistency" for details.